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Chapter 1: Getting Started

What Can QuicKeys Do for Me?
The introduction and rapid evolution of Mac OS X® changed the way we work with our computers like no other 
hardware or software advance since Appleʼs introduction of the original Macintosh® in 1984. Along with this new 
operating system came the necessity to adjust the way we work to conform to the new user interface and models it 
presented.
Although the Mac OS X interface has universal appeal out-of-the-box, users are individuals with unique tastes, jobs, 
and work styles. Thatʼs where QuicKeys X3 comes in; it lets you modify your work flow and the way you interact 
with your computer. These modifications can range from small tweaks to save a few seconds or relieve a sore wrist, 
to sweeping sequences of actions letting you go grab a cup of coffee while QuicKeys goes to town on one of your 
routine tasks.

Personalize your Mac
QuicKeys automates the repetitive jobs that take up too much of your day. It lets you replace a task or series of tasks 
with a single “trigger” such as a keystroke, menu selection, or a timer. For instance, you could use QuicKeys to 
automate applying a series of filters to numerous images in Photoshop. Just open the files, hit the assigned trigger, 
and read a magazine article about retiling your floors while QuicKeys puts Photoshop through its paces.

Performs daily tasks
When youʼre done brushing up on your home improvement skills (and QuicKeys is finished with its Photoshop 
tasks), tap a key on your keyboard and watch your e-mailer, web browser, and chat program all launch automatically. 
Surf for a while, compose e-mails, chat, all the while making use of QuicKeys to smooth out the repetitive tasks. 
Store and retrieve boiler-plate text for e-mails, jump to your favorite web sites, change your iChat status, all with the 
touch of a key!

You can surely see the advantages of using QuicKeys even in these brief examples. Primarily, youʼll save time. 
Every shortcut, whether saving you 10 seconds or 10 minutes of attentive work at your keyboard, will give you back 
some of that most precious commodity. Accuracy is another bonus. Humans are prone to error, but with some care, 
QuicKeys shortcuts can be built to be bullet-proof, performing a task thousands of times, each iteration exactly like 
the last.

The time savings are easy to measure, but a less tangible but even more beneficial advantage exists. After youʼve 
installed and built a number of shortcuts, your computer and workflow will begin to glide along with less effort. The 
boundaries between individual applications will fall away, merging the various parts of your computing day into 
a more seamless whole. Once youʼve experienced this kind of power, you wonʼt want to use a Macintosh without 
QuicKeys.

1
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About this Manual
This section discusses how this manual is organized and contains information on the conventions used in this 
manual. Knowing how the manual is set up will help you use it more effectively.

Assumptions
This documentation assumes you have a working knowledge of the Mac OS X operating system and accompanying 
hardware. For example, you should know how to use your mouse and how to open, save, and close files. You 
should also be familiar with Mac OS X interface elements, such as buttons, menus, icons, and the Dock. If you need 
assistance with usage or with Mac OS X terms, consult the documentation that came with your computer or with 
your Mac OS X CD.

Organization
• Chapters 1 & 2 of this manual introduce you to QuicKeys and provide basic instructions for installing and 

operating the software.
• Chapters 3 & 4 dig deeper into QuicKeys and contain several examples and tutorials to teach more complex 

concepts in creating Shortcuts and utilizing Triggers.
• Chapters 5-11 describe each shortcut type and give point-by-point explanations of each feature and control.
• The remaining appendices cover somewhat peripheral subjects such as how to activate QuicKeys shortcuts 

with AppleScript, controlling a remote computer with QuicKeys, and methods for publicly sharing shortcuts 
over a network. Several simple examples are also located in this section.

Conventions
• A right arrow symbol (->) indicates the hierarchy of menu and submenu options. For example: Create -> Files 

-> Open Items.
• A forward slash (/) indicates the hierarchy of a file or folder path on your hard drive. For example: <hard 

drive>/Applications/QuicKeys
• Variable text is contained within angle bracket characters < and >. For example, “look in your User folder, 

<user>/Library/QuicKeys, for your Shortcuts folder.”
• A ❖ symbol indicates a note that provides supplemental information about the topic being covered.
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Contextual Menu Terminology
QuicKeys X3 makes extensive use of contextual menus. These menus, as their name suggests, change depending 
on the context under which they are activated. Contextual menus are activated when you right-click (multi-button 
mouse), or control-click (hold your keyboardʼs control key down while clicking with a single-button mouse) on a 
user interface element such as a shortcut name, Editor toolbar, or a Scope. For the sake of brevity in this manual, 
the term “right click” will be used when we want to activate a contextual menu.
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Contacting Startly Technologies
If you have questions about QuicKeys X3 that are not addressed in the manual, use the resources listed in this 
section to learn how to find more information.

Sales and Customer Service

Sales Department
Hours: 9:00 A.M. to 5:00 P.M. Central Time
Phone:  800-523-7638 or 515-221-1801
Fax:  515-221-2258
E-mail: sales@startly.com
Web: http://www.startly.com/shop/

Customer Service Department
Hours: 9:00 A.M. to 5:00 P.M. Central Time
Phone: 515-221-1801
Fax: 515-221-1806
E-mail: Online at: http://www.startly.com/company/contact.html
Web: http://www.startly.com/support/customerservice.html

Ownership transfer
To transfer ownership of this product, e-mail us at sales@startly.com or send a letter with the product name, 
serial number, your name and address as well as the new ownerʼs name and address to:
Startly Technologies
Attn: Ownership Transfer
PO Box 65580
West Des Moines, IA 50265 U.S.A.
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Change of Address
To change or update your mailing or e-mail address online visit:
http://www.startly.com/forms/addresschange.html
or send a letter including your old and new address to: 
Startly Technologies
Attn: Change of Address
PO Box 65580
West Des Moines, IA 50265 U.S.A.

Technical Support

Phone Support
Hours: 8:30 A.M. to 4:30 P.M. Central Time
Phone: 515-221-1803

Your product serial number and credit card information will be required up front in the event that your 
support request isnʼt covered under complimentary support.

E-mail Support
For e-mail support on the current version of QuicKeys, use our online support form at 
http://www.startly.com/support/contact/request.html

Knowledge Base
http://know.cesoft.com/search.htm

QuicKeys Community
http://forum.quickeys.com/

For more information on our support policies, visit http://www.startly.com/support

Product Feedback
We encourage you to submit feedback regarding the product and documentation. Please submit feedback using our 
Product Feedback Form at: http://www.startly.com/forms/productfeedback.html
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System Requirements & Installation
This section provides general installation instructions. For the most current installation information, always view the 
Read Me document that accompanies the QuicKeys application, be it on the CD or in a downloaded disk image.

System Requirements
Verify that your computer meets the following system requirements before installing QuicKeys X3.

• At a bare minimum, QuicKeys X3 requires that your computerʼs operating system be Mac OS X version 10.3 
or later.

• There are no minimum processor or RAM requirements for QuicKeys X3, but its performance will directly 
relate to the abundance of or lack of capacity in these areas. If you meet Appleʼs RAM requirements for Mac 
OS X, that is sufficient.

• 20MB of free hard drive space is recommended, you will need more as you build a library of QuicKeys 
shortcuts and clips.

• Certain features, such as automatic checking for QuicKeys updates, require an internet connection.

Turning on Accessibility
QuicKeys X3 requires that your systemʼs Accessibility preference be turned on. When you first run QuicKeys X3, if 
you do not have Accessibility turned on, QuicKeys will help you through the process. To turn it on manually, follow 
these steps:

1. Select System Preferences from the Apple menu.
2. Select the Universal Access pane from the System category.
3. Check the Enable access for assistive devices checkbox.
4. If you are prompted to do so, enter your administrator password.
5. Quit System Preferences.
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Figure 1-1. Mac OS X Universal Access system preference

Installing QuicKeys
To install QuicKeys X3 from the CD, simply open the CD and drag & drop the big blue Q icon named “QuicKeys” 
from there into your Applications folder on your hard drive.
To install QuicKeys from a downloaded disk image, do the following:

1. Double click the disk image file (QuicKeysX3.dmg) to mount the QuicKeys X3 volume.
2. Double click the newly mounted QuicKeys X3 volume to open it, and drag & drop the big blue “Q” icon 

named “QuicKeys” from there into your Applications folder on your hard drive.
For instructions on upgrading from a previous version, refer to the QuicKeys Read Me document found on the CD 
or on the disk image.

Opening QuicKeys
Launching QuicKeys X3 for the first time is as simple as double clicking the QuicKeys application icon that you 
copied to your Applications folder. When QuicKeys is running, its presence will be indicated by a black “Q” (known 
as the QuicKeys Menu) up by your system clock in the menu bar. It will also show up in your Dock just like any 
other running application, but this behavior can be changed through QuicKeys  ̓preferences.
Opening the QuicKeys Editor window can be accomplished in two ways. You can select QuicKeys… from the 
QuicKeys Menu up by your system clock, or you can click on the QuicKeys icon in the Dock.
❖ Note: If you quit the QuicKeys application, you will not be able to play the shortcuts you have created. However, 
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the QuicKeys Editor window does not need to be open to play your shortcuts.

Adding QuicKeys to the Dock
To permanently add the QuicKeys icon to the Dock, just drag & drop the QuicKeys application icon from your 
Applications folder onto the desired location in the Dock. You can reposition the QuicKeys icon in the Dock by 
clicking and holding your mouse on it and dragging it around. You can remove it in a similar manner by dragging 
the QuicKeys icon out of the dock of and releasing your mouse button.

Checking for QuicKeys Updates
QuicKeys can automatically check our companyʼs web site for updates to the product. When you select Check for 
Update from the QuicKeys X3 application menu, the QuicKeys Update window appears. You can set QuicKeys to 
check for updates automatically, or you can return to this window from time to time to check for updates manually. 
If you choose to check for updates automatically, you must specify how often QuicKeys checks.

 
Figure 1-2. Check for QuicKeys updates



9

Chapter 1 - Getting Started

Tutorial 1 – Your First Shortcut
Feeling brave? Some users like to just jump right in and get their feet wet in a new product without reading much 
of the manual, and there is a lot to be said for having a look at how a product works before trying to digest a pile of 
technical mumbo jumbo. To this end, weʼll now present a short tutorial with step by step instructions on making a 
simple shortcut in QuicKeys X3.

The Problem
“I have to type my mailing address frequently, it would be really nice to be able to just hit a key and have it typed 
for me.”

The Solution
Build a simple Type Text shortcut in QuicKeys X3 which types in your name and home address whenever you press 
Control+H on your keyboard.

How To
1. Open your word processor, text editor, or any application that handles text documents. TextEdit is a good 

choice if you donʼt have a favorite; itʼs located in your Applications folder.
2. Make sure QuicKeys is running, then open the QuicKeys Editor by clicking on the QuicKeys icon in the Dock, 

or by selecting QuicKeys from the QuicKeys Menu up by the clock in the menu bar. The QuicKeys Editor 
window will open.

Figure 1-3. Step 3, setting the Scope

3. In the left column of the QuicKeys Editor (titled “Scopes”), click on the scope named “All Applications” This 
tells QuicKeys to create your new shortcut so that it is scoped, or is active, no matter which application you 
are currently using.
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4. From QuicKeys  ̓Create menu, select Text -> Type Text. A new Type Text shortcut will be created, opening a 
new window named “Untitled Shortcut.”

Figure 1-4. Tutorial Step 4, selecting Type Text from the Create Menu

5. Click in the “Text to Insert/Type:” field and type in your name and home address.
6. If a hot key trigger is not automatically created and present in the upper Scopes & Triggers part of the shortcut 

window, click on the small green circle with the “+” in it to add a trigger. QuicKeys will automatically 
assume you want to use a hot key type of trigger, and will likely automatically assign one of the F-keys as the 
hot key.

 

donsauer
Highlight

donsauer
Highlight

donsauer
Highlight
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Figure 1-5. Tutorial Steps 5 through 8, editing the shortcut

7. Click on the F-key (not the word “hot key”!) that was assigned as the hot key to bring up a small dialog 
allowing you to change it. Now press a key combination to assign a more meaningful hot key trigger, letʼs use 
Control+H. Close the hot key dialog window by clicking on the little circled X in its upper left corner.
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8. Click on the “Rename” button in this shortcutʼs toolbar or press the Command+R key combination to name 
your shortcut. Enter a sensible name such as “Home Address” in the resulting field, and click the OK button.

 
Figure 1-6. Tutorial Step 8, renaming the shortcut

9. Press Command+S on your keyboard or select the File -> Save Shortcut menu item to save the shortcut. 
Close the shortcut window and switch applications so that your word processor is now in front.

10. Press Control+H and watch QuicKeys do its thing!

Alternate Solutions
As your knowledge of QuicKeys X3 grows, you will discover alternate and more powerful ways to use it. In 
the case of typing blocks of text, the Clips shortcut is that alternate method. Clips shortcuts allow you to collect 
text and graphics on the fly, and retrieve them from those collections when needed. Think of Clips collections as 
unlimited permanent clipboards… good stuff.

The Sky’s the Limit
Although this Home Address shortcut is quite simple, it illustrates many of the important aspects of QuicKeys X3. 
Youʼll use the same basic procedure for every shortcut you create, and as you grow wise in the ways of automation, 
youʼll discover many variations on this basic theme. Whether your shortcuts are simple or complex, the only limit 
is your imagination.



Chapter 2: QuicKeys X3 Overview

This section introduces the important general concepts behind QuicKeys X3. It describes various components of 
the QuicKeys X3 package, and how they interact. Take a few minutes to read this material and gain a working 
vocabulary for the product. Once you have a handle on the fundamentals, youʼll be ready to dig in and start 
customizing your Macintosh.

Shortcuts
The shortcut is the most basic unit of QuicKeys. The goal of any shortcut in QuicKeys X3 is to make a single user 
action, such as a keystroke or menu selection, represent a larger task or series of tasks. You define the tasks and the 
trigger needed to get the ball rolling.
QuicKeys X3 comes with a number of predefined shortcuts that perform several useful functions. These are a good 
starting point and reference; look them over as you explore the product, theyʼll give some insight into what can be 
done with QuicKeys X3. As you use QuicKeys youʼll create many shortcuts of your own, adding to this collection 
and creating a portrait of the way you interact with your computer, fitting your Macintosh to your work style.

Single-step & Multi-step Shortcuts
Single-step shortcuts automate simple one-step tasks, such as typing your name, opening your Documents folder, or 
launching an application. By building additional steps onto a single-step shortcut, we can create Multi-step shortcuts 
to automate more complex tasks.
Examples of these multi-step tasks include opening your FileMaker client and connecting to a specific database, 
moving and resizing a window, or mounting a network drive and copying files to it.

Triggers
A trigger is a user-specified signal that directs QuicKeys to play or activate a specific shortcut. When you create a 
shortcut, you can assign one or more triggers to it. For example, you can assign Command+F3 as a hot key trigger 
that launches Microsoft Word, or you can create a trigger to automatically launch your e-mail application at 7:30AM 
while youʼre still brushing your teeth.
❖ Note: Triggers are covered in greater detail in Chapter 4 of this manual.

Trigger types
• App Event – Shortcuts can be triggered automatically after a specific application opens, quits, becomes front-

most or leaves the front.
• Day & Time – Lets you select the time and day(s) of the week when QuicKeys automatically triggers a 

shortcut.
• Device – With this trigger type you can directly assign shortcuts to buttons on your USB mouse, trackball, 

joystick, and even keys like Eject and Mute on your keyboard.
• Hot Key – You assign a keystroke or combination of keystrokes to activate a particular shortcut.
• Menu – QuicKeys places a small black “Q” menu up by your clock in the top right corner of your screen. 

Shortcuts may be added to and triggered from this menu.
• Repeat – Once youʼve activated a shortcut, a Repeat trigger will cause it to repeatedly activate after a set 

amount of time has passed.

13
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• Speech – If you have a headset or microphone attached to your Mac, you can assign a unique phrase for any 
QuicKeys shortcut you make, which when spoken will activate that shortcut.

• Time Range – This option is technically a qualifier rather than an actual trigger, it will not directly trigger a 
shortcut. But if you group this qualifier with another trigger, you can limit that triggerʼs operation to specified 
time ranges.

Scope
Scope is the realm of operation for a trigger. You can specify the scope of your triggers to limit the applications 
under which that shortcut can be triggered. A shortcut can have more than one scope if so desired. Scope comes in 
two major flavors, All Applications and Application-specific.
All Applications – When scoped to All Applications, a shortcut trigger will be active no matter which application is 
in front. For example, your F1 key might be set up to hide the front application. If you scope it to, say, Safari, then 
the F1 key would only hide the front application if it happened to be Safari. Youʼd need to scope that hot key to All 
Applications for it to work as desired for any application.
Application-specific – A trigger scoped to a specific application will only be active when that application is in front. 
You can assign more than one application scope to a shortcut if needed.
Scope interaction – Triggers scoped to a specific application always take precedence over those scoped to All 
Applications. This is useful for special case situations where you may not want your F1 key triggering the same 
shortcut in Safari (for example) that it does in your other apps.
Excluded Applications – You can designate any application as being “Excluded” from the All Applications scope. 
Applications so designated, when front-most, prevent the triggering of shortcuts that are scoped to All Applications. 
For example, if you exclude iMovie from All Applications, shortcuts scoped to All Applications will not trigger if 
iMovie is the front-most application.

Step Results
When a shortcut is played, it has some awareness as to whether or not its intended action was a success or failure. 
For example, if a Menu Selection shortcut cannot find the specified menu item, that shortcutʼs Step Result will be 
reported as “Failure”. By default, a failed shortcut or step will cease playback and present a window notifying you 
of that failure. Conversely, when a step succeeds, QuicKeys mutely reports “Success”, and playback of that shortcut 
proceeds to the next step if one exists.
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The QuicKeys Editor
The QuicKeys Editor is your control center for creating, modifying, and organizing your shortcuts. The most 
fundamental parts of the QuicKeys editor include: the QuicKeys Editor Toolbar, the Scope List, and the Shortcut 
List.

 

Figure 2-1. The QuicKeys Editor window

The Shortcut List
The right side of the QuicKeys Editor window is dominated by the Shortcut List. This pane will display a list of 
your shortcuts depending on what is selected in the Scopes list to the left. For example, if you click on Safari in the 
Scopes list, only shortcuts that are scoped to Safari will show up in the shortcut list. But if you click on All Shortcuts 
in the Scopes list, your shortcut list will display every shortcut youʼve created.

Features of the Shortcut List
• Resizable Columns – Clicking on the column headers in the shortcut list will sort the list by that particular 

column. The shortcut and triggers columns in the shortcut list can be resized by using your mouse to grab and 
drag the divider lines between the column headers.

• On/Off column – Turn shortcuts on and off here. Shortcuts that are off will not be triggered. Sorting by this 
column separates the On shortcuts from the Off shortcuts.
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• Type column – This column displays a helpful icon indicating what type of shortcut it is. Sorting by this 
column sorts your shortcuts by shortcut type.

• Shortcut column – This column displays the names of your shortcuts. Sorting by this column is alphabetical by 
shortcut name.

• Triggers column – This column displays the trigger for each shortcut. Sorting by this column groups similar 
trigger types together.

 ❖ Note: Clicking on a trigger in the shortcuts list will allow you to edit it directly from the QuicKeys Editor 
window rather than having to open the shortcut.

• Sizing Bar – Use this bar to change the width of the shortcuts list pane.

Contextual Menu Support
Right-clicking (or control-clicking with a single button mouse) on items in the shortcut list will bring up a contextual 
menu allowing you quick access to certain features. You can Edit, Rename, or Play a shortcut, Turn a shortcut on or 
off, and Select All, Cut, Copy, Delete or Export the selected shortcuts.

The Scopes List
The left half of the QuicKeys Editor window is dominated by the Scopes list. This list will always contain the 
default items of All Shortcuts, Unscoped Shortcuts, and All Applications. It will also include the names of all 
applications to which you have scoped your shortcuts. For example, if you have built shortcuts specifically for use 
within Word, Safari, and Mail, your Scopes list will include those three applications.
Clicking on one of the items in the Scopes list will alter what you see in the shortcuts list in the right side of the 
QuicKeys Editor window. For example, if you click on the Safari scope, the shortcuts list will show only those 
shortcuts scoped to work when Safari is the front-most application.

Default Scopes
• All Shortcuts – Displays all of your shortcuts in the shortcuts list.
• All Applications – Only those shortcuts scoped to All Applications will be displayed in the shortcuts list.
• Unscoped Shortcuts – Displays only shortcuts that have no scope. Shortcuts placed on toolbars, in the 

QuicKeys Menu, and on your desktop do not necessarily need to be scoped and so will likely show up in this 
list.

Contextual Menu Support
Right-clicking on a scope name in the Scopes list will allow you to easily access the Reassign, Duplicate, and Delete 
scopes features.

• Reassign Scope... Changes the scope of an entire set of shortcuts to another application. For example, if you 
upgrade from Dreamweaver MX to Dreamweaver 2004, you will want to reassign all of your Dreamweaver 
MX shortcuts to the new application. Rather than change each shortcut individually, you can use this 
convenient feature.
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• Duplicate Scope... Selecting this option will allow you to assign an additional scope to a set of shortcuts. For 
example, if you use more than one version of 4D for compatibility reasons, you may want to duplicate the 
scope so your shortcuts for one version of 4D also work in the other version.

• Delete Scope... Deleting a scope will remove that scope from all shortcuts. This can be useful if you retire an 
application and want to clean up your shortcut scopes. Shortcuts that are left without any scopes assigned can 
be easily located in the shortcuts list by clicking on the Unscoped Shortcuts scope.

❖ Note:  If you right-click on the All Applications scope it contains an additional contextual menu item named 
Excluded Applications. Selecting this will open the Excluded Applications window which lists any applications you 
have designated as not working with triggers scoped to All Applications. For example, if you add iMovie to this list, 
shortcuts scoped to All Applications will not trigger when you hit their hot key while using iMovie.

The QuicKeys Editor Toolbar
At the top of the QuicKeys Editor window is a customizable toolbar. This toolbar is initially populated with often 
used buttons, but you can make changes as you see fit. To customize this toolbar, either right-click on it and choose 
Customize Toolbar, or go to the View menu and select Customize Editor Toolbar. This will open a large sheet full of 
alternate buttons and separators which can be dragged to and from the toolbar to change its contents.
You can also customize the way the buttons on this toolbar are presented. Choices are Icon & Text, Icon Only, Text 
Only, and Use Small Size. Figure 2-2 shows some examples of the different views available.

 

Figure 2-2. QuicKeys Editor Toolbar customizable view options

The Default Buttons
• Inspector – Clicking this button will show/hide the Inspector window. The Inspector window displays six 

different types of information about the selected shortcut. See page 33 of this chapter for more information on 
the Inspector.

• Rename – A quick way to rename a selected shortcut.
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• New Shortcut – This button is actually a pop-up list. Click on it to reveal a menu containing all of the 
available shortcut types you can create.

• Record – Click this button to tell QuicKeys to start interpreting and recording your actions. See page 45 of 
the next chapter for more information on Recording.

• QK Community – Click this button to direct your browser to the QuicKeys Community web forums where 
you can get help and trade ideas.

• Open Items – This button represents the Open Items shortcut type. If you click on this button, QuicKeys 
will create a new Open Items shortcut for you to edit. This button is provided as an example of placing 
often-used items on this toolbar.

• Menu Selection – This button represents the Menu Selection shortcut type. If you click on this button, 
QuicKeys will create a new Menu Selection shortcut for you to edit. This button is provided as an example 
of placing often-used items on this toolbar.
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Creating Shortcuts
Shortcuts can be created in a number of ways, both from inside the QuicKeys Editor and from outside QuicKeys.

Shortcut Creation Within QuicKeys
• When you are in the QuicKeys Editor, the Create menu contains all of the shortcut types you can create.
• The File menu also contains a New Shortcut item which you can select to create a new, blank shortcut 

window; pressing ⌘+N will accomplish the same thing.

Drag & Drop Shortcut Creation
• If you drag and drop a file, application, or folder onto the QuicKeys Editor window it will instantly create 

an Open Items shortcut; all you need to do is name it and give it a hot key or another trigger.
• Dragging and dropping text from a document onto the open QuicKeys Editor window will create a new 

Type Text shortcut containing the selected text.

Using the Services Menu
• Your systemʼs Services submenu (found under the menu with the name of whatever application you happen 

to be in) contains a Create QuicKeys Shortcut menu item. If you select text in a document or a file or folder 
from the Finder, choosing this menu item will instantly create a shortcut of the appropriate type.

 ❖ Note: Not all applications support the Services menu.

 

Figure 2-3. Creating a shortcut using the systemʼs Services menu.
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The Shortcut Editing Window
The Shortcut Editing window appears with shortcut-specific options when you create a new shortcut or open and 
existing shortcut for editing. The two general tasks you perform in this window are creation of the shortcut step or 
steps, and assignment of a trigger or triggers to activate the shortcut.
More than one shortcut editing window can be open at the same time. This is convenient for copying and pasting or 
dragging and dropping steps from one shortcut to another.
❖ Note: When a shortcut editing window is open, that shortcut is disabled so it will not trigger. If a shortcut you 
recently edited isnʼt triggering, it may be that you left the editing window open for that particular shortcut.

 

Figure 2-4. The Shortcut Editing Window

The Shortcut Editing Toolbar
Like the main QuicKeys Editor window, the Shortcut Editor window also has its own independently customizable 
toolbar. You will notice that this toolbar contains a few buttons that do not appear on your main editor toolbar; when 
you are editing a shortcut rather than working with the main list window, you will likely want a different set of tools 
within easy reach.
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❖ Note: Every shortcut uses the same editor toolbar. If you customize this toolbar while editing a shortcut, it will be 
changed for all shortcuts you edit.

The Default Buttons
• Inspector – Clicking this button will show/hide the Inspector window. This window displays information about 

the shortcut you are editing. See page 33 of this chapter for more information on the Inspector.
• Rename – A quick way to rename the shortcut.
• Record More – Click this button to tell QuicKeys to resume interpreting and recording your actions. Steps 

recorded will be added to the current shortcut rather than creating a new shortcut. See page 45 of the next 
chapter for more information on Recording.

• Pause – This button represents the Pause shortcut type. If you click on this button, QuicKeys will create a new 
Pause step within the current shortcut. The new step will be placed below any selected step, or at the end if no 
steps are currently selected. This button is provided as an example of placing often-used items on this toolbar.

• Type Keystroke – This button represents the Type Keystroke shortcut type. If you click on this button, 
QuicKeys will create a new Type Keystroke step within the current shortcut. The new step will be placed 
below any selected step, or at the end if no steps are currently selected. This button is provided as an example 
of placing often-used items on this toolbar.

The Scopes & Triggers area
The Scopes & Triggers pane of this window is where you specify in which applications your shortcut can be 
triggered, and what types of triggers will activate your shortcut. A shortcut can have more than one scope, and each 
scope can have more than one trigger. This pane can be enlarged by dragging the Resize Bar downward with your 
mouse, and each scope can be collapsed/minimized by clicking on the reveal triangle in the upper left corner of the 
Scopes & Triggers area.

Features of the Scopes & Triggers area
The number of interface elements in the Scopes & Triggers area is somewhat daunting. But each item is easily 
identified through hot help; simply hover your mouse over any button or pop-up list for a couple of seconds to see 
what that item is.

• Scope pop-up list – To set the scope for a particular trigger, choose an item from this list. If the application you 
want is not listed, choose Select Application and navigate to it.

• Subscope pop-up list – If so desired, you can set up and choose subscopes with this pop-up list. Subscopes 
break application scopes into more focused mini-scopes; they are an advanced feature explained in Chapter 4 
of this manual.

• Add/Remove Scope buttons – Two square, gray buttons occupy the top right corner of the Scopes & Triggers 
area. These buttons are used to create additional scopes or to delete selected scopes.

• Change Trigger Type pop-up list – Choose the type of trigger you want to activate/play the shortcut. Triggers 
are explained in detail in Chapter 4.

• Edit Trigger button – Depending on the type of trigger you are creating, clicking this button will open a small 
trigger editing window. Make the selections desired and close the trigger editing window to complete your 
trigger.
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• Add/Remove Trigger buttons – A scope can have multiple triggers. Click on the round, green button with the 
“+” in it to add a new trigger. Click the round, red button with the “-“ in it to delete a trigger.

• Group with preceding trigger button – If you add a second trigger to a scope, a square, blue button with a “+” 
in it will appear. Clicking this button will group that trigger with the one above it. This is an advanced feature 
and is better explained in Chapter 4.

The Steps area
The Steps area is where you edit the actions you want your shortcut to perform. This pane of the Shortcut Editor 
window will contain one or more steps. 

Features of the Steps area
Each stepʼs contents may vary widely from the next, but there are also some elements common to every step, 
starting from the top...
• Steps # - Indicates the number of steps in the shortcut. Also indicates how many, if any, steps are currently 

selected.
• Add/Remove Steps buttons – Clicking the Add [+] Step button will open a pop-up list that mirrors the 

Create Menu, allowing you to add a new step to the shortcut. Clicking the Remove [–] Step button will 
delete any steps you have selected at the time.

• Step number – A stepʼs number is located in the upper left corner of the step.
• Reveal triangle – The small triangle to the right of the step number can be clicked to minimize or reveal the 

contents of a step.
• Step icon – The small icon to the right of the reveal triangle identifies what kind of QuicKeys shortcut/step 

it is.
• Step name – To the right of the step icon is the stepʼs name. You can edit this name by clicking on it if so 

desired.
• Enable/Disable Step button – The upper right corner of a step contains a small button that can be clicked to 

enable or disable a specific step within a shortcut. If a step is enabled, this button contains a check mark. If 
a step is disabled, the button contains a dash and the entire step is grayed out.

• Step Results indicator buttons – These dual function elements are indicators as to how a stepʼs success 
or failure will be handled by QuicKeys. The button on the left shows what QuicKeys will do if that step 
completes successfully, the one on the right indicates what happen if that step fails. In addition, clicking on 
these buttons will open the Inspector window so you can make changes to the Step Results behavior.

 
Playing Shortcuts
Shortcuts can be activated or played using the assigned triggers or by selecting Play from the Shortcuts menu in 
the QuicKeys Editor. When you play a shortcut, the Playback palette appears (if you have not turned this feature 
off in QuicKeys  ̓preferences), giving you feedback regarding the progress of the shortcut that is playing. When the 
shortcut finishes playing, the Playback palette will disappear.
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Figure 2-5. The QuicKeys Playback palette

Playback Palette Options
• Step name – Across the bottom of the QuicKeys playback palette is the name of the step that is currently 

playing.
• Step number – On the right side of the palette is the number of the step currently playing.
• Play/Pause button – This button pauses a playing shortcut and resumes a paused shortcut.
• Execute step button – When a shortcut is paused you can use this button to execute the next step in the 

shortcut.
• Stop button – Clicking this button will stop a playing shortcut.
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Tutorial 2 – Multi-step Shortcuts
Itʼs time for another break from the reading. Letʼs create another shortcut, making use of some of the new things 
weʼve learned. This tutorial will provide an example of multiple steps and multiple triggers in one shortcut.

The Problem
“I frequently transpose characters when typing, sometimes entering ʻwrok  ̓instead of ʻworkʼ, or ʻthier  ̓instead of 
ʻtheirʼ. It would be great if QuicKeys provided a way to quickly swap characters that are out of order.”

The Solution
Build a short, multi-step shortcut in QuicKeys X3 that swaps adjacent characters in a text editor whenever you press 
Control+Shift+Up Arrow on your keyboard or when you speak the words “QuicKeys, Swap characters.”
This sequence will consist of four steps, all of which will be Type Keystroke shortcuts. The first step selects the 
character to the right of the insertion point. The second cuts that character. The third moves the insertion point 
in front of the left character. The fourth step pastes in the character that was cut earlier, swapping their positions. 
Simple!

How To

Part One - Create the shortcut steps:
1. Bring up your QuicKeys Editor window by clicking on the QuicKeys icon in the Dock, or by selecting 

QuicKeys from the QuicKeys Menu up by your system clock.
2. Select User Actions -> Type Keystroke from QuicKeys  ̓Create menu to make a new Type Keystroke shortcut.
3. Click in the Keystroke field and press Shift+Right Arrow to assign the keystroke we want QuicKeys to send 

first. When our shortcut is playing, this step will select the character to the right of the text insertion point.
 ❖ Note: Part One of this How To section deals with only the bottom half of the Shortcut Editor window; just 

ignore the upper half of the window until we get to Part Two.
 ❖ Note: If you need more working space in the bottom half of the Shortcut Editor window, feel free to resize it 

as you would any document, and/or drag the resizing bar (shown in Figure 2-4 on page 20) upward to increase 
working space.

 

Figure 2-7. Tutorial Step 3, selecting the character to cut.

4. Letʼs make our second step in a different way. Click on the gray bar of the first step (not in the Keystroke field) 
to select it. The entire step should get a colored highlight around its edges as shown in Figure 2-8. Now press 
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Command+C to copy the step and then Command+V to paste a new copy in as step 2.

 

Figure 2-8. Tutorial Step 4, showing the first step as selected/highlighted.

5. Set the Keystroke field in this new second step to Command+X. When our shortcut is playing, this step will 
cut the selected character onto the system clipboard.

6. Letʼs make the third step in yet another way: Click the Add Step [+] button and select Type Keystroke from the 
menu that pops up, as shown in Figure 2-9. A new step has been created below step 2.

 

Figure 2-9. Tutorial Step 6, using the Add Shortcut button.

7. In the newly created shortcut step 3, enter a Left Arrow in the Keystroke field.
8. Using whatever method you desire, create a final Type Keystroke step, and enter Command+V in the 

Keystroke field.
9. You should now have four completed steps in your shortcut. This would be a good time to save your work. 

Select Save Shortcut from QuicKeys  ̓File menu (or press Command+S on your keyboard), and save this 
shortcut with the name “Swap Characters.”

10. Before we continue on to assigning triggers, letʼs make sure weʼre all looking at the same thing: For each step, 
toggle the reveal triangle shut (found in the upper left corner of the steps, next to the step number) to collapse 
them, and make sure your steps look like those in Figure 2-10.

❖ Note: If you hold down your option key and click the reveal triangle for an open/expanded step, all reveal 
triangles in that shortcut will change from expanded to collapsed. Likewise, an option-click on a closed triangle will 



27

Chapter 2 - Overview & Editor

expand all of the steps in a shortcut.

 

Figure 2-10. Tutorial Step 10, collapse the steps for a more compact view.

Assign triggers:
Itʼs time to switch our focus to the upper half of the Shortcut Editor window, the Scopes & Triggers area. 
When we started this tutorial, our stated solution included the ability to trigger this shortcut by pressing the 
Control+Shift+Up Arrow combination, or by speaking the phrase “QuicKeys, swap characters.”
❖ Note: While you can set up a speech trigger even if you donʼt have a microphone, you must have a 
microphone attached to your Mac to get the speech trigger to work.

11. First we need to make sure the Scope is set properly. We want this shortcut to work in any application we 
happen to be using, so it must be scoped to “All Applications”. The Scope pop-up list will highlight as shown 
in Figure 2-11 when you hover your mouse over it. If “All Applications” is not selected, select it now.

12. Next we need to select the type of trigger we want to use. Your shortcut likely already says “hot key”, but 
if not you can click the Change Trigger Type pop-up list and make it so. The Trigger Type pop-up list will 
highlight as shown in Figure 2-11 when you hover your mouse over it.
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Figure 2-11. Tutorial Steps 11-12, setting scope and trigger type.

13. To the right of the hot key pop-up list youʼll see a hot key listed. QuicKeys has automatically assigned one of 
your F-keys as the hot key, but weʼre not going to use the key it suggested. Click on the key that QuicKeys 
assigned (“F4” in our example screenshots) to reveal a small Hot Key assignment window. Assign the desired 
hot key by pressing Control+Shift+Up Arrow, then click the round “X” button to close the hot key assignment 
window.

 

Figure 2-12. Tutorial Step 13, assigning the hot key.

14. With the desired hot key trigger in place, it is time to add another trigger. To the left of our hot key trigger are 
two small round buttons. These buttons add or remove triggers from a scope. Click on the green (+) button to 
add a second trigger to this shortcut. QuicKeys will automatically create a new trigger of the hot key variety.
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Figure 2-13. Tutorial Step 14, add a second trigger.

15. We want to change this new trigger to a speech trigger, so click on the trigger pop-up list and change it from 
“hot key” to “speech”. This will open a small window with a text field, enter “swap characters” in that field. 
Click the circled “X” to close the Speech phrase window.
❖ Note: If the new trigger is obscured because the Scopes & Triggers area is too small, simply grab the sizing 
bar and drag downward to increase the work space.

 

Figure 2-14. Tutorial Step 15, set the speech trigger.

16. Save your new 4-step shortcut again. Your Shortcut Editor window should look very similar to Figure 2-15 at 
this point.
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Figure 2-15. The completed Swap Characters shortcut.

Test your shortcut:
Close your new shortcut window and launch TextEdit or another text editor and type “wrok”. Now put your 
cursor between the “r” and the “o” and hit the hot key for your new Swap Characters shortcut. QuicKeys 
transposes the letters for you in a flash! If you have a microphone attached to your computer, trigger your 
shortcut again by saying “QuicKeys, swap characters” clearly into the microphone.

Alternate Solutions
There are a couple of alternate ways to make this shortcut. For instance, rather than having to move your cursor 
back between the transposed letters before triggering your swapping shortcut, it may be more efficient to work from 
the right-hand side of those transposed letters. To use this method, you would need to change your first step to a 
Shift+Left Arrow keystroke.
Another use for this type of shortcut is putting quotes around a block of text. If you have a bit of text highlighted, 
the easiest way to put quote marks around that block is to have QuicKeys do Command+X to cut the text, enter a 
quotation mark, press Command+V to paste the text, and enter another quotation mark. This technique will work 
for bracketing highlighted text or data in other ways, such as adding parenthesis or opening and closing HTML tags. 
You name it, QuicKeys will streamline it!
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The QuicKeys Menu
The QuicKeys Menu is made available by default when you first install and run QuicKeys X3; it is located in your 
computerʼs menu bar near the system clock. This menu can be turned on and off with the corresponding preference 
setting. The QuicKeys Menu provides quick access to some of QuicKeys basic components, as well as a list of 
shortcuts to which you may have assigned “menu” trigger types.

 

Figure 2-16. The QuicKeys Menu

QuicKeys Menu contents
• QuicKeys... - Opens the QuicKeys Editor window.
• Turn Triggers Off – Shuts off all triggers, taking QuicKeys “out of the way” if necessary without the need to 

quit the program. This menu item changes to “Turn Triggers On” if they are currently shut off.
• Subscopes – Subscopes you have defined can be selected/activated from this submenu.
• Toolbars – Show or hide individual Toolbars from this submenu.
• Edit Toolbars... – opens the Toolbar editor.
• Pause Playback – If a shortcut is playing, this will pause playback. When a playing shortcut is paused, this 

menu item changes to “Resume Playback”.
• Stop Playback – If a shortcut is playing, this will stop playback entirely.
• Start Recording Me – Starts QuicKeys interpreting and recording your actions. If recording is in progress, 

this item changes to “End Recording Me”. Selecting "End Recording Me" stops recording and opens a new 
shortcut with your actions inside.

• Cancel Recording Me – Cancels recording in progress, no shortcut is created.
• Shortcut list – Any shortcuts you create with triggers of type “menu” will show up here, below the last menu 

divider line.
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The QuicKeys Dock Menu
The QuicKeys Dock Menu is made available by default when you first install and run QuicKeys X3. Clicking on 
the QuicKeys Dock icon will open the QuicKeys Editor. Right-clicking or holding your control key and clicking 
on the QuicKeys Dock icon brings up the Dock menu. The QuicKeys Dock icon can be turned on and off with the 
corresponding preference setting.

 

Figure 2-17. The QuicKeys Icon Dock Menu

QuicKeys Dock Menu contents
The QuicKeys Dock Menu is nearly identical to the QuicKeys Menu which is described in detail on page 55 
however the following menu items are unique to the QuicKeys Dock Menu:

• Show In Finder – Switches the Finder to the front and opens your Applications folder, or whichever folder 
happens to contain the QuicKeys X3 application.

• Hide – Hides QuicKeys and any associated windows.
• Quit – Quits the QuicKeys application.
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The Inspector Window
Certain information about QuicKeys shortcuts is accessible through the Inspector window rather than within the 
editor windows. Exactly what information this Inspector window contains depends on the context under which it 
was opened. If you are working in the main QuicKeys Editor window and open the Inspector, it will only show 
whether or not a shortcut you have selected in the main list exists on a Toolbar.
However, if you have a Shortcut Editor window open and you bring up the Inspector, it will present six different 
informational views that can be switched by clicking the icons along the top edge.

 

Figure 2-18. Three of the six Inspector window views

Inspector window views
• Shortcut Controls - This view contains a checkbox to toggle the entire shortcut that you have open on/off. This 

has the same effect as the On/Off checkbox in the shortcut list area of the QuicKeys Editor window.
• Shortcut Comments - This view contains a field where you can write comments about the entire shortcut you 

have open.
• Step Comments - Stores comments for each individual step within an open shortcut.
• Shortcut Icon - Customize the look of your shortcuts; drag and drop a new shortcut icon here.
• Shortcut Toolbars - Lists any Toolbars that contain the shortcut you have open.
• Step Results - Two pop-ups in this view allow you to customize how QuicKeys reacts to the success or failure 

of each step in a shortcut.
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Step Results
By default, when a shortcut step fails, QuicKeys stops the playback of that shortcut and alerts you with a warning 
message. If the step succeeds, playback continues on to the next step. These are not, however, the only options 
available for handling the success/failure of a step. Every shortcut step has a pair of Step Results indicator buttons 
in the bottom right corner; the button on the left indicating what will happen if the step is successful, the one on the 
right showing what QuicKeys will do if the step fails.
❖ Note: Hovering your mouse over a Step Results indicator button for a couple of seconds will cause a tool tip to 
appear, describing that particular step resultʼs behavior.

 

Figure 2-19. Step Results indicator buttons

Clicking on either of the indicator buttons will open the Inspector window to the Step Results view. From this view 
you can manipulate both the Success and Failure results for a given step, instructing QuicKeys to handle those 
results as you see fit.

 

Figure 2-20. The Step Results and Inspector window relationship

For example, you could set a shortcutʼs failure result to be ignored and proceed on to the next step, or to stop 
playback but with no warning window. Or, you might direct a successful step to jump ahead during playback, 
skipping a specified number of steps in the process.
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Icon Step Options Description
Continue to next step Continues to the next step of the shortcut if one exists.

Stop shortcut and notify me Stops playback and notifies the user that the shortcut 
stopped.

Stop shortcut Stops playback of the shortcut with no notification to the 
user.

Jump to step (by offset) Jumps forward (or back) the number of steps specified by 
the user.

Jump to (specific) step Jumps forward (or back) to a specific step in a shortcut.

Figure 2-21. Step Results icons

Being able to change the flow of a shortcutʼs playback depending on the success or failure of a step, combined with 
logic handling shortcut steps like Decision and Wait makes for many powerful new ways to build your shortcuts and 
take control of you computing.
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Tutorial 3 – Step Results in Action
This tutorial will build upon the concept of the multi-step shortcut, adding Step Results to the mix. Even the novice 
user will quickly see ways to make use of this powerful feature of QuicKeys.

The Problem
“I want to launch TextEdit in Plain Text mode sometimes, but in Rich Text mode other times. What kind of shortcuts 
can I build to automatically make that happen for me?”

The Solution
Build two similar shortcuts to launch TextEdit. One of those shortcuts will select “Make Plain Text” from the Format 
menu after launch, the other will select “Make Rich Text” after launch.
Weʼll only build the first shortcut since the second is nearly identical. Our shortcut will consist of 5 steps. The last 
two steps are only necessary to demonstrate the custom Step Results weʼll be setting up.

1. Open TextEdit
2. Wait for TextEdit to finish loading
3. Select Make Plain Text from the Format menu

• If TextEdit is successfully switched to Plain Text mode, continue on to step 4.
• If TextEdit was already in Plain Text mode, skip step 4 and continue on to step 5.

4. Type “TextEdit is now in Plain Text mode” and stop playback of the shortcut.
5. Type “TextEdit was already in Plain Text mode” and stop shortcut playback.

How To

Part One - Create the shortcut steps:
1. Open the QuicKeys Editor, then go to your Applications folder and find your TextEdit application. Drag & 

Drop TextEdit onto the open QuicKeys Editor window to instantly create an Open TextEdit shortcut step.



38

Chapter 2 - Overview & Editor

 

Figure 2-22. Drag and drop TextEdit onto the QuicKeys Editor 
window to create a new Open Items type shortcut.

2. To add the second step, click the Add Step [+] button and select QuicKeys -> Wait -> Wait for Application 
from the menu that pops up.

3. In the newly created Wait step, select TextEdit from the Application pop-up list. If TextEdit is not running it 
will not show up here so you will need to choose “Select Application...” and navigate to it instead. Leave the 
State pop-up set to “is running”.

 

Figure 2-23. Step 3, setting up the Wait for Application step.

4. Toggle shut the first two steps  ̓reveal triangles to give yourself more room to work. Click on the gray header 
bar of shortcut step number two to select it, then go back to the Add Step [+] button and select User Actions 
-> Menus -> Menu Selection to create step three.

5. The new Menu Selection step needs to be configured to access the desired menu item. There are two ways to 
set up menu selection shortcuts; weʼll do it manually but you can look at the Menu shortcut descriptoin on 
page 173 for details on the more automated method. 
Type “Format” in the Menu field, then type “Make Plain Text” in the Menu Item field. Down near the bottom 
of this step youʼll also want to put a check in the Show menus while performing menu action box. The reason 
for this is explained on page 175 in the Menu Selection shortcut documentation.



39

Chapter 2 - Overview & Editor

 

Figure 2-24. Step 5, configuring the Menu Selection step.

6. The fourth and fifth steps of this shortcut are for proof of concept. These steps are simple Type Text steps, so 
go to the Add Step [+] button and select Text -> Type Text from the pop-up twice to add two Type Text steps. 
In the first Type Text shortcut, enter the text “TextEdit is now in Plain Text mode.” In the second Type Text 
shortcut, enter the text “TextEdit was already in Plain Text mode.”

7. Letʼs make sure weʼre looking at the same thing now. Toggle shut the reveal triangles for each step (or 
Option+Click one of them to toggle them all). Your steps should look like what is shown in Figure 2-25.
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Figure 2-25. How your shortcut should look after completing tutorial step 7.

Part Two – Setting the Step Results
Now for the fun part: configuring the Step Results! Shortcut Steps 1 and 2 need not be changed, they are both set 
to continue on to the next step if they succeed, and to stop playback and notify you if they fail. You can hover your 
mouse over the Step Results indicator buttons for each step to see hot help describing what actions will be taken 
when a step succeeds or fails.
The third shortcut step is the one we are concerned with; it is the step that will fail if TextEdit is already in Plain Text 
mode when we run our shortcut. But remember, our shortcutʼs purpose is to put TextEdit into Plain Text mode, so if 
it is already in that mode when we trigger our shortcut, do we really care that the menu selection “Make Plain Text” 
failed? No we donʼt, it is better that QuicKeys does not interrupt our work to tell us that the “Make Plain Text” menu 
item is not available when weʼre already in plain text mode.

8. Click on one of the Step Results buttons in shortcut step 3. This will open the Inspector window to the Step 
Results view for step 3.

9. In the Inspector window, change the Step Failure pop-up to “Jump to Step”.  Select the "Jump to specific step" 
radio button and put a “5” in the numeric field. QuicKeys will now jump to step 5 rather than do the default 
action of stopping playback and notifying us if this shortcut step fails.
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Figure 2-26. Setting shortcut step 3ʼs Step Failure action.

10. Now we need to change step 4ʼs success results so that success stops the shortcut from continuing to step 5. In 
your Shortcut Editor window, click on step number 4. The Inspector will change its contents to show you the 
Step Results for step 4. Set the Step Success pop-up to “Stop Shortcut”.
Thatʼs all for Step Results setup; the Step Results indicators for shortcut steps 3 and 4 should look exactly as 
shown in Figure 2-27. Save this shortcut and name it “Plain TextEdit” or something similar.

 

Figure 2-27. Finished Step Results for shortcut steps 3 and 4.
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Assign triggers:
Weʼre going to create a new type of hot key trigger for this tutorial, this one using “Sticky Keys” which allow 
you to chain a series of hot keys together. When you create multiple hot key triggers for a shortcut and “group” 
them, QuicKeys treats them as a single trigger that is activated when the hot keys are pressed in sequence.

 

Figure 2-28. Setting up the grouped “Sticky” hot key triggers.

11. In the Scopes & Triggers part of the Shortcut Editor, set the Scope pop-up to All Applications.
12. Click on whatever hot key was automatically assigned by QuicKeys when you created this shortcut. Change 

the hot key to Control+T (⌃T). This hot key symbolizes the name “TextEdit”.
13. Click on the Add Trigger button (the small green circle (+) to the left of the hot key trigger); this will create a 

second hot key trigger. Assign the letter P as the second hot key. This hot key symbolizes the Plain Text notion 
of this shortcut.

 ❖ Note: You may need to drag the sizing bar downward to give yourself more working space in the triggers 
area.

14. Now click on the blue square with the plus sign in it. This will group the second hot key trigger with the first 
and automatically make them Sticky.
Your Scopes and Triggers area should now look like the example in Figure 2-29. Save and close the shortcut 
so you can test it.

 

Figure 2-29. The finished Scopes & Triggers setup featuring grouped hot keys.



43

Chapter 2 - Overview & Editor

Test your shortcut:
Once you have saved and closed the Shortcut Editor window you can try the hot keys. Press Control+T and release; 
note that a white “⌃T” appears on your monitor. This is to let you know that a stickied hot key has been pressed. 
Now press the P key to fire the shortcut.
❖ Note: Sticky/Grouped hot keys time out after a short time. If you wait more than a couple of seconds to press 
your second grouped hot key, the shortcut will not trigger. The amount of time QuicKeys waits before giving up on a 
follow-up key press can be adjusted in QuicKeys  ̓preferences.
So when you triggered the shortcut, TextEdit should have been opened, itʼs mode switched to Plain Text, and 
QuicKeys will have typed “TextEdit is now in Plain Text mode.”
Without closing TextEdit, press Return for a new line, then press the hot key chain again. On the second run of 
this shortcut, TextEdit is already in Plain Text mode so step 3 will fail, branch to step 5 on that failure, and type 
"TextEdit was already in Plain Text mode.” Exactly what we wanted!

Alternate Solutions
Fire and forget menu selection shortcuts are useful in a lot of situations. Any time you want to make a menu 
selection but donʼt care if it fails, you can set the Step Results to do something different or just ignore failure.
More to the point, Step Results in general have massive potential for making your shortcuts more intelligent. Have 
you ever tried to make a shortcut whose timing was at the mercy of the loading of a web page? Load times vary 
widely from page to page, minute to minute, but what happens when a page is done loading? In Safari, a menu 
item named “Reload Page” becomes enabled. Put that knowledge together with a Wait for Menu shortcut and some 
creative Step Results; youʼve got a shortcut that will never overrun the state of your browser.
Check out the Decision shortcut on page 101 and the Wait shortcut on page 126 in Chapter 7 for more ideas on how 
to use Step Results to bring more power to your QuicKeys efforts.
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Recording
QuicKeys shortcuts can be built manually or you can turn on Recording and let QuicKeys interpret your actions and 
turn them into shortcut steps; just add a trigger and a do a little tweaking and youʼll be up and running with a new 
shortcut. This section provides the basics of how recording works and ends with a Recording example. The example 
may not directly apply to the way you will be using QuicKeys, but it will illustrate the method.

Initiating Recording
There are several ways to tell QuicKeys to start recording:

• Select Start Recording Me from the QuicKeys Menu up by the system clock or from QuicKeys  ̓Dock icon 
menu.

• From within the QuicKeys Editor, click the Record button in the toolbar.
• When editing a shortcut, click the Record More button in the toolbar.
• Press ⌘+F1 to trigger the Toggle Recording shortcut that was installed by default with QuicKeys X3.

❖ Note: If you press the Option key when you start recording, the "Do exhaustive click and typing analysis" 
preference will toggle to the opposite setting for the current recording.

Stop Recording
When you want to end or cancel recording, use one of the following options:

• Select End Recording Me from the QuicKeys Menu or from QuicKeys  ̓Dock icon menu.
• Click the Cancel Recording or End Recording button in the QuicKeys Recording window.
• Press ⌘+F1 to trigger the Toggle Recording shortcut that was installed by default with QuicKeys X3.

❖ Note: Ending recording captures what youʼve recorded and presents it to you as a shortcut for further 
editing, while canceling stops recording and discards any recorded steps from that recording session.
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QuicKeys Recording Tutorial Window
When you begin to record a shortcut, the QuicKeys Recording Tutorial window appears. Read this tutorial window 
carefully and practice clicking and typing in the areas provided before you record your first shortcut.

 

Figure 2-30. The QuicKeys Recording Tutorial window

Example of Recording: Check for Updates
Since everyone has easy access to their System Preferences weʼre going to be using it for our recording example. 
Our plan will be to record the following actions: select System Preferences from the Apple Menu, click on System 
Preferences, then click on the Check Now button.
Before we start recording, letʼs prepare. It is a good idea to quit any applications that wonʼt be involved in 
the recording. Not only does this get them out of your way so they donʼt impede your work flow, it can help 
performance and thus increase recording accuracy.
Speaking of accuracy, QuicKeys will almost always record a couple of actions that you will want to prune from 
the resulting shortcut. QuicKeys will err on the side of caution and record everything it can, so if you get up to 
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put on your pajamas in the middle of a recording, expect a three and a half minute pause step to show up in there 
somewhere. Likewise, if you accidentally click on the wrong thing or inadvertently press a key, QuicKeys is going 
to capture that action and youʼll have to delete that step after youʼve ended the recording. Okay let s̓ get started.

1. Switch to the Finder then go to your QuicKeys Menu up by your system clock and select Start Recording Me 
(or press ⌘+F1 to trigger the Toggle Recording shortcut that was installed by default with QuicKeys). This 
tells QuicKeys to begin recording and the QuicKeys Recording Tutorial window (shown in Figure 2-30) will 
appear.

2. Read and follow the instructions in the recording tutorial window. When you are satisfied that you have a feel 
for the pace and technique of recording, click the Start Recording button on the QuicKeys Recording Tutorial 
window. Within a second or two, a small QuicKeys Recording window will appear.

 

Figure 2-31. QuicKeys Recording window

3. Once the QuicKeys Recording window appears, go to the Apple menu and select System Preferences...
4. When the System Preferences window opens, hover your mouse over the Software Update button long enough 

for it to turn green. This tinting is a QuicKeys recording hint and it is telling you that it has identified a button 
under your mouse pointer. Now deliberately click and hold on the Software Update button for a second or 
more to ensure the button click is recorded.

 ❖ Note: If when you open the System Preferences “Show All” is not selected (thatʼs the upper left button on 
that window), you will need to cancel recording. Then click on the Show All button, quit System Preferences, 
and go back to step 1 of this example and start again.

 

Figure 2-32. QuicKeys Recording Hint over the Software Update button

5. After the System Preferences window changes views to the Software Update pane, deliberately click on the 
Check Now button, holding the mouse button down long enough for QuicKeys to record the action.

6. Thatʼs all weʼre going to record, click on the End Recording button on the QuicKeys Recording window. This 
will cause QuicKeys to come to the front and open the new shortcut for you to edit.

7. Your new shortcut will likely have from 4 to 7 steps. The variation comes in mainly from pauses that might 
have been put in during the recording. Depending on how long you took to do steps 1 through 6, you may or 
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may not find errant pauses in your recording.

 

Figure 2-33. Recording example, resulting shortcut steps

8. Toggle the reveal triangles (located just to the right of each shortcut step number) to display the shortcut more 
compactly. Your shortcut should look similar to the one in Figure 2-33.

Tips and Troubleshooting Recordings
The goal of this example was not to build a polished, working shortcut, but to demonstrate the process of recording. 
If you were going to finish this shortcut youʼd want to assign a trigger and change the Scope from the Finder to All 
Applications. Youʼd also want to review the steps closely and delete or reduce in duration any superfluous pauses, 
then play the shortcut back to test its accuracy. Further refining and testing might be needed.
This is pretty much the pattern for any recording you do. Youʼll want to plan and prepare a little so you can 
deliberately proceed through the actions you want to record, allowing QuicKeys the best opportunity to interpret 
what youʼre doing. After you end the recording youʼll need to evaluate what QuicKeys has captured and presented 
in the new shortcut. A couple of rounds of editing and testing the results of the recording will be common, larger 
recordings likely requiring more.
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QuicKeys Debugging
QuicKeys offers a debugging tool that can help you troubleshoot your recordings. Select Shortcuts -> Turn on 
Shortcut Debugging to activate this tool. When debugging is enabled, QuicKeys guides you through certain steps of 
your multi-step shortcut to help you verify that the Shortcut will perform properly.

Using Debugging
The QuicKeys playback window will appear whenever you play a shortcut while Debugging is turned on. Use the 
Execute Step button (the second from the left)  on this window to step through your recording one shortcut step at a 
time.

 

Figure 2-34. QuicKeys playback window

During playback, when QuicKeys encounters a Click, Windows, Button, Pop-up Menu, or Wait type shortcut, the 
debugger will take over and ask for your input.

 

Figure 2-35. Debugger asking if the target button is in this window.
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• If the step shown by the debugger is correct, click the Continue button.
• If the step shown is not accurate, click the Stop & View step button and the Shortcut Editing window will 

appear with the questioned step highlighted.
• Click the Stop button during debugging when you are done verifying the multi-step shortcut and you want to 

stop the playback process.

 

Figure 2-36. Debugger asking if this is the target button.

This debugging feature is very useful and will help you figure out whether or not QuicKeys is finding the desired 
buttons and windows on playback. Problematic steps identified by debugging can either be hand edited or deleted 
and recorded again.

Timing Is Everything
While QuicKeys may improperly record an action, the majority of the time the real problem during playback is 
timing. Buttons and windows wonʼt be found, menu items wonʼt be active, etc. if the timing of a sequence is not 
right. It takes time for the system to load an application, draw a new window, switch from one pane to another, and 
on slower systems it is much more noticeable.
The solution is often adding the simplest shortcut step that exists in QuicKeys, the Pause shortcut. A Pause of one 
or two seconds in a couple of locations will often mean the difference between a working shortcut and one that fails 
intermittently.
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To access QuicKeys  ̓Preferences, select Preferences from the QuicKeys X3 menu, or press “⌘,” while QuicKeys 
is the front-most application. The preferences window is divided into 4 tabs, General, Triggers, Recording, and 
Administration.

 

Figure 3-1. QuicKeys Preferences: the General and Triggers panes.

The General pane

General Settings
• Show playback palette - If this is turned on, a small playback palette will be shown on screen while 

shortcuts are playing.
• Automatically name single-step shortcuts - With this option turned on, most new shortcuts will 

automatically be named according to the type of shortcut it is. You can always change this name if it is not 
to your liking.

• Automatically save shortcuts - If this option is off, QuicKeys will prompt you to save edited shortcuts when 
you try to close them. If this is turned on, they will automatically be saved before closing.

• Show QuicKeys Menu in menu bar - Turns the QuicKeys Menu, located up by your system clock, on and 
off.

51
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• Show QuicKeys icon in Dock - When this box is checked, the QuicKeys icon is displayed in the Dock 
when QuicKeys is running. You may want to turn this feature off if you donʼt care to have QuicKeys in the 
Dock. Any changes made to this preference setting will affect all users on that machine.

▫ Show QuicKeys Menu in Dock - If this menu is turned off, the handy options available to you when 
you right-click or control-click the QuicKeys Dock icon will no longer be there.

▫ Animate Dock icon when playing shortcuts - If this preference is on, the clock hands on the 
QuicKeys Dock icon will spin during shortcut playback so you know QuicKeys is busy. This is a 
good option to have on if you leave the playback palette turned off.

• Open QuicKeys at log in - Select this preference if you want QuicKeys to launch when you log in to your 
computer. If this preference is not selected, your shortcuts will not work until youʼve launched QuicKeys 
manually.

• Display QuicKeys Editor window on open - If this is turned on, the QuicKeys Editor window will open 
whenever you launch the QuicKeys application. This is helpful in letting you know when QuicKeys is fully 
loaded after you launch it.

• Display warning when quitting - If you select this option, QuicKeys will ask, “are you sure” when you try 
to quit the program. This helps prevent inadvertently quitting QuicKeys.

Typing speed
• Slider - Set the global typing speed for all new actions where QuicKeys types text. On slower systems 

QuicKeys may type faster than the systemʼs typing buffer; adjust this slider to prevent that from happening.
• Sync All Typing Actions button - Each shortcut that can type text will have its own slider much like the 

Typing Speed slider found in the preferences. These individual shortcut sliders take precedence but can all 
be reset to match the general prefs Typing Speed slider by clicking this button.

Reset “Do Not Show Again” messages
• Reset button - If you click this reset button, QuicKeys will reset all of its “Do not show again” checkboxes. 

For example, if you have shut off the “Do not show again” warnings that occur when you delete a shortcut, 
you can turn it back on by clicking this Reset button.

The Triggers pane

Enable Triggers
• Enable QuicKeys triggers - Turning this preference off will effectively disable QuicKeys until turned back 

on.
• Toggle triggers with hot key - If you turn this preference on, you can assign a hot key which will cause 

QuicKeys triggers to become disabled until you press that hot key again.

Default Trigger Type
• Pop-up list - When you create a new trigger in a shortcut, the type of trigger you have selected here is what 

will automatically be assigned to your shortcut.
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Hot Keys
• Hot keys are automatically Sticky when grouped together - When this preference is turned on, multiple hot 

keys that are grouped together in a shortcut will be considered “Sticky”. Sticky hot keys must be pressed 
in sequence to trigger a shortcut. For example, if you assign both F1 and F2 as hot keys for a shortcut, and 
group them together, pressing F1 and then F2 within a couple of seconds will trigger the shortcut.

• Sticky Duration slider - Increase or decrease the amount of time a Sticky hot key remains sticky. Increasing 
the duration means you have more time to press follow-up hot keys after having pressed the first one.

Speech
• Enable Speech Triggers - With this option turned on (and a microphone attached to your computer), 

QuicKeys can listen for speech input if you have assigned phrases to shortcuts as triggers. You should 
familiarize yourself with the Speech Recognition portion of your System Preference s̓ Speech pane if you 
are going to use this type of trigger.

• Speech Prefix - If desired, QuicKeys can be set to require that a specific phrase be spoken before it will 
start comparing what it hears to what you have entered as speakable phrases for your triggers.

 

Figure 3-2. QuicKeys Preferences: the Recording and Administration panes.

The Recording pane

Scope Creation
• Automatically assign scope when recording – When QuicKeys records your actions it can read which 

application you are recording in and automatically assign that application as the scope for that shortcut.
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Recording Hints
• Show recording hints – Recording hints tell you when QuicKeys has found an interface item that it can 

record, such as a button or checkbox. Recording hints will appear as you record if you pause for a moment 
over user interface items. Some items cannot be recorded directly, in which case the itemʼs window is used 
rather than the item itself.

• Recording hint color – This preference lets you set the color of the highlight that appears over user interface 
elements if Recording Hints are turned on.

Action Analysis
• Do exhaustive click and typing analysis - Some applications  ̓user interfaces may not be readily accessible 

to QuicKeys during recording. Exhaustive Analysis may allow recording in those instances, but it is 
recommended this feature be kept off unless specifically needed.

The Administration pane

Remote Administration
• Allow remote network administration – This setting allows or disallows the remote network administration 

of QuicKeys.
 ❖ Note: Currently the only remote administration action available in QuicKeys is the ability to remotely 

quit another copy of QuicKeys X3 that is using the same serial number/activation key. This feature allows a 
user to remotely shut down a conflicting copy of QuicKeys running on their second computer.

• Administration network port – If desired you can change the network port through which QuicKeys 
communicates with another copy of QuicKeys. The default port is 50000.

• Open Sharing Preferences – Click this button to open your systemʼs sharing preferences so you can set your 
systemʼs firewall to allow communication on port 50000 (the QuicKeys X3 remote administration network 
port number).
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The Menu Bar
When QuicKeys X3 is the front-most application, its menu bar is available. What follows is a description of each 
item in each menu on the QuicKeys X3 menu bar.

 

Figure 3-3. The QuicKeys X3, File, and Edit menus

The QuicKeys X3 menu
• About QuicKeys – Opens the About QuicKeys window that contains version and licensing information as 

well as buttons which take you to the product registration page or allow you to enter an new activation key or 
activate the product for all users on that computer (requires Administrator password).

• Preferences – Opens the QuicKeys Preferences window.
• Check for Update – If you are connected to the Internet this item will check to see if your version of QuicKeys 

is the latest.
• Provide QuicKeys X Feedback – This item will open your web browser to the QuicKeys product feedback 

page.
• Services –> Create QuicKeys Shortcut – This option can be used to instantly create new QuicKeys shortcuts 

from selected text inside documents or from items selected in the Finder. QuicKeys will create Type Text or 
Open Items shortcuts depending on what you have selected. This menu item is only active when QuicKeys X3 
is not the front-most application.

• Hide QuicKeys – Hides the QuicKeys application from view.
• Hide Others – Hides all running applications except for QuicKeys.
• Show All – Shows all running applications.
• Quit QuicKeys – Quits the QuicKeys X3 application.

❖ Note: If you are running a 30-day demo version of QuicKeys, this menu will also contain “Enter Activation Key” 
as a menu item. Use this menu item to enter your purchased activation key and remove the 30-day demo timer.
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The File menu
• New Shortcut – Creates a new shortcut with no steps.
• Save Shortcut – Saves the currently open shortcut.
• Rename Shortcut – Allows you to rename the currently open or selected shortcut.
• Reassign Scope – If you have a scope selected in the main QuicKeys Editor window, this item will allow you 

to change that scope to another application in all shortcuts simultaneously. For example, if an application to 
which you have scoped shortcuts undergoes a name change, you can use this option to change the old scope to 
match the new application name.

• Duplicate Scope – If you have a scope selected in the main QuicKeys Editor window, this item will allow you 
to duplicate that scope in all shortcuts at once. For example, if you have two versions of the same program and 
you would like to quickly scope your existing shortcuts to the new version, you can duplicate the scope.

• Import Shortcuts – Shortcuts that you have exported as a backup, or another user has exported to share can be 
imported.

• Export Shortcuts – Export selected shortcuts to back them up or to share with other QuicKeys X3 users.
• Subscribe to Shortcuts – Subscribe to remote shortcut repositories.
• Page Setup – Standard page setup dialog for printing.
• Print – Prints a list of all shortcuts in a selected scope, complete with icon, shortcut name, and trigger 

information.

The Edit menu
• Undo/Redo – Allows you to undo or redo such actions as deleting or rearranging shortcut steps in a multi-step 

shortcut. Deleting entire shortcuts is not something you can Undo.
• Cut – Cut the selected item to the system clipboard.
• Copy – Copy the selected item to the system clipboard.
• Paste – Paste the contents of the system clipboard.
• Delete – Delete the selected item.
• Select All – Select all shortcuts in a scope or all steps in a shortcut.
• Special Characters – Opens the Mac OS X Special Characters palette.
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Figure 3-4. The QuicKeys X3 View, Create, and Shortcuts menus

The View menu
• Hide Editor Toolbar – Hides/Shows the toolbar at the top of the QuicKeys Editor.
• Customize Editor Toolbar – Allows you to customize the contents of the QuicKeys Editor Toolbar.

The Create menu
• Start Recording Me – Tells QuicKeys to begin interpreting and recording your actions. This menu changes 

to “Stop Recording Me” when recording is in progress. Stopping recording creates a new shortcut containing 
steps that represent the actions you recorded.

• Cancel Recording Me – Canceling recording stops the recording process and discards any new actions that 
might have been recorded. No new shortcut is created.

• Files, Internet, Network, QuicKeys, Scripting, System, Text, User Actions – When an item is selected from 
one of these submenus a new QuicKeys shortcut of that type is created. However, if a shortcut is already front-
most, selecting from this menu will add a new step to that shortcut rather than create a new shortcut.

The Shortcuts menu
• Play – Plays a selected shortcut.
• Turn On Shortcut Debugging – Enables debugging mode to help you decipher problems you might be having 

with shortcut creation and playback.
• Edit Shortcut – Open the selected shortcut for editing.
• Edit Step Results – Opens the Inspector window so you can edit a shortcutʼs Step Results settings.
• Turn Shortcut Off/On – Shuts off or turns on any selected shortcuts.
• Apply Typing Speed to Siblings – In a multi-step shortcut that contains multiple typing steps, the typing speed 

of all steps within that shortcut can be matched to the currently selected step with this menu item.
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Figure 3-5. QuicKeys X3ʼs Toolbars, Window, and Help menus

The Toolbars menu
• New Toolbar – Creates a new Toolbar.
• Edit Toolbar – Edits a toolbar that you have selected in the QuicKeys Toolbar window.
• Delete Toolbar – Deletes a toolbar that you have selected in the QuicKeys Toolbar window.

The Window menu
• Close Window – Closes the front-most window.
• Zoom Window – Zooms the front-most window.
• Minimize Window – Shrinks the front-most window and puts it in the Dock.
• QuicKeys Editor – Opens the QuicKeys Editor window.
• QuicKeys Toolbars – Opens the QuicKeys Toolbars window.
• Show Inspector – Opens the Inspector window.
• Excluded Applications – Opens a window containing a list of applications that youʼve told QuicKeys to not 

trigger shortcuts in. This applies only to shortcuts scoped to All Applications; you can still scope shortcuts to 
excluded applications directly if desired.

• Variables – Opens the Variables window.
• Equation Tester – Opens the Equation Tester window.
• Bring All to Front – Pulls all windows associated with QuicKeys to the front.
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The Help menu
• QuicKeys Help – Opens the system Help Viewer window to display QuicKeys Help. These help files contain 

condensed, up-to-date documentation for QuicKeys X3.
• QuicKeys Community – Directs your web browser to the QuicKeys Community discussion forum web site.
• QuicKeys Newsletter – Directs your web browser to the QuicKeys Newsletter web page.
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QuicKeys Toolbars
QuicKeys Toolbars are small floating palettes that enable you to play QuicKeys Shortcuts with a single click. These 
toolbars have three components: the toolbar itself, the buttons on the toolbar and the toolbar tabs. You can create or 
edit these components using the Toolbar Editing sheet.
Toolbars can be opened and closed with a hot key or by selecting them from the QuicKeys Menu or the QuicKeys 
Dock Menu. They can be universal or they can be scoped to specific applications, accessible only when the scoped 
application is running.
❖ Note: Itʼs important to note that the QuicKeys Toolbars discussed in this chapter are floating toolbars you create 
to hold and play your QuicKeys Shortcuts; whereas the Editor and Shortcut Editing Toolbars discussed in Chapter 2 
are merely part of the QuicKeys application user interface.

Creating Toolbars
You can create QuicKeys Toolbars by selecting Toolbars -> New Toolbar when the QuicKeys Editor is open. When 
you choose to create or edit a QuicKeys toolbar, the Toolbar Editing sheet appears. Any changes to toolbars are 
saved as soon as you click the OK button on this sheet.

 

Figure 3-6. Editing a toolbar; the Toolbar tab.

The Toolbar Tab
• Name – This is the name of the new toolbar as seen in its title bar.
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• Hot Key – You can show or hide a QuicKeys toolbar with a Hot Key. Position your cursor in the Hot Key field 
and press the key(s) you want to use to display the selected toolbar. Click the Clear button to remove your Hot 
Key selection.

• Scope – Toolbar Scope is the range of operation for a toolbar. You can choose whether a toolbar displays only 
when a specific application is front-most, or whether it appears regardless of which application is in front.

 

Figure 3-7. Editing a toolbar; the View tab.

The View Tab
• Type – There are two basic types of toolbars, standard and docked:

▫ Standard toolbars can be moved anywhere on your desktop. With Standard toolbars, you can click on the 
title bar of the toolbar and drag it to another desktop location.

▫ A Docked toolbar attaches to the edge of the computer screen. This type of toolbar is useful when you want 
to keep your toolbar out of the way along the side of your screen. You can drag Docked toolbars from one 
side of your screen to another. Docked toolbars will spring back to the closest screen edge when you drag 
them across your screen and you release, or stop moving, your mouse.

• Always on top - Select the Always on top checkbox to ensure that QuicKeys toolbars always display on top of 
other active application windows. This option is useful because it gives you easy access to the toolbar without 
having to move windows around to get to the toolbar.

• Icon Size– Use the slider bar to specify the size of icons in your toolbar. The dimensions of your icons appear 
next to the slider.
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• Placement – Make a selection in the Placement pop-up list to customize the appearance of your toolbar 
buttons. After you make a selection from the pop-up menu, use the slider bar to specify the size of your icons.

• Resize – Select the Automatically checkbox when you want your toolbars to resize to accommodate a change 
on a toolbar.

 ❖ Note: When you drag an item onto a toolbar that has the Automatically option turned on the buttons already 
present will move except for Application buttons which can act as drag & drop launchers. You may need to 
press the Command+Option keys to force Application buttons that are already there to move out of the way so 
you can put the new button in place.

 ❖ Note: Turning off the Automatically checkbox disables the toolbarʼs ability to resize when new buttons are 
added or removed. If you have turned off the Automatically option, you can resize a toolbar by clicking on the 
lower right corner of the toolbar and dragging.

• Orientation – Choose whether you want your toolbar to display vertically or horizontally.
• Tabs – If your toolbar has multiple tabs, this setting tells QuicKeys where to put those tabs.

 

Figure 3-8. Editing a toolbar; the Tabs tab

The Tabs Tab
You can create multiple tabs for your QuicKeys toolbars using the Tabs area of the Toolbar Editing sheet. Multiple 
tabs enable you to organize the buttons and make your toolbars more compact. Click the Add Tab button to add a tab 
and provide a name for the tab in the Tab Name field.
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Figure 3-9. Example toolbar with 4 tabs

Adding Shortcuts to Toolbars
You can add Shortcuts to QuicKeys toolbars using any of the following methods:

• Drag shortcuts from the Shortcut List and drop them onto a toolbar.
• Drag application icons, files and folders to toolbars. This action will create a button on the toolbar and a new 

shortcut in the QuicKeys Editor.
 ❖ Note: You may need simultaneously hold the Command+Option keys while dragging a file onto a toolbar to 

force the icons already on the toolbar to shift and make room for the one you are adding.
 ❖ Note: Dropping a file onto an existing toolbar button that represents an application will open the file in that 

application if possible.
• Drag text onto a toolbar to create a Type Text shortcut.
• Drag a fully qualified Uniform Resource Locator (URL) onto a toolbar to create a Web Address shortcut.

Displaying Toolbars
You can display QuicKeys toolbars by selecting them from the QuicKeys Menu or from the QuicKeys Dock menu. 
You can also assign a Hot Key trigger for a toolbar in the Toolbar Editing sheet and display/hide the toolbar by 
pressing the Hot Key.

Hot Help
Hot Help is descriptive text that appears over toolbar buttons, helping you identify the purpose of each toolbar 
button. To display Hot Help text, hover your mouse over a toolbar button.

The Toolbars Window
To view a list of your toolbars, select Window -> QuicKeys Toolbars. Selecting a toolbar from this list brings that 
toolbar to the front. Double-clicking in this list puts that toolbar in edit mode.

Editing Toolbars
You can display the Toolbar Editing sheet by double-clicking a toolbar in the QuicKeys Toolbars window list, or by 
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selecting a toolbar from the list and choosing Toolbars -> Edit Toolbar.
❖ Note: You can Control+Click on a toolbar to bring up a contextual menu and select Edit Toolbar.

Closing Toolbars
Use one of the following methods to hide a toolbar:

• Click the close button on the toolbar.
• Select the toolbar from the QuicKeys Menu.
• Press the Hot Key assigned to the toolbar.

Deleting Toolbars & Toolbar Components
You can use the following methods to delete toolbars, toolbar buttons and toolbar tabs:

• Control+Click anywhere on a toolbar and select Delete Toolbar.
• With a toolbar selected and the Toolbars window front-most, select 

Toolbars -> Delete Toolbar.
• Toolbar buttons are automatically deleted when the Shortcut represented by 

that button is deleted.
• Toolbar buttons can be removed from the toolbar by Command+dragging them 

off of the toolbar.
• Control+Click anywhere on a multi-tab toolbar and select Delete Tab.
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Tutorial 4 – Decision: Send or Enter?
This tutorial introduces the Decision shortcut and uses it in a very simple multi-step shortcut, making use of Step 
Results in the process.

The Problem
“Iʼm an Instant Message addict like you wouldnʼt believe! I type something witty and hit my Enter key probably 
200 times per day. So when I get into my e-mail program (Apple Mail), I expect my Enter key to send my completed  
message but it just enters a line feed instead. Is there a way I can have QuicKeys intelligently remap my Enter key 
only when Iʼm composing a message?”

The Solution
This sort of problem requires that we find something unique in the message composition window of Appleʼs Mail 
program that QuicKeys can read and base a decision on. In this example we can use the Send button as our decision 
point. The Send button exists in the toolbar of any message that is being composed in Mail, but it does not exist in 
the main browser window; thatʼs exactly the type of user interface element needed.
Our three step shortcut will do the following when triggered by the Enter hot key:

1. Look at the front-most window and try to find a button named “Send”...
• If QuicKeys finds the Send button, proceed to step 2 of the shortcut and stop playback of the shortcut when 

step 2 has finished.
• If QuicKeys fails to find the Send button, jump to step 3 of the shortcut.

2. Send the key combination ⌘⇧D to Mail, causing it to send the message we were composing.
3. Send the key “Enter” to Mail, simply treating the Enter key as the Enter key.

How To

Part One - Create the shortcut steps:
1. Launch Appleʼs Mail application (weʼll need it later).
2. Open the QuicKeys Editor and choose QuicKeys -> Decision -> Check for Button from the Create menu. 

This creates a new Check for Button shortcut.
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Figure 3-10. Setting up the Decision:Check for Button shortcut step.

3. In the Button name field, type “Send”. Leave the pop-up set to “Is”.
4. The pop-up lists need to be set as follows:

• Exists: Yes – because thatʼs exactly what we want to know, does the button named Send exist.
• Enabled: Yes – the Send button needs to be enabled before you can actually send a message. If you havenʼt 

addressed your message yet this button is not enabled. This test isnʼt 100% necessary but itʼs a nice touch.
• Selected: Do not Care – this setting is for checkboxes, we donʼt care.
• Button Window: Main Window – When composing a message, that message window is the “Main” window 

as far as the operating system is concerned. We need to be looking for our Send button in that Main 
window.

5. Toggle the reveal triangle closed on the first shortcut step to give yourself more working space. You may want 
to drag the window larger as well since weʼll be adding two more steps.

6. Click the Add Step button and select User Actions -> Type Keystroke to create the second shortcut step.
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Figure 3-11. Configuring the Type Keystroke Shortcut steps.

7. Select the Keystroke field in the second shortcut step and press ⌘⇧D.
8. Again, click the Add Step button and select User Actions -> Type Keystroke to create the third shortcut step. 

Select the Keystroke field and press your Enter key.

Part Two – Setting the Step Results:
Shortcut steps 1 and 2 need to have their Step Results changed. Shortcut step 1 is the decision making step and 
so we need to tell it what to do when it finds or does not find the Send button. You can hover your mouse over 
the Step Results indicator buttons for each step to see hot help describing what actions will be taken when a 
step succeeds or fails.
Our stated goal was to test for the Send button and if it is present QuicKeys should proceed to shortcut step 2 
and send the message, stopping playback at that point. If the Send button is not there, QuicKeys should skip 
shortcut step 2 and process step 3 instead.

9. Click on one of the Step Results buttons at the bottom of shortcut step 1. This will open the Inspector window 
to the Step Results view for step 1.

10. In the Inspector window, change the Step Failure pop-up to “Jump to Step”. Select the Jump to specific step 
radio button and put a “3” in the numeric field. QuicKeys will now jump to step 3 rather than do the default 
action of stopping playback and notifying us if this shortcut step fails (and by failure, remember, we mean the 
Send button was not found).

11. Now click on the gray name-bar of shortcut step 2 (make sure step 2 becomes highlighted) in the Shortcut 
Editor. Set the Step Success pop-up for shortcut step 2 to Stop Shortcut. Your Step Results should look like 
those in the bottom right corner of each shortcut step shown in Figure 3-12. 
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Assign a trigger:
As stated in the planned solution at the beginning of this tutorial, our trigger is going to be the Enter key.

 

Figure 3-12. Setting the Enter key as the hot key trigger.

12. Change the Scope pop-up to Mail if it is not already set there. Mail will only show up in this list if Mail is 
currently running.

13. Click on the hot key that QuicKeys automatically assigned to change it. When the Hot Key assignment 
window appears, click and hold your mouse button with your mouse cursor in the hot key field, and press the 
Enter key on your keyboard while still holding the mouse button down. Clicking and holding the mouse button 
is necessary to assign some keys as hot key triggers; Enter and Tab are two examples of such keys.

14. Name your new shortcut and close the Shortcut Editor window.
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Test your shortcut:
Open Appleʼs Mail program and start composing a new e-mail message. Address it to yourself, give it a test subject, 
and press your Enter key. The message should send.
Now select one of the messages in your In-box. Press the Enter key again, it should be interpreted as simply an Enter 
key and thus open the message you had selected.

Alternate Solutions
The task performed in this example might not be everyoneʼs cup of tea, but it illustrates the power and flexibility 
of QuicKeys  ̓Decision shortcut when combined with Step Results. This is really just the tip of the iceberg though. 
The Decision shortcut comes in five flavors allowing it to test not only buttons but also several parameters of menu 
items, the current Date & Time, window characteristics, and the status of applications.
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Chapter 4: Triggers & Scope in Detail

A trigger is a user-specified signal that directs QuicKeys to play or activate a specific shortcut. When you create a 
shortcut you can assign one or more triggers to it. QuicKeys X3 introduces several new trigger types that vary in 
complexity; all are explained in detail in this section.

Trigger types

Application Event Trigger
Shortcuts can be triggered automatically after a specific application opens, quits, becomes front-most or leaves 
the front. You determine the application and the time delay.
Example: Letʼs say when you open Safari you want the browser window to be a specific size, so you use an 
“App Event - Safari Opens” trigger to automatically move the browser window and resize it 5 seconds after 
Safari launches.

 

Figure 4-1. Application Event trigger options

Application Event Options
• Application – Choose the application which will be used as the trigger. If the desired application is not 

running it will not show in this list and you will have to choose “Select Application” and navigate to it.
• Event – Choose the event you want QuicKeys to watch for in relation to the chosen application.

▫ Opens – Trigger when the chosen app is launched.
▫ Quits – Trigger when the chosen app quits.
▫ Becomes Front – Trigger when the chosen app becomes front-most.
▫ Ends Front – Trigger when the chosen app is no longer front-most.

• Event Delay – Delay the actual triggering of the shortcut for as long as needed to account for things like 
slow loading applications.

Day & Time Trigger
Lets you select the time and day(s) of the week when QuicKeys automatically triggers a Shortcut.
Example: At 11:55AM, Monday through Friday, QuicKeys can launch your time tracker application so you 
can clock out for lunch.

71
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Figure 4-2. Day & Time trigger options

Day & Time Options
• Days – Put a check in the box next to each day that you want this trigger to be active.
• Time – Set the time of day at which you want this trigger to activate.

Device Trigger
With this trigger type you can directly assign shortcuts to buttons on your USB mouse, trackball, joystick, 
scroll wheels, and even keys like Eject and Mute on your keyboard.
❖ Note: If you are simply wanting to assign a key or combination of keys such as F1 or Command+M as a 
shortcut trigger, skip on over to the hot key trigger information later in this chapter.

 

Figure 4-3. Device trigger options

Device Options
• Action – Choose which device action you want to use as a trigger. QuicKeys preloads this pop-up menu 

with a few common buttons and keys which will likely (but may not) fit your needs. If the device item 
you need is not on the list, choose Custom from this pop-up to open the Advanced Device Trigger window 
(described later in this topic).

• Modifiers – Adding modifier key requirements to Device triggers lets you define more triggers per device. 
For example, you might have the 3rd button on your trackball set as a trigger to launch Safari, but pressing 
Option while clicking your 3rd trackball button launches Internet Explorer instead.

• Advanced – The Advanced button opens the Advanced Device Trigger window. This window is fairly 
complex at first glance, but donʼt let that worry you since most users wonʼt need to understand but a couple 
of simple things.
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Figure 4-4. Advanced Device Trigger configuration window

    Advanced Options
▫ Device – Every USB device attached to your computer that advertises itself via HID (Human 

Interface Device) will show up in this pop-up list. Choose which device you want to use as a trigger.
▫ Any Device – This checkbox tells QuicKeys to ignore which device sent the trigger. For example, if 

you have a trackball with “Button 3” and also a jog shuttle with “Button 3” reported by HID, either of 
those devices would trigger your shortcut if Button 3 is pressed and Any Device is checked.

▫ Page & Usage – Page and Usage are HID references to parts of devices and the behaviour of those 
parts. These would be entered manually if someone knew very specific technical information about a 
HID object.

▫ Device Element – Letʼs you choose which button or control on the selected device is to be used as a 
trigger. You can end up swimming through a massive list of elements for some devices (Set Device 
to your keyboard and take a gander at the truly massive list of elements it reports...), so you may just 
want to skip past this list and click the Set Element button.

▫ Set Element – Click this button to put QuicKeys into a listening state. The next button or key or 
control you use will be captured and designated as the triggering element. For example, if you want 
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button 4 on your MegaMouse to be the trigger, just click the Set Element button then press button 4 
on your MegaMouse. QuicKeys will capture that fact and create the desired trigger.

▫ Trigger Action – When you click a mouse button or move a slider or adjust a jog shuttle, the device 
you are using sends a HID (Human Interface Device) signal that is unique to that device and to the 
control being manipulated. QuicKeys can monitor these signals and use them as triggers in three 
different ways.

• User Action – The vast majority of device triggers will be of the type User Action since this encompasses 
clicking mouse and trackball buttons and pressing keyboard and keypad keys. This is a generic “something 
happened with that button” kind of setting.

• Value Changes – Some device elements, such as scroll wheels and jog shuttles, change their value when 
they are manipulated, rather than sending simple on/off signals like a button would. These value changes 
can be used as triggers when combined with Element Value options explained later. QuicKeys is looking 
for a change in value with this selection.

• Value Check – Value Check is similar to Value Changes, but QuicKeys must actively query the device 
control to ask if the Value has changed. A trigger of this type must be combined with a repeat or timed 
trigger to get it to poll the device periodically.
❖ Note: The Value Check feature may or may not work with all devices, this is up to the device 
manufacturer.

▫ Element Value – The Element Value pop-up list and the associated field below it work together. You 
must know the possible values of the device you are working with to make use of this type of Device 
trigger. Some examples include: a trigger can be set up to fire if your scroll wheel value is greater 
than “0”, or a joystick throttle can trigger a shortcut if its value exceeds 155.

▫ Modifiers – Works as explained earlier in the Device trigger topic.

Hot Key Trigger
You can assign a keystroke or combination of keystrokes with or without modifier keys as a shortcut trigger. 
This is by far the most common trigger used with QuicKeys and can be as simple as pressing your F1 key or 
as complex as pressing a series of chained hot keys.
Example: a pair of Type Text Shortcuts to type either your home or work address can be given hot key triggers 
of ⌃H and ⌃W respectively. Pressing the Control key and the H key at the same time will trigger the Shortcut 
which types your home address.

 

Figure 4-5. Hot Key trigger options
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Hot Key Options
• Hot Key – Highlight the hot key field by clicking in it. The next keystroke or key combination you press 

will be assigned as the hot key trigger. If the key combination appears in red text, that key combination is 
already assigned to another shortcut, so you may need to consider using a different key combination.

 ❖ Note: Two or more shortcuts assigned the same hot key trigger may both fire when that key combination 
is pressed. Their simultaneous activation depends on the assigned Scope of those hot key triggers.

• Trigger when pressed/released – This pair of radio buttons let you choose between setting your hot key to 
fire when the designated key is pushed down or when it is released. Most hot keys are set to Trigger when 
pressed, only special cases would benefit from triggering upon release.

• Hot key repeats – Normally if you press and hold a key which is set as a hot key trigger in QuicKeys, it will 
only trigger that shortcut once. But if you turn on the Hot key repeats option, holding the hot key down will 
trigger the hot key as rapidly as you have your key repeat rate set in your system preferences.

• Hot key is sticky – When a hot key is set sticky, pressing that key will still trigger the shortcut unless there 
is another trigger grouped with it. If there is another hot key grouped with a sticky hot key, the two must 
be pressed in sequence to activate the shortcut. This setting is something of a legacy item for hot keys 
that were created sticky in previous versions of QuicKeys. If your goal is to create chains of keystrokes as 
triggers you can simply create and group them in the desired order rather than turn on this Sticky setting.

QuicKeys Menu Trigger
QuicKeys places a small black “Q” menu up by your clock in the top right corner of your screen. Shortcuts 
may be added to and triggered from this menu. This is a good way to trigger infrequently needed shortcuts, 
avoiding the need to remember seldom-used hot keys. If the QuicKeys Menu is not visible then either 
QuicKeys is not running or the menu preference has been shut off.

Repeat Trigger
A Repeat trigger will repeatedly activate after a set amount of time has passed. If the Repeat trigger is scoped 
to All Applications that shortcut will start firing when you close the Shortcut Editor window and the allotted 
amount of time has passed.
Example: a Repeat trigger can be used like an Auto-Save feature, telling an application to Save the current 
document every 10 minutes.

Repeat Options
• Repeat Interval – Select from Seconds, Minutes, Hours, and Days, and enter a number in the available field. 

For a repeat rate of every ten minutes, put a 10 in the field and select Minutes from the pop-up list.

Speech Trigger
If you have a headset or microphone attached to your Mac and configured properly, you can assign a unique 
phrase for any QuicKeys shortcut you make, which when spoken will activate that shortcut. The phrase you 
choose combined with the prefix specified in QuicKeys Preferences trigger pane is what you need to say to 
trigger a given speech shortcut.
Example: If you are setting a speech trigger for launching TextEdit you may want to enter a phrase something 
like “Open Text Edit”. Combine that with the prefix and your speech phrase becomes “QuicKeys, open text 
edit.”
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❖ Note: QuicKeys is not directly interpreting your spoken commands; that technology is part of Mac OS X 
and QuicKeys is simply making use of it. If you have difficulty getting shortcuts to fire reliably with speech 
triggers there is no adjustment to QuicKeys that can be made. Instead look into your microphone quality, 
sensitivity and configuration, the trigger phrases you have chosen, and the way you annunciate when speaking 
those phrases.

Speech Options
• Phrase – Enter the desired phrase to combine with any speech prefix and speak as a trigger.
• QuicKeys Preferences – The Triggers pane of QuicKeys Preferences window contains a check box to 

enable/disable speech triggers. It also contains a Speech Prefix field where you can specify a word with 
which to begin all of your speech triggers. By default that word is “QuicKeys”, so in our previous example 
you would have to say “QuicKeys, open text edit” to trigger the shortcut unless you change the prefix.

Time Range Trigger
This item is actually a qualifier rather than a stand-alone trigger, it will not directly trigger a shortcut. But if 
you group this qualifier with another trigger, you can limit that triggerʼs operation to a specified time range.
Example: Outside working hours you may want to disable a certain shortcut trigger so it will not fire when its 
hot key trigger is pressed. To do so you would create a Time Range trigger and group it with a hot key trigger.

 

Figure 4-6. Time Range trigger options

Time Range Options
• From – Starting time to make this trigger qualifier active.
• To – Ending time to make this trigger qualifier inactive.
• Week Days – Days on which this trigger qualifier is active.

Time Range Trigger Usage
There are a few basic rules to how the Time Range trigger qualifier behaves:
• If you assign both a From and a To number for any unit (a unit being defined as a minute, hour, day, month, 

etc.), triggers grouped with your Time Range qualifier will only be active between those From and To 
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values. For example, if you set the Hour as From 8AM To 5PM, a grouped hot key will not work before 
8AM or after 5PM. 

• If you leave a field blank, QuicKeys assumes “Any” value is acceptable.
• If you enter a value in a unitʼs From field but leave the To field blank, QuicKeys assumes the highest 

number possible in that field. For example, if you enter 15 in the From Minutes field and leave the To 
Minutes field blank, the grouped trigger will be active from “:15 to Any”, or from 15 minutes after until the 
end of that hour.

• If you leave both the From and the To fields of a particular unit blank, that unit is ignored. For example, 
if you leave both the From Day and To Day fields blank, the day of the month is ignored when QuicKeys 
checks to see if the grouped trigger should be active.

• If you uncheck any of the Week Days, the grouped trigger will never be active on those unchecked days of 
the week.

Time Range examples

 

Figure 4-7. Example 1: Trigger is active only from 
4PM to 5PM on the first day of the month.

 

Figure 4-8. Example 2: Trigger is active after 8:15AM daily.



78

Chapter 4 - Triggers & Scope

 

Figure 4-9. Example 3: Trigger is active before 5:00PM MWF.

Trigger Requirements
• To trigger shortcuts, the QuicKeys application must be running but the QuicKeys Editor window does not 

need to be open.
• You cannot trigger a shortcuts when that shortcutʼs is open. This prevents inadvertently triggering a shortcut 

while you are editing it.
• You cannot trigger any shortcuts when the Hot Key assignment window is open in the Shortcut Editor or main 

QuicKeys Editor window.

 

Figure 4-10. Triggers are disabled while the 
Hot Key assignment window is open.

Trigger Grouping
QuicKeys can be told to group a number of triggers in the same scope. Grouping triggers means that both conditions 
must become true for the shortcut to fire. To group a trigger with the one above it, simply click the blue button with 
the plus sign in it. When triggers are grouped this button changes to a minus sign which you can click to ungroup 
that trigger from the one above it. Grouped triggers are easily identified by the surrounding light gray frame.
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Figure 4-11. Group with preceding trigger button

Why Group Triggers?
There are essentially two reasons you would want to group triggers:

Chaining hot keys
If you group two or more hot key triggers, QuicKeys will treat them as “sticky” and expect to see them 
pressed in order to trigger their shortcut. For example, if you group a hot key trigger of F5 and another hot key 
trigger of F6 youʼll need to press F5 then press F6 within the next couple of seconds to trigger the shortcut. 
More than two hot key triggers can be chained together with grouping.
Grouping hot keys opens up an endless supply of intuitive chains of key presses you can use to trigger your 
shortcuts. For example, all of your application launching shortcuts could be triggered by chained hot keys. 
Each chain might begin with Control+A (for application) followed by a couple of letters relating to the 
application name, such as X and L for Microsoft Excel.

 

Figure 4-12. Grouped or chained hot key triggers

Adding a Time Range qualifier to a trigger
Any trigger can be grouped with one or more Time Range qualifiers to restrict the times when that shortcut can 
be activated. A single Time Range qualifier can restrict a shortcut to firing only between 8:00AM and 5:00PM 
for example. If you want to also restrict it to firing only between Noon and 4:00PM on Saturday, just group a 
second Time Range qualifier.
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Figure 4-13. Grouped Time Range qualifiers restrict the app event trigger.

When Not to Group Triggers
Grouping triggers is a powerful tool, but if used improperly it will make your shortcut unable to be triggered. When 
grouped, the triggers are connected with a “logical AND” which means that both of the triggers must be ON or 
TRUE at exactly the same time for the shortcut to run. For example, if you tried to group a hot key trigger with 
a Date & Time trigger set to go off at 4:37PM, will you be able to press that hot key at exactly 4:37PM? In the 
computer world of milliseconds it is very unlikely.

 

Figure 4-14. Two triggers that donʼt group well together.
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Scope Details
As discussed previously in Chapter 2, Scope is the range of operation for a trigger or triggers assigned to a particular 
shortcut. If you have not read the Scope and The Scopes List sections in Chapter 2 it would be a good idea to do so 
before continuing with this section.

Creating & Assigning Scopes
Most shortcuts will have only one scope assigned, but you can add more as needed by clicking on the Add Scope 
button. You may need to drag the sizing bar in the shortcut editing window downward to give yourself more working 
space in the Scopes & Triggers area. Once youʼve added a new scope region, select the desired scope from the Scope 
pop-up list. Triggers are added to each scope separately.

 

Figure 4-15. Adding and setting a new Scope

Scope Precedence
Scopes fall into three categories: application-specific scopes, the All Applications scope, and the Excluded (from All 
Applications) Applications list. In general, application-scoped shortcuts can only be triggered if that application is 
front-most, while shortcuts scoped to All Applications can be triggered no matter what application is in front.
For hot key triggers these scope types interact in interesting ways and use the following hierarchy or precedence of 
operation:

1. Application-specific scopes – A shortcut scoped to a specific application is eligible to be triggered when that 
application is front-most. When this application is front-most, any hot key triggers in this scope will take 
precedence over the same hot key if it is used in another scope.

2. Excluded Applications – Shortcuts scoped to All Applications will never activate when an application that has 
been “Excluded” is in front (but that excluded application can still have its own shortcuts and triggers scoped 
to it!).

3. All Applications scope – Hot keys for shortcuts scoped to All Applications will be active as long as a the front-
most application is not Excluded and does not have the same hot key assigned to a shortcut of its own.
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Exclude Applications
You can easily add an application to the Excluded list by selecting Excluded Applications from QuicKeys  ̓Window 
menu and choosing the desired application from the pop-up list in the resulting window. Only running applications 
are listed so you will need to choose Select Application from the pop-up and navigate to the desired application if it 
is not running. To remove an application from this list, simply click on the application name and press your delete 
key, or right-click on it and choose Remove from the contextual menu.

 

Figure 4-16. Excluded Applications window

Reassigning Scopes
You can reassign the scope of a shortcut trigger when you have the Shortcut Editor window open, but this can 
become tedious if you have a number of shortcuts needing their scope reassigned. For example, if you upgrade from 
Dreamweaver MX to Dreamweaver 2004, you will want to reassign all of your Dreamweaver MX shortcuts to the 
new application.
Rather than change each shortcut individually in the Shortcut Editor, open the main QuicKeys Editor window, select 
the desired scope from the Scopes list, and select Reassign Scope from QuicKeys  ̓File menu, or right-click on the 
scope in the Scopes list and choose Reassign Scope from the contextual menu that pops up. This will cause the 
Reassign Scope sheet to appear where you should verify the Current Scope then select the application youʼd like for 
the new Scope.
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Figure 4-17. The Reassign Scope sheet

Duplicating Scopes
Like reassigning scopes, duplicating them can also be done one shortcut at a time while in the Shortcut Editor, but in 
some cases it makes more sense to duplicate the entire scope at once. From the QuicKeys Editor you can click on a 
scope in the Scopes list and select File -> Duplicate Scope to assign an additional scope to an entire set of shortcuts. 
For example, if you use more than one version of 4D for compatibility reasons, you may want to duplicate the scope 
so your shortcuts for one version of 4D also work in the other version.

Deleting Scopes
Deleting a scope will remove that scope from all shortcuts. This can be useful if you retire an application and want 
to clean up your shortcut scopes. Shortcuts that are left without any scopes assigned can be easily located in the 
shortcuts list by clicking on the Unscoped Shortcuts scope.
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Subscopes
Subscopes are going to throw a rather large wrench into the gears of unprepared minds. Scopes are rather straight 
forward, but subscopes become a bit confusing because they add another layer of complexity to the idea. Theyʼre 
really not as bad as they look at first glance though. Essentially, subscopes allow you to have multiple sets of 
shortcut triggers for each application.

 

Figure 4-18. The Subscope pop-up list

A good example for using subscopes is interaction with FileMakerʼs different modes of operation. The activities you 
might want to do within FileMaker vary widely depending on if FileMaker is in Layout, Browse, or Find mode. If 
you build a large number of shortcuts for each of those modes, it could be beneficial to break your FileMaker scope 
into three subscopes specific to the tasks you will be doing in each of the three modes.
Another example might be setting up a Subscope for use within Appleʼs Mail application. When you are composing 
e-mail messages you might want a different set of shortcuts to be active from when you are filing messages.

Creating Subscopes
Subscopes can only be created from within a Shortcut Editor window. If you wanted to create a subscope in Mail, 
for example, youʼd need to open a shortcut scoped to the Mail application. In the shortcut s̓ Scopes & Triggers area, 
to the right of the Mail scope is the Subscope pop-up list.

 

Figure 4-19. Creating a new Subscope in the Mail scope

Clicking on the Subscope pop-up list will reveal all of the subscopes available in the parent scope, Mail. You 
can instantly create a new subscope by selecting Other Subscope from the list and typing in the name of the new 
subscope you want created.
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Figure 4-20. Naming the new subscope of Mail

Subscope Interaction
Subscopes obey these simple rules:

• If you subscope a shortcut, it will only trigger when that subscope is active.
• The “All parts of <application>” subscope is universal when that application is front-most. In other words, all 

shortcuts with a subscope set to “All parts of <application>” will be active if that application is in the front.
• You can change the subscope that is active using a Switch Subscope type of QuicKeys Action shortcut. This 

type of shortcut is explained on page 115 in Chapter 7.

Subscope Usage
To make use of Subscopes, you not only need to create the subscopes for your shortcuts to use, you also need to 
create at least one QuicKeys Action shortcut of type Switch Subscope. It does you no good to create subscopes if 
you cannot switch between those subscopes as you work.

 

Figure 4-21. A shortcut step for switching subscopes in the front 
application; covered in more detail in Chapter 7

Going back to the FileMaker example, letʼs say you have 20 shortcuts scoped to that application and you have two 
subscopes defined, Browse and Layout. Five of your shortcuts are specific to the Browse mode so you subscope 
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them to Browse, and another five are specific to Layout mode so you subscope those five to Layout. The remaining 
ten shortcuts are more universal and so you leave their subscope set to All Parts of FileMaker.
When you switch to Layout mode in FileMaker, QuicKeys needs to have its subscope switched to Layout as well so 
that the five Layout-specific shortcuts are available to use along with the ten set to work in “all parts” of FileMaker. 
But, QuicKeys doesnʼt know you just switched to Layout mode in FileMaker unless you tell it. The built-in hot key 
to switch FileMaker into Layout mode is ⌘+L, so you should create a simple two-step shortcut to kill two birds 
with one stone.
The shortcut would be triggered when you press ⌘+L, overriding FileMakerʼs own hot key of the same 
combination. The first step would be a QuicKeys Action step set up to switch to the Layout subscope within the 
FileMaker scope. The second step would be a Type Keystroke shortcut that sends ⌘+L on to FileMaker, telling 
it to switch to Layout mode. Now youʼre up and running with 15 shortcuts working in the FileMaker scope, 10 
universal and five specific to Layout work. To complete this subscope setup youʼd want to make a similar shortcut 
for switching to Browse mode as well. 

Deleting Subscopes
When editing a shortcut you can remove that shortcut from a subscope but you cannot directly delete the entire 
subscopek but subscopes are automatically removed if you remove all shortcuts from that subscope. Switching to the 
main QuicKeys Editor window gives you access to the Scopes list and under each scope you can find any defined 
subscopes. Select the desired subscope and right-click or control-click on a subscope to access a Delete Scope menu 
item.

 

Figure 4-22. Deleting a subscope from 
the QuicKeys Editor window

❖ Note: Deleting an entire Scope or Subscope cannot be undone. QuicKeys will not destroy the shortcuts 
themselves (even if youʼve deleted all of a shortcutʼs scopes), but an inadvertent deletion of a scope and all of the 
triggers therein could create a lot of extra work and headaches setting things right again.
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Tutorial 5 – Remap Your Scroll Wheel
This tutorial uses Photoshop as its target, but even if you donʼt have that application the Device trigger concepts 
should be of interest.

The Problem
“Word uses Control+Scroll Wheel to zoom in and out of documents, while Photoshop uses Option+Scroll Wheel. I 
want both applications to behave in the same manner, that being Control+Scroll Wheel to zoom. How can QuicKeys 
help with this?”

The Solution
The solution to this problem is to construct a pair of Scroll Wheel shortcuts scoped to Photoshop, one for zooming in 
and one for zooming out. In each shortcut weʼll use a Device trigger which will activate when the user to spins their 
scroll wheel while pressing their Control key, and weʼll translate that into an Option+Scroll Wheel event.

How To

Part One - Create the Zoom Out shortcut:
1. Launch Photoshop (weʼll need it later).
2. Open the QuicKeys Editor and choose User Actions -> Scroll Wheel from the Create menu. This creates a 

new Scroll Wheel shortcut.
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Figure 4-23. Settings for the Zoom Out scroll wheel shortcut.

3. Weʼll make this one the Zoom Out shortcut, so set the Scroll Direction radio button to Up/Left.
4. Since Photoshop is looking for Option+Scroll Wheel to initiate zooming in, we need to check the Option 

modifier checkbox. Leave the Scroll Speed slider at Very Slow.
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Part Two – Configure the Device Trigger:
Now for the meat of this tutorial, the Device trigger. The interface for setting up Device triggers is pretty 
simple unless youʼre going to do something like trigger off of Control+Scroll Wheel... which we are. Weʼll 
be working with the Advanced Device trigger interface, but itʼs look is truly more daunting than the task will 
prove to be.

Figure 4-24. Advanced Device Trigger setup window.

5. First we need to scope this shortcut to Adobe Photoshop. Choose Photoshop from the Scope pop-up list.
6. Next we need to change the Trigger Type to Device. As soon as you select Device from the Trigger Type 

pop-up list, the Device trigger editor window will appear. 
7. From the Device trigger editor window you could select a trigger from a list of more common Device 

triggers such as mouse buttons, but we wonʼt need that list. Instead, click the Advanced button to open the 
Advanced Trigger Device window.



90

Chapter 4 - Triggers & Scope

 

Figure 4-25. Advanced Device Trigger setup window.

8. Set the Device pop-up to whichever device has a scroll wheel.
9. Set the Device Element pop-up to Wheel.

10. Leave Trigger Action set to User Action, but change the Element Value pop-up to Greater Than and the 
Element Value field to zero. How do we know to do this? Some guesswork and some logic; the Element 
Value Min and Max values appear to be -127 to +127 so zero is in the middle and that is very likely the 
value of the scroll wheel when it is at rest. Weʼre making the assumption that if we scroll up, the Element 
Value is going to go above zero and our trigger will fire because we are looking for a value “Greater Than 
0” according to the choices weʼve made in this window.

11. Check the Control modifier checkbox since we want our trigger to fire when we hold the Control Key and 
use our scroll wheel.

12. Click OK to close the Advanced Device Trigger window, save this shortcut and name it something like 
“Zoom Out with Scroll Wheel”, then close the Shortcut Editor window.
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Figure 4-26. The finished scroll wheel Device trigger.

Test your shortcut:
Launch or switch to Photoshop and open a document or a create a new one. Hold your Control key and roll 
your scroll wheel both up and down. It works! Okay, it half works, we can scroll out but we canʼt scroll in.
To remedy this, go to the main QuicKeys Editor window, locate your Zoom Out shortcut, select it, and press 
⌘C and ⌘V to copy and paste the shortcut, duplicating it. Now open and edit that new shortcut, changing 
the shortcut step so that it sends Down/Left rather than Up/Right. Edit the Device trigger so that the Element 
Value pop-up is set to Less Than. Save the shortcut and rename it to Zoom In; now both zooming in and out 
should work.

Conclusion
Device triggers can give some amazing control if you stop to think of the possibilities. Joysticks, game pads, 
30-button trackballs and mice, keypads... all of these items can act as triggers for QuicKeys. With active polling, 
QuicKeys can even ask passive devices what specific Element Values are and act when they change or reach a 
certain value.
There is one very large caveat to all of this amazing Device trigger power though, and that is driver software. Most 
manufacturers of mice, trackballs, and other input devices also provide configuration or driver software for their 
products so you can configure the device. These drivers will, in many cases, interfere with QuicKeys ability to see 
the fact that a button was clicked or a slider moved or a hat-switch flipped.
Removing/Uninstalling drivers or configuration software will fix things up, but then youʼre left without specialized 
configuration options that may be necessary for the device but QuicKeys cannot match. A large portion of the 
functionality brought by configuration software can be mimicked by QuicKeys but not all of it, so you will have to 
evaluate both options.
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Chapter 5 - File & Folder Tools

With nearly every task we perform on our computers, we face the necessity of navigating to numerous folders 
multiple times. If you keep a tally of the number of times you have to navigate to a different folder when opening 
or saving documents, launching applications, and copying or moving files, you would be surprised by just how 
much time you spend doing this time-consuming but unavoidable activity. QuicKeys can significantly increase your 
efficiency in this area with the Change Folder, Manage Files, and Open Items shortcuts.

Change Folder
Create -> Files -> Change Folder
The Change Folder shortcut enables you to switch to a previously specified folder in any standard Open or Save 
dialog, or in the Finder. This lets you jump to frequently-used folders with the touch of a key rather than clicking 
around the provided hierarchical view supplied by the operating system. This shortcut behaves differently depending 
on the context under which it is triggered: 

• Open/Save dialog – Changes open/save location to the folder specified in the Change Folder shortcut.
• Finder Window – Changes the front-most Finder window to the folder specified in the shortcut, or may open 

the designated folder in a new window depending on Finder preference settings.
• In the Finder – If no windows are open, creates a new window opened to the specified folder.

 

Figure 5-1. The Change Folder Shortcut options

Change Folder Options
To create a Change Folder shortcut, click the Select... button and navigate to the folder you want to use in your 
shortcut. Select the desired folder and click the Choose button.
You can also drag files or folders over the icon well shown in figure 5-1 to assign the desired folder for this shortcut.
❖ Note: The path of the folder you selected will appear as “Hot Help” if you hold your mouse pointer over the icon 
well.
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Manage Files
Create -> Files -> Manage Files
The Manage Files shortcut will copy or move files from one location to another for you. For example, you can use 
this shortcut to move files from one folder to another on your hard drive, to a USB or Firewire drive, or to a network 
drive. Triggered by a hot key when desired, or by a timer on a schedule, it can act as a quick and dirty file backup 
system.

 

Figure 5-2. The Manage Files Shortcut options

Manage Files Options

Action pop-up list
• Copy – Copies the specified Target Item to the specified Destination Folder.
• Move – Moves the specified Target Item to the specified Destination Folder.
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Target Item
This is the item to be moved or copied. You can specify this target item, or make a more open-ended shortcut 
which copies/moves any item(s) you currently have selected in the Finder.
If you choose Specified, click the Select button and navigate to the item you want to copy or move. Click 
Choose after you select the item.
You can also drag files or folders over the icon wells shown in figure 5-2 to assign the Target Item or 
Destination Folder.
❖ Note: The path of the file or folder you selected will appear as “Hot Help” if you hold your mouse pointer 
over the icon well.

Destination Folder
This is the location to which the selected/specified item(s) will be moved. Click the Select button and navigate 
to the destination folder of choice. Select the desired folder and click Choose.

Replace existing files
If you check this box, files that you move or copy will overwrite any files of the same name in the destination 
folder. Use with care!
Since it is not possible to navigate to the Trash folder, Trash is presented as a Destination Folder option.
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Open Items
Create -> Files -> Open Items
The Open Items shortcut will open any file, folder, or application you specify. For example, you can create an Open 
Items shortcut for each of your most frequently used applications, putting them at your fingertips in a flash.

 

Figure 5-3. The Open Items shortcut options

Open Items Options
To create an Open Items shortcut, click the Select... button and navigate to the file, folder, or application you want to 
use in your shortcut. Select the desired item and click the Choose button.
You can also drag files or folders over the icon well shown in figure 5-3 to assign the desired file, folder, or 
application for this shortcut.
❖ Note: The path of the folder you selected will appear as “Hot Help” if you hold your mouse pointer over the icon 
well.

Other Ways to Create Open Items Shortcuts
• Drag-and-drop a file, folder, or application onto the shortcut list in the main QuicKeys Editor window.
• Drag-and-drop a file, folder, or application onto a QuicKeys toolbar.



Chapter 6: Internet & Network Tools

The shortcuts discussed in this chapter require an Internet connection or access to another networked computer to be 
of any use. For those with such connections, there are several tasks QuicKeys can help you with. These tasks include 
preparing e-mail messages, opening specific web pages, and mounting server volumes or shared hard drives.

E-mail
Create -> Internet -> E-mail
The E-mail shortcut letʼs you predefine the address, subject, and body of an e-mail message for instant creation in 
your default e-mail application. Use it to create templates for frequent messages you write. Use it as a fast way to 
start a new message addressed to your most common recipients. It will even launch your e-mail application if it isnʼt 
running.

Figure 6-1. The E-mail Shortcut options

E-mail Options
To create an E-mail shortcut, just fill in the To, Subject, and Body fields as you would when creating a message in 
your e-mail application.
❖ Note: You can put multiple addresses separated by commas in the To field.
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Web Address
Create -> Internet -> Web Address
While all web browsers store bookmarks for you, you still have to launch your browser, open the bookmarks, find 
what you want, and click on it to get where you want to go. QuicKeys cuts to the chase, launching your browser if it 
isnʼt running, and sending it straight to the web address you specified in your shortcut.

Figure 6-2. The Web Address Shortcut options

Web Address Options

Action pop-up list
• Open URL – Sends the specified web address to your web browser.
• Open selected text as URL – Sends any selected text to your browser as if that text were a URL.

▫ Make applications share selection – Selecting this checkbox will force unruly browsers to recognize 
clipboard text as a URL.

❖ Note: The Web address field does not necessarily have to contain an HTTP address. FTP and SSH are 
examples of other types of URLs that will work in this field. In the cases of FTP and SSH, your default FTP 
application and the Terminal, respectively, would be launched/targeted rather than your web browser.
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Servers
Create -> Network -> Servers
The Servers shortcut is a major time saver for anyone needing to frequently mount network volumes. QuicKeys 
stores the particulars of the desired server volume and your login information, allowing you to connect and gain 
access to your data almost instantly. As part of a morning startup routine, or the first step in a build-your-own backup 
routine, the Servers shortcut is indispensable.

Figure 6-3. The Server Shortcut, AppleShare (IP) options

Server Options

Server Type
Choose whether the server uses the AppleShare (IP) or the AppleShare (AppleTalk) file sharing method.

Zone
The AppleTalk Zone of the server you want to access. This option is available when you select AppleShare 
(AppleTalk) from the Server Type pop-up list.

Server
The AppleTalk server name you want to access goes here. (This field is only available if you choose 
AppleShare – AppleTalk from the Server Type list.)
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Address
The IP address (192.168.1.100) or DNS entry (server.company.com) of the server you want to access. This 
option is available when you select AppleShare (IP) from the Server Type pop-up list.

Volume
The Volume (hard drive or partition) name you want to access on the server.

User Name
Enter a user name which has access to the server. Leave blank to log in as guest.

Password
Enter the password that goes with your user name on the server. Leave blank to log in as guest.

Figure 6-4. The Server Shortcut, AppleShare (AppleTalk) options



Chapter 7: QuicKeys Tools

Most of QuicKeys  ̓functionality revolves around controlling other applications, but the shortcuts discussed in this 
chapter allow you to control QuicKeys itself. Some are fairly simple to use, such as Message and Open QuicKeys 
Editor, while Decision, Wait, and Repeat Loop are more advanced shortcuts often utilized in multi-step shortcuts.

Decision
Create -> QuicKeys -> Decision -> ...
The Decision shortcut lets you incorporate logical tests into your multi-step shortcuts; it is one of the most powerful 
and thus complex features in QuicKeys X3. Decision can test for a wide variety of conditions and determine if that 
test has passed or failed. Once the results of the test are known, Step Results are then used to control what action 
occurs next, allowing QuicKeys to react to the current state of your computer.
For example, you might want to know if a particular program is running, if the Clipboard contains a specific type 
of data, or if the current time is after 4:30PM. The Decision shortcut can test for these parameters and more. The 
true/false result of each test is then used to control the flow of a multi-step shortcut through Step Results found at the 
bottom of every shortcut window.
Below, Figure 7-1 diagrams the flow of a simple multi-step shortcut containing a Decision shortcut. This example 
assumes there are several windows open in an application, and looks for a specific window before typing the date 
and time:

1. Cycle the next window to the front.
2. Check the name of the window. If the window name is “Report”, proceed to the next step, otherwise go back 

to step 1.
3. Type the date and time in the window named “Report”.
4. Enter the keystroke “Tab” and the shortcut ends, ready for user input.

Figure 7-1. Decision Step Results flow
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This simple branching ability can turn a useful multi-step shortcut into a much more powerful automation action. 
The need to baby sit your computer while QuicKeys works is drastically reduced by this sort of decision making 
capability.
❖ Note: Step Results allow you to control the flow of a multi-step shortcut depending on whether or not a step 
succeeds or fails. QuicKeys  ̓response to a stepʼs failure or success is user-determined and the options consist of: 
Continue to next step, Jump to specific step, Jump ahead or back a number of steps, and Stop the shortcut. Step 
Results usage is covered in detail on page 34 of Chapter 2.

Decision Types
The Decision shortcut comes in six flavors: Check for Application, Button, Date & Time, Menu, and Window.

Check for Application
Tests whether or not a specific application is running, not running, front-most, not front-most, hidden, or not 
hidden.
Check for Button
Tests to see if a specific button exists or does not exist, is enabled or is not enabled, is selected (checked) or is 
not selected, and what type of window it is in.
Check for Date & Time
Checks the current date and time to see if it is before or after the date and time you specify.
Check for Menu
Tests to see if a specific menu or menu item exists or does not exist, is enabled or is not enabled, is checked or 
is not checked.
Check for Window
Tests to see if a specific window of a specific type exists or does not exist, is front-most, or is not front-most.

❖ Note: When you look at the contents of the Create -> Decision submenu youʼll note that five types of Decision 
shortcuts are listed. But when you look at the Check for pop-up list while editing a Decision shortcut, youʼll see only 
four. The missing item is the “Check for Menu” option. Check for Menu is very closely tied to the Menu Selection 
shortcut type, and as such there are engineering reasons why it will not work well to make it an option in the Check 
for pop-up.
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Check for Application - Options

 

Figure 7-2. Decision – Check for Application options

Application: pop-up list
Choose from the list of running applications, or choose “Select Application...” and navigate to the desired 
application.

State: pop-up list
• Is Running – QuicKeys looks for the specified application. If that application is running, the Step Result is 

“Success”. If it is not running, the Step Result is “Failure”.
• Is Not Running – QuicKeys looks for the specified application. If that application is not running, the Step 

Result is “success”. If it is running, the Step Result is “Failure”.
• Is Front Most – If the specified application is in front, the Step Result is “Success”, else the Step Result is 

“Failure”.
• Is Not Front Most – If the specified application is not in front, the Step Result is “Success”, else the Step 

Result is “Failure”.
• Is Hidden – If the specified Application is hidden, the Step Result is “Success”, if it is not hidden, the Step 

Result is “Failure”.
• Is Not Hidden – If the specified Application is not hidden, the Step Result is “Success”, if it is hidden, the 

Step Result is “Failure”.



104

Chapter 7 - QuicKeys Tools

Check for Button - Options

Figure 7-3. Decision – Check for Button options

Button Name: pop-up list
QuicKeys looks for a button whose name is, contains, starts with, or ends with the text you enter.

Ignore Case
If you check this box, QuicKeys will ignore upper/lower case differences when trying to locate your button.

Which button if multiple matches:
If more than one button that matches your naming criteria exists, QuicKeys needs to be told which of those 
buttons it should be looking at.

Button Window: pop-up list
When looking for the desired button, QuicKeys can be instructed to find it in a particular type of window such 
as, palette, document, sheet, or drawer. Only the front window can be tested.

Exists: pop-up list
QuicKeys needs to be told what attribute of that button should be tested. Primarily you will want QuicKeys to 
test whether or not the specified button Exists.
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Enabled: pop-up list
QuicKeys can test to see if a button is enabled or disabled (grayed out), or you may not care which state it is 
in.

Selected: pop-up list
Check boxes and radio buttons are testable too! This pop-up list lets QuicKeys check to see whether or not a 
particular radio button or check box is checked.

Check for Date & Time - Options

Figure 7-4. Decision – Check for Date & Time options

Date field
Enter the Date to which you would like QuicKeys to compare the current date.

Time field
Enter the Time to which you would like QuicKeys to compare the current time.

Only check time
Check this box if you are not concerned with the date and want QuicKeys to only test for the current time.
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Before date & time / After date & time
These radio buttons tell QuicKeys to test to see if the current date & time is before or after the date & time you 
entered. For example, if you want a multi-step shortcut to react differently before 5:00PM than after 5:00PM 
every day, you can set the Time field to 5:00PM and select the “After date & time” radio button. When the 
shortcut runs, if it is after 5:00PM the Decision step will report back “Success” as its Step Result. If it is before 
5:00PM, the Step Result will be “Failure”.

Check for Menu - Options
❖ Note: The Decision shortcutʼs Menu Action pop-up list, for engineering reasons, contains options other than 
“Check for Menu”. If you select one of these other options, you are no longer in the realm of the Decision shortcut, 
so those options are not explained here. Look for an explanation of the Select Menu option on page 173 and details 
on the Wait for Menu option on page 131.

Figure 7-5. Decision – Check for Menu options

Menu and Menu Item fields
Enter the name of the menu and menu item you want QuicKeys to test against. You can hand type these names 
or you can use the Choose Menu button to automatically fill in that information. Details buttons allow you to 
further refine the target menu details.
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❖ Note: The upper half of this shortcut window behaves exactly like the Menu Selection shortcut type, please 
refer to the in-depth instructions on page 173 for more details on designating a menu item.

Exists: pop-up list
Have QuicKeys check to see if the specified menu item Exists or does not Exist. If you select “Yes” then the 
Step Result for this shortcut step will be “Success” if that menu item is found.

Enabled: pop-up list
Menu items that are Enabled or active show up in black text, those that are Disabled or inactive use gray text. 
QuicKeys can test for this and the shortcut Step Result will return as “Success” if you set Enabled to “Yes” 
and that menu item is found to be active.

Checked: pop-up list
A menu item will sometimes have a check mark beside it indicating that whatever part of the application it 
controls is turned on. QuicKeys can test a menu item for the presence of a check mark. If you set this pop-up 
to “Yes” QuicKeys will return “Success” as the Step Result if the target menu item is indeed checked.

Show menus while performing menu action
Some applications do not build their menus until you click on them with your mouse, and they cease to 
exist once they close. This means QuicKeys will have to actually open the desired menu to get it to draw 
its contents and make them accessible. Also, it is often impossible to test a menu item to see if it exists, is 
checked, or is enabled unless its menu is opened. For this reason, this option will have to be checked for 
almost every Wait for Menu and Check for Menu shortcut you build.

Perform as alternate menu action (option key)
The names of some menu items change if you open the menu and hold down your option key (open Safari s̓ 
File menu and depress the option key, you should see Close Window change to Close all Windows). With 
this option checked, QuicKeys simulates pressing the option key while checking for the desired menu item s̓ 
presence.
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Check for Window - Usage
Use this test to examine the state of a window and make a decision based on the step results. Typically youʼll want 
QuicKeys to be checking for the existence of a specific window name, but specifying the window type (such as 
document window or a palette) may be desired or necessary at times.
Starting off with a couple of examples is probably the best way to describe this type of Decision shortcut:

Example 1: Assume you want to see if a document whose name contains “Report” is the front-most window 
on your screen. Youʼd set the pop-up lists as follows:

Window Name : Contains : “Report”
Window Type : Document Window
Window Level : Front Most
Window State : Exists

If all of these conditions are met, QuicKeys will return “Success” as the Step Result, if not, QuicKeys will 
return “Failure” instead.

Example 2: Letʼs say you want to know whether or not the text Color selector window is open in TextEdit. 
Youʼd set the pop-up lists as follows:

Window Name : Is : “Color”
Window Type : Palette Window
Window Level : Any Level
Window State : Exists

If all of these conditions are met, QuicKeys will return “Success” as the Step Result, if not, QuicKeys will 
return “Failure” instead.
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Check for Window - Options

 

Figure 7-6. Decision – Check for Window options

Identify the Window
Window Name: pop-up list
Choose from Is, Contains, Starts with, and Ends with, and enter the name of the Window for which you are 
testing.
Window Type:
In cases where you may have more than one window with the same name (a document named Font and a 
palette with the same name for example), QuicKeys can differentiate by window type. Choose from eight 
different window types if you need to be specific, or leave it set to Any Type of Window if the type does not 
matter.
Window Is:

• Main Window – The main window is essentially the most important window on your screen at any 
given time. This is often a document or list window. By testing for the Main window you can often 
avoid needing to specify the window name.

• Focused Window – The focused window is the often where your text insertion point is, or possibly 
where you have selected a control or object. This is often but not necessarily a document window; it 
could also be a palette or toolbar for example.
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• Frontmost/Any Level - The level at which the desired window currently resides can also be specified 
for testing by QuicKeys. Your choices are Front-most and Any Level. If you simply want to know if 
the window is open, use Any Level. But if, for example, you need QuicKeys to perform operations 
inside the front window, youʼd want to specify Frontmost. In this case if the window is open and in 
front, the Step Result is “Success”, but if the window is open and not in the front, the Step Result 
 is “Failure”.

Test the Window state
Window State:

• Exists – QuicKeys tries to find the window you specified with the first three pop-ups. If that window 
exists, the Step Result is “Success”, and if that window does not exist, it is “Failure”.

• Does Not Exist (closes) – If the specified window does not exist, the shortcut Step Result is 
“Success”, and if that window does exist, it is “Failure”.
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Insert Shortcut
Create -> QuicKeys -> Insert Shortcut
Insert shortcut allows you to insert existing shortcuts inside your multi-step shortcuts. This is useful for recycling 
shortcuts youʼve made, saving you the time of having to recreate them when you need them again as part of a larger 
multi-step shortcut.

Insert Shortcut Usage
Imagine you have three shortcuts (A, B, and C) that you run every night, each consisting of 3-5 steps. At some point 
you decide to put them all into one big multi-step shortcut. Rather than copying and pasting all of the steps from 
each shortcut into the larger shortcut of twelve steps, You can create a new shortcut which consists of three Insert 
shortcut steps, each triggering your original shortcuts A, B, and C.
❖ Note: The added modularity of Insert shortcut imparts new power to Step Results, allowing you to build a very 
simple framework inside a multi-step shortcut that calls out to other shortcuts as determined by the Decision s̓ step 
results.

Figure 7-7. Insert Shortcut options

Insert Shortcut Options
To set up an Insert shortcut, drag a shortcut from the main list in the QuicKeys Editor onto the drop-well in the 
Insert shortcut window. You can also specify how many times you want the shortcut repeated in the Play x time(s) 
box.
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Message
Create -> QuicKeys -> Message
Use the Message shortcut to create a custom text dialog, play a sound, speak text, or do a combination of all three. 
Useful as a stand-alone reminder, or set it up to activate at a designated point in a multi-step shortcut.

Message Options
In the text entry box, type the message text you want displayed in the QuicKeys Message window or spoken by your 
computer.

• Display message in window – Click this checkbox when you want the provided message text to appear in the 
QuicKeys Message window.
▫ Display cancel button – Click this checkbox when you want a Cancel button to appear in the QuicKeys 

Message dialog. Clicking on the cancel button during playback of a multi-step shortcut will cause that 
shortcut to fail.

▫ Continue automatically after x seconds – Specify how long you want QuicKeys to wait after displaying the 
QuicKeys Message window, before closing the window and continuing on to the next step if one exists.

• Speak message – Click this checkbox to direct your computer to speak the text you provided.
• Message Sound – Check the Play Sound box and pick a sound from the list box if you want a system sound 

instead of, or to accompany the message when it is triggered.

 

Figure 7-8. Message Shortcut options
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Pause
Create -> QuicKeys -> Pause
Use the Pause shortcut to pause a multi-step shortcut for a user-specified amount of time. Pauses are especially 
helpful when multi-step shortcut playback needs to be slowed down so the operating system can make necessary 
items available.

 

Figure 7-9. Pause Shortcut options

Pause Options
When you create a Pause shortcut, you must specify how many seconds you want QuicKeys to pause.
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QuicKeys Actions
Create -> QuicKeys -> QuicKeys Actions
You can use the QuicKeys Actions shortcut to control parts of QuicKeys itself. These shortcuts perform a variety of 
tasks such as opening the QuicKeys Editor; pausing or continuing the playback of a shortcut; and showing/hiding 
QuicKeys toolbars.

 

Figure 7-10. QuicKeys Actions Shortcut

QuicKeys Action Options
• Open QuicKeys Editor – Opens the QuicKeys Editor window.
• Pause Playback/Continue Playback – Pauses and continues playback of shortcuts/multi-step shortcuts. 

This same effect can be accomplished by clicking on the playback palette which can be turned on and off in 
QuicKeys preferences.

• Show Toolbars/Hide Toolbars/Toggle Toolbars – Controls any QuicKeys toolbars you have created by 
showing or hiding them. Use the Toggle Toolbars option to alternately show and hide multiple toolbars with 
the same trigger. Show All Toolbars will only reveal toolbars that are scoped to the application which is front-
most.

• Start/Stop/Toggle/Cancel Recording – Use Start Recording to start QuicKeys recording your actions, Stop 
Recording will finish and create the newly recorded shortcut. Cancel Recording will not only stop recording, it 
will prevent a new shortcut from being created. Toggle recording uses one trigger to toggle recording on/off.
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Figure 7-11. QuicKeys Actions – Switch Subscope

• Switch Subscope – Each shortcut Scope can have multiple Subscopes, allowing for a multitude of actions 
to be triggered by the same hot keys. By creating a shortcut to Switch Subscopes, you can turn on/off whole 
groups of shortcuts assigned to those subscopes with a single keystroke. Usage of Subscopes is covered in 
Chapter 4, setting up the associated Switch Subscope type of QuicKeys Action shortcut is covered here:
▫ Subscope Action

- Switch to Next/Previous Subscope – Switch to the next/previous Subscope within a specific 
application, the front application, or the All Applications scope.

- Switch to Specific Subscope – Switch to a specific Subscope of a designated Scope. Choose a scope 
from the Scope pop-up and then choose the desired Subscope. For example, if you have subscopes of 
“composing” and “filing” within your Mail scope, you can switch directly to either of those scopes.

▫ Scope – Select which Scope is having its Subscope switched.
- All Applications – This option will activate the specified subscope within the All Applications scope.
- Front Application – This option will activate the specified subscope within the front-most application 

of that subscope exists.
- Application List – Choose one of your application-specific scopes from the list.

▫ Subscope – Choose the desired Subscope.
- Subscope List – Select the desired subscope from the list of subscopes associated with the scope 

chosen above.
- Subscopes Off – Rather than choose a specific subscope, have QuicKeys turn off any custom 

subscopes in the active scope.
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Repeat Loop
Create -> QuicKeys -> Repeat Loop
You can use the Repeat Loop shortcut to replay steps in a Multi-step shortcut. Rather than having to cut and paste 
several iterations of a series of steps within a shortcut, you can duplicate, triplicate, or centuplicate those steps easily 
with a Repeat Loop.

Repeat Loop Usage
Repeat Loop requires both a Begin and an End step to work. Youʼll need to sandwich the desired steps below the 
Begin Repeat Loop step and above the End Repeat Loop step.

  

Figure 7-12. Begin Repeat Loop options 

Repeat Loop Options
Repeat Action - Select Begin repeat loop to repeat the steps that follow the Begin Repeat Loop shortcut and 
precede the End Repeat Loop shortcut. Select End repeat loop to terminate a Begin Repeat Loop shortcut. You 
must create an End Repeat Loop shortcut in Multi-step shortcuts to terminate a Begin Repeat Loop shortcut. If 
you select Begin repeat loop, the following options appear:
• Repeat X times - Specify how many times you want the steps between the Begin Repeat Loop shortcut and 

the End Repeat Loop shortcut to repeat. 
• Prompt for repeat count - Select this option if you want QuicKeys to display a prompt asking you to choose 

how many times you want the shortcut steps to repeat at runtime.
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Variables
Create -> QuicKeys -> Variables
Variables are one of the more advanced features of QuicKeys X3. In general, they allow you to store, compare, and 
use information gathered on the fly in a multi-step shortcut. These variables can be set to remember their values 
even if you quit and re-launch QuicKeys or reboot your computer. Alternately they can be told to reset to a specific 
defined value whenever QuicKeys is launched.

The QuicKeys Variable Window
Before we discuss the actual Variable shortcuts, we need to look at how shortcuts are initially created. Within 
QuicKeys, if you select Variables from the Windows menu, the window shown in Figure 7-13 will open. This 
QuicKeys Variables window contains all of the variables you have created, plus the system Clipboard (the Clipboard 
is really just a variable whose value is whatever item you last cut or copied). This window floats on top of all other 
windows so you can see the values of your variables change as you play your shortcuts.

Figure 7-13. The QuicKeys Variable window controls

Features of the QuicKeys Variable window
• Name column – The Name column shows the name of any variable you have created. Double-click on the 

variable name to edit it.
• Value column – The Value column shows the contents of each variable. You can manually change the value of 

a variable by double-clicking on it and editing it.



118

Chapter 7 - QuicKeys Tools

• Type column – The Type column shows the type of data contained in a variable. Common data types are 
Number and Text.

• Add/Remove buttons – Click these buttons to add a new variable or to delete a selected variable.
• Inspector toggle – Click this button to open/close the variable Inspector pane. This inspector is an alternate 

way to edit your variables and has a unique feature of its own explained later in this section.
• Revert to Default button – Reverts the value of a selected variable to that variable s̓ default value. 
• Set Default button – Click this button to designate a selected variable s̓ value as the new Default. The default 

value of a variable is automatically loaded into a variable whenever QuicKeys is launched.
❖ Note: The QuicKeys Variable window floats above all other windows so you can watch the values of your 

variables changes as your shortcuts play back.

Features of the Variable Inspector window
Click the Inspector button in the QuicKeys Variable window to show the variable Inspector window.

 

Figure 7-14. The Variable Inspector

• Name – The Name field shows the name of a variable you have selected. This field can be edited.
• Value – This field shows the contents of the variable selected in the QuicKeys Variables window. This field can 

be edited.
• Remember value – checking this box tells QuicKeys to remember the selected variable s̓ value across quits 

and re-launches of QuicKeys. Leaving this unchecked means that if QuicKeys is quit, the variable will revert 
back to its Default value next time QuicKeys is run.

• Set Default Value to Current Value button - Click this button to designate a selected variable s̓ value as the 
new Default. The default value of a variable is automatically loaded into a variable whenever QuicKeys is 
launched.
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Assign Variable Shortcut
Variable shortcuts come in three flavors, Assign, Compare, and Use. The Assign Variable shortcut lets you assign 
new values to variables while a shortcut is playing. The value you assign can be a plain number or text, the contents 
of another variable, or the result of an equation you build.

 

Figure 7-15. Assign Variable shortcut options

Assign Variable shortcut options
Variable pop-up list – Choose the variable you want to work with from this list. If you have created no 
variables of your own, the only one in the list will be the System Clipboard.
Value/Equation field – Put the value you want to assign to the chosen variable here. This field is more than 
just a text/numerical entry field though! You can build equations in this field that incorporate mathematical 
operators and make use of the data from other variables.
Add Equation Item pop-up list – This list contains all of your variables and the system clipboard variable, a 
list of mathematical operators, and a few other items helpful for building your equation in the equation field. 
Most of these items can also be quickly typed into the equation editor, but you must tab-complete them to get 
them to operate properly.
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Take a look at the equations in Figure 7-16. The first equation is concatenating the contents of the Clipboard 
with the contents of the Name variable. The ampersand (and) symbol was chosen from the Add Equation 
Item pop-up list. In the second equation, the user is typing the word “and” rather than selecting the symbol 
from the list. The word “and” will become an orange ampersand operator as long as the user hits their tab key 
while the word “and” is highlighting itself indicating that it wants to auto-complete. If “and” is not allowed 
to auto-complete to an “&” symbol, QuicKeys will consider “and” to be a string and not an operator. This 
same behavior goes for any operator or other item in the Add Equation pop-up list: If you want to type these 
operators in, you have to use your tab key to auto-complete them or they will not covert to operators and will 
evaluate as strings.

Figure 7-16. Example equations 
and auto-completing operators

Ask for variable and equation – Rather than predetermining what you want for the selected variable s̓ value, you can 
assign it at run time. If you check this box, QuicKeys will stop playback when this step is reached and ask you for 
the value you want assigned to the variable.
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Compare Variable Shortcut
The Compare Variable lets you compare the contents of a variable with another value. The entire point of this 
shortcut type is to test a variableʼs value then use the results in conjunction with Step Results to branch the flow of 
your shortcut. For example, you might test to see if the value of a counter variable you have created has reached a 
value of “0”. If that value has not been reached, jump back to step 1 of your multi-step shortcut. If zero has been 
reached, terminate playback of the shortcut.

 

Figure 7-17. Compare Variable shortcut options

Compare Variable shortcut options
Variable pop-up list – Choose the variable whose contents you want to compare from this list. If you have 
created no variables of your own, the only one in the list will be the System Clipboard.
Variable comparison popup list – The comparison pop-up contains a 14 different methods of comparing the 
contents of the selected variable with some value determined by the user.
Comparison equation field – Enter a value or build an equation to compare against the value of the variable 
selected in the Variable pop-up list.
In Figure 7-17, the example shortcut is comparing the contents of the IDNumber variable with the contents 
of the Clipboard. If they are equal, this step results in True/Success. If the comparison is not true, the step is 
considered a Failure for Step Results purposes.

Add Equation Item pop-up – This item is explained fully in the Assign Variable write-up earlier in this section.
Numeric comparison – Check this box if you want to force a numeric comparison of the values of your variable 
and the equation field. For example, one of the items you are comparing may contain the string “3.0” rather than a 
numeric “3”. To force the 3.0 to evaluate as a numeric 3, you would need to check this box.
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Ask for variable and equation - Rather than predetermining what value you want to compare your variable to, you 
can determine it at run time. If you check this box, QuicKeys will stop playback when this step is reached and ask 
you for the value you want to compare to the selected variable s̓ contents.
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Use Variable Shortcut
The Use Variable shortcut lets you extract the contents of a variable while a shortcut is playing. The contents can be 
typed or pasted by QuicKeys into a document, or displayed on your screen.

 

Figure 7-18. Use Variable shortcut options

Use Variable shortcut options
Use Value: Variable – Choose the variable whose contents you want to use from this list. The contents will be 
outputted in the manner you choose for the Action portion of this shortcut. If you have created no variables of 
your own, the only item in the list will be the System Clipboard.
Use Value: Equation – Rather than simply pull the contents from one of your variables, you can create an 
equation consisting of variables and operations upon them. The results of the equation are determined and then 
outputted in the manner you choose.
Ask for variable/equation – Rather than predetermining what variable value or equation you want to use, you 
can determine it at run time. If you check this box, QuicKeys will stop playback when this step is reached and 
ask you for the variable or equation you want to use.
Action: Insert/Type/Display Value – Select the desired radio button to choose the method of output you want 
QuicKeys to use. Typing and Inserting into documents will quickly dump the contents of a variable or the 
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results of an equation into a document for you. Displaying the value lets you OK/Succeed or Cancel/Fail the 
step. You can also select and copy the results from the Equation Value window.

Figure 7-19. The Display Value window 

The Equation Tester
The Equation Tester window is opened by selecting Equation Tester from the Window menu in the QuicKeys X3 
application. This tester is a utility window meant as a convenience to help users test their equations without having 
to put them into a working shortcut. Once youʼve created an equation that yields the results you want, you can make 
quick use of it copying and pasting it into a Variable shortcut.

Using Variables
A book, or at least a very large pamphlet could be written describing ways to use variables in general, and QuicKeys 
Variables to be specific. Weʼre going to settle for an overview here and a tutorial later in this chapter.
Users without a programming background may have little idea how variables are supposed to work. The premise 
is that QuicKeys variables are simply containers that you create and then use within multi-step shortcuts to hold, 
modify, and retrieve information as the shortcut plays out.
Variables can be of great assistance in doing something as simple as pulling several cells worth of data from a 
spread sheet then moving that data into another type of document. For example, assume a spreadsheet contains four 
columns containing Name, Address, City, and State and you want to move this data into a web form. Normally you 
would have to copy the contents of a cell, switch to a browser, paste, switch back to the spreadsheet, copy a cell, etc. 
Even using QuicKeys to help with this process doesnʼt reduce the inefficiency of switching between apps repeatedly.
However, if you use variables you can copy and collect a whole row of cells into separate variables before switching 
to your browser. Tabbing through the browser fields and pasting the contents of your variables in the proper places 
as you do so is going to mean a huge speed improvement in your shortcut.
Letʼs extend that example a bit further and assume there are dozens of rows of data to move. Youʼd want QuicKeys 
to go into a loop and copy these rows of data repeatedly until there was no more data to move. But how does 
QuicKeys know when to quit? Variables to the rescue again... Just test the value of your “Name” variable whenever 
you move data into it and if it ever becomes zero or “empty”, QuicKeys can branch out to end the shortcut at that 
point.
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Some things to remember
Variables will undoubtedly be a daunting feature to some users, but just experiment and keep the following tips in 
mind as you do so:

• The QuicKeys Variables window is where you create new variables and assign their initial and default values 
if so desired.

• The Assign Variable shortcut is used to move data into your variables during playback of your shortcuts. The 
data you move into your variables during run time can only come from 4 places, the system Clipboard, another 
QuicKeys variable, the contents of the Equation field, or from the user on the fly during playback of the 
shortcut. (Okay, AppleScript is a 5th place that variables can come from and is covered in Appendix A.)

• The Use Variable shortcut is what you use to retrieve the contents of a variable and Type/Insert it into 
documents or display it on your screen.

• The Compare Variable shortcut is the tool you use to test the contents of a variable. The results will always be 
True or False which directly translates to Step Results of Success or Failure. For example, you may test to see 
if the number in one of your variables is larger than the number held in the system Clipboard. If your variable 
is larger, that shortcut step is a Success. If your variable is not larger, then that step is a Failure.

• Step Results are the key to actually doing something with the results of your variable comparisons. For 
example, be it a successful or failed step, Step Results can stop a shortcut or cause it to jump to a non-
sequential step.

• http://forum.quickeys.com is a great place to go present questions to other members of the QuicKeys 
Community.
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Wait
Create -> QuicKeys -> Wait -> ...
The Wait shortcut puts a multi-step shortcut on hold while it waits for a certain condition to occur. Once that 
condition is met, the shortcut will proceed to the next step. This is an excellent way to keep your shortcut playback 
in sync with what is happening on your computer. Where a strict Pause of X seconds may be at the mercy of your 
computerʼs performance from day to day, the Wait shortcut has no such concern.
The Wait shortcut comes in six flavors: Wait for Application, Button, Date & Time, Menu, User, and Window.

Wait for Application
Waits for the state of a specific application to change to running, not running, front-most, not front-most, 
hidden, or not hidden.
Wait for Button
Waits for a specific button to appear or go away, become enabled or not enabled, become selected (checked) or 
is not selected. Buttons can be differentiated by not only name but also what type of window they are in.
Wait for Date & Time
Checks the current date and time to see if it is before or after the date and time you specify.
Wait for Menu
Waits to see if a specific menu or menu item comes into existence or does not exist, becomes enabled or 
disabled, becomes checked or unchecked.
Wait for User
Waits for the user to click their mouse, press a specified key, or press any key before continuing.
Wait for Window
Waits for a specific window of a specific type to exist or go away, become front-most, or no longer be front-
most.

❖ Note: When you look at the contents of the Create -> Wait submenu youʼll note that six types of Wait shortcuts 
are listed. But when you look at the “Wait for” pop-up list while editing a Wait shortcut, youʼll see only five. The 
missing item is the “Wait for Menu” option. Wait for Menu is very closely tied to the Menu Selection shortcut type, 
and as such there are engineering reasons why it will not work well to make it an option in the Wait for pop-up.
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Wait for Application - Options

Figure 7-20. Wait for Application options

Application: pop-up list
Choose from the list of running applications, or choose “Select Application...” and navigate to the desired 
application.

State: pop-up list
• Is Running – QuicKeys checks to see if the specified application is running. If the application isnʼt running, 

QuicKeys pauses playback of the shortcut until it is.
• Is Not Running – QuicKeys looks for the specified application. If that application is running, playback of 

the shortcut is paused until it quits.
• Is Front Most – If the specified application is not in front, QuicKeys pauses the shortcut until that 

application moves to the front.
• Is Not Front Most – If the specified application is in front, the shortcut is paused until that is no longer the 

case.
• Is Hidden – If the specified application is not hidden, QuicKeys pauses playback of the shortcut until it 

becomes so.
• Is Not Hidden – If the specified application is hidden, the shortcut is paused until it is no longer hidden.
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Wait for Button - Usage
Using this shortcut is very simple once you get used to setting the various states for your button so that QuicKeys 
can find it accurately. Once youʼve properly defined the button you are keying off of, QuicKeys will check that 
buttonʼs conditions and if they do not match what you have specified, the shortcut will pause until they do.
For example, you might have a multi-step shortcut set up that needs to pause or wait until a button named “Reset” 
becomes active in a sheet on the front-most window. You would set up the Wait for Button shortcutʼs pop-ups like 
so:

Exists: Yes
Enabled: Yes
Selected: Do not care
Button Window: Sheet on front window

Until these conditions are all met by the button in question, the shortcut playback will remain paused.

Wait for Button - Options

Figure 7-21. Wait for Button options
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Button Name: pop-up list 
QuicKeys looks for a button whose name is, contains, starts with, or ends with the text you enter.
Ignore Case 
If you check this box, QuicKeys will ignore upper/lower case differences when trying to locate your button.
Which button if multiple matches: 
If more than one button that matches your naming criteria exists, QuicKeys needs to be told which of those 
buttons it should be looking at.
Button Window: pop-up list 
When looking for the desired button, QuicKeys can be instructed to find it in a particular type of window such 
as, palette, document, sheet, or drawer. Only the front window can be tested.
Exists: pop-up list 
QuicKeys needs to be told what attribute of that button should be tested. Primarily you will want QuicKeys to 
test whether or not the specified button Exists.
Enabled: pop-up list 
QuicKeys can test to see if a button is enabled or disabled (grayed out), or you may not care which state it is 
in.
Selected: pop-up list 
Check boxes and radio buttons are testable too! This pop-up list lets QuicKeys check to see whether or not a 
particular radio button or check box is checked.
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Wait until Date & Time - Options

Figure 7-22. Wait until Date & Time options

Date & Time fields 
QuicKeys will pause playback of the shortcut until the current time matches the Date and Time you specified.
Only check time 
Enable this option if you are not concerned with the date and want QuicKeys to only check the current time.
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Wait for Menu - Options
❖ Note: The Wait shortcutʼs Menu Action pop-up list, for engineering reasons, contains options other than “Wait for 
Menu”. If you select one of these other options, you are no longer in the realm of the Wait shortcut, so those options 
are not explained here. Look for an explanation of the Select Menu option on page 173, and details on the Check for 
Menu option on page 106.

Figure 7-23. Wait for Menu options

Menu and Menu Item fields 
Enter the name of the menu and menu item you want QuicKeys to test against. You can hand type these names 
or you can use the Choose Menu button to automatically fill in that information. Details buttons allow you to 
further refine the target menu details.
❖ Note: The upper half of this shortcut window behaves exactly like the Menu Selection shortcut type, please 
refer to the in-depth instructions on page 173 for more details on designating a menu item.
Exists: pop-up list 
Have QuicKeys check to see if the specified menu item Exists or does not Exist. If you select “Yes” then 
QuicKeys will pause playback until that menu or menu item exists. If you select “No” then QuicKeys will 
pause playback until that menu or menu item no longer exists.
Enabled: pop-up list 
Menu items that are Enabled or active show up in black text, those that are Disabled or inactive use gray text. 
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QuicKeys can test for this condition and the shortcut playback will be paused until the selection you specify 
here is met.
Checked: pop-up list 
A menu item will sometimes have a check mark beside it indicating that whatever part of the application it 
controls is turned on. QuicKeys can test a menu item for the presence of a check mark. If you set this pop-up 
to “Yes” QuicKeys will pause playback of the shortcut until the specified menu item becomes checked.
Show menus while performing menu action 
Some applications do not build their menus until you click on them with your mouse, and they cease to 
exist once they close. This means QuicKeys will have to actually open the desired menu to get it to draw 
its contents and make them accessible. Also, it is often impossible to test a menu item to see if it exists, is 
checked, or is enabled unless its menu is opened. For this reason, this option will have to be checked for 
almost every Wait for Menu and Check for Menu shortcut you build.
Perform as alternate menu action (option key) 
The names of some menu items change if you open the menu and hold down your option key (open Safari s̓ 
File menu and depress the option key, you should see Close Window change to Close all Windows). With 
this option checked, QuicKeys simulates pressing the option key while checking for the desired menu item s̓ 
presence.
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Wait for User Action - Options
This type of Wait shortcut pauses playback of the shortcut until the user interacts in a particular way as defined in 
advance.

Figure 7-24. Wait for User Action options

User Action pop-up list
• Click with Main Button – The shortcut is paused until the user clicks the primary button on their mouse.
• Click with Second Button – The shortcut is paused until the user clicks the second button on their mouse.
• Click with Third Button – The shortcut is paused until the user clicks the third button on their mouse.
• Any Keystroke – QuicKeys pauses the shortcut and waits for the user to press any key before continuing to 

the next step.
• Return – QuicKeys pauses the shortcut and waits for the user to press the Return key before continuing to 

the next step.
• Enter – QuicKeys pauses the shortcut and waits for the user to press the Enter key before continuing to the 

next step.
• Space – QuicKeys pauses the shortcut and waits for the user to press the Space bar before continuing to the 

next step.
• Escape – QuicKeys pauses the shortcut and waits for the user to press the Escape key before continuing to 

the next step.
• Tab – QuicKeys pauses the shortcut and waits for the user to press the Tab key before continuing to the 

next step.
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Wait for Window - Options
The Wait for Window shortcut tells QuicKeys to pause a shortcut until a window matching the conditions specified 
exists (or no longer exists). The methods needed here to define the desired window are identical to the Check for 
Window portion of the Decision shortcut; for some examples go to page 108.

Figure 7-25. Wait for Window options

Identify the window
Window Name: pop-up list 
Choose from Is, Contains, Starts with, and Ends with, and enter the name of the Window for which you are 
testing.
Window Type: 
In cases where you may have more than one window with the same name (a document named Font and a 
palette with the same name for example), QuicKeys can differentiate by window type. Choose from eight 
different window types if you need to be specific, or leave it set to Any Type of Window if the type does not 
matter.
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Window Is:
• Main Window – The main window is essentially the most important window on your screen at any 

given time. This is often a document or list window. By testing for the Main window you can often 
avoid needing to specify the window name.

• Focused Window – The focused window is the often where your text insertion point is, or possibly 
where you have selected a control or object. This is often but not necessarily a document window; it 
could also be a palette or toolbar for example.

• Frontmost/Any Level - The level at which the desired window currently resides can also be specified 
for testing by QuicKeys. Your choices are Front-most and Any Level. If you simply want to know if 
the window is open, use Any Level. But if, for example, you need QuicKeys to perform operations 
inside the front window, youʼd want to specify Frontmost. In this case if the window is open and in 
front, the Step Result is “Success”, but if the window is open and not in the front, the Step Result is 
“Failure”.

Test the window state
Window State:

• Exists – QuicKeys tries to find the window you specified with the first three pop-ups and pauses the 
shortcut until it can.

• Does Not Exist (closes) – If the specified window does not exist, the shortcut does not pause. If it 
does exist, QuicKeys pauses the shortcut and waits for the specified window to close.

• Changes Order – QuicKeys takes note of the current level of the specified window, pausing the 
shortcut until the level changes.
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Chapter 8: Scripting Tools

QuicKeys can enhance your AppleScripts by tying them to QuicKeys triggers. Conversely, AppleScripts can become 
steps in a QuicKeys multi-step shortcut, providing more flexibility in how you manipulate your work environment.

AppleScript
Create -> Scripting -> AppleScript
AppleScript is a programming language designed for controlling applications via Apple Events. It provides simple 
commands you can use to customize and automate your Mac. QuicKeys harnesses this additional power by allowing 
you to either enter AppleScripts as text directly into a shortcut, or by reaching out to an already compiled script to 
execute it as part of a multi-step shortcut.
For example, iTunes is equipped with a handy set of scriptable features. In chapter 3 of this manual, one of the 
tutorials shows you how to build shortcuts to manipulate several of iTunes  ̓more frequently used features.

Figure 8-1. The AppleScript Shortcut options

AppleScript Shortcut Options
AppleScript type: Text 
Choosing the Text option provides a text box where you can type in your AppleScript. It also reveals a 
Check Script button which checks the syntax of the script you entered. If there is a problem with your script, 
QuicKeys will notify you with a dialog similar to that shown in Figure 8-2.
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Figure 8-2. The AppleScript Compile Error window

AppleScript type: File 
Choosing the File option reveals a Select Script File... button. Click this button to reveal a standard open file 
window and navigate to a previously created AppleScript file, then click Choose.
Assign Script Result to Variable 
AppleScripts can return success or failure or some other value depending on how they are written. You can 
have QuicKeys place the script results inside one of your QuicKeys Variables (see Chapter 7 for more on 
Variables), just choose the desired variable from this pop-up list. If you have not set up any variables in 
QuicKeys, this pop-up will contain only “Clipboard” as an option, allowing you to send the script results to 
the system clipboard.
❖ Note: When QuicKeys executes an AppleScript step, it is intelligent enough to wait for that script to finish 
before continuing on to the next step in the multi-step shortcut.
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QuicKeys System Tools cover a wide array of functions, from collecting and retrieving text and graphics clips and 
shutting down your computer, to switching applications and running terminal commands.

Clips
Create -> System -> Clips
The Clips shortcut Type enables you to gather and store clips of text or graphics in a Clips Group. The Clips shortcut 
is a bit like the system clipboard, but with a memory. Unlike items on your system clipboard, QuicKeys Clips are 
saved even if you restart your computer or quit QuicKeys. It is a permanent collection of boilerplate text (formatted 
or unformatted) and/or graphics that you can retrieve at any time to paste or type into a document.

Clips Options
The Clips shortcut Type requires that you make two different instances of the shortcut to be fully functional: one to 
gather text and graphic selections and one to display a list of clips that you can choose to insert.

Figure 9-1. Clips Shortcut options for making/gathering Clips
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Make new Clip in selected group
Where you set up the method used to gather your text and graphics into a collection of clips.

Use selection in front applications 
This option will copy whatever text or graphics you currently have highlighted/selected in your application, 
and turn it into a clip for later retrieval. 
Use contents of clipboard 
This option will copy whatever text or graphics are currently on your system clipboard, and turn it into 
a clip for later retrieval. This is useful if youʼve cut or copied data to the system clipboard, closed the 
document, and subsequently decide that data would make a good clip for your collection.

Insert selected clip/prompt for clip from selected group 
Here you set up the method used to retrieve and insert your text and graphics from a collection of clips.

Paste clip when inserting 
This option behaves much like pressing Command+V and pasting something from your system clipboard. 
This is the fastest and most common way to insert your clips into your documents.
Type clip when inserting 
This option simulates the keyboard typing the clip data into your document. This only works with text 
clips, graphics clips cannot be “typed.” Having QuicKeys type the clip as text might be necessary if the 
target application cannot accept paste/insert actions.

Make applications recognize Clip actions 
If you have problems pasting a Clip into a particular application, selecting this checkbox may solve the 
problem.

Clip Groups
The bottom section of the Clips shortcut window deals with Clip Groups. You do not have to create Clip 
Groups, but as you accumulate more and more bits of text and graphics in your Clips collection, you will 
likely take some interest in sorting and segregating them for easier retrieval.

New Clip Group 
The New Clip Group button creates a Clip Group in which to store clips. If you have the no Clip Groups 
selected when you click this button, QuicKeys will create a new Clip Group in the root/main level.
If you have another Clip Group selected and you click the New Clip Group... button, the new Clip Group 
will be created inside the selected group.
You can create nested/hierarchical clip groups as deep as you like, much like nesting folders in the Finder.
Rename 
Click the Rename... button to change the name of a selected Clip Group.
Delete 
Click the Delete... button to delete a selected Clip Group. (Note: this will delete any clips contained within 
the selected Clip Group as well!)
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Clips Usage & Behavior
Once youʼve created your “gather” and your “retrieve” shortcuts, youʼll populate your clips collection with 
the “gather” routine. The following 5 steps are the typical sequence of steps you will take to add a clip to your 
collection:

Figure 9-2. Save QuicKeys Clip window

Gather clips
1. Use your mouse to highlight/select desired text or graphics.
2. Press the hot key you assigned to trigger your Clips “gather” shortcut. The Save QuicKeys Clip window 

appears.
3. Type a descriptive name for your clip.
4. Select a Clip Group in which to save your clip. You can also create a new Clip Group on-the-fly at this time 

if desired.
5. Click the Save button.
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The following 3 steps are the typical sequence of steps you will take to insert or paste from your collection 
into a document:

Figure 9-3. Insert Clip window

Retrieve clips
1. When you are ready to paste a clip into a document, press the hot key you assigned to trigger your Clips 

“retrieve” shortcut. The Insert Clip window will appear with the names of the Clip Groups and Clips you 
have created and gathered.

2. Select the clip you want from the left, notice that the contents of that clip are displayed on the right side of 
the window.

 ❖ Note: To select a clip you donʼt have to use your mouse, you can use your keyboard. Type-to works in 
this window; just type the first few characters of a clipʼs name and QuicKeys will jump to that clip. You can 
also change Clip Groups and select clips with the arrow keys on your keyboard.

3. Press the Return key or click the Paste/Type button to insert the clip into your document.
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Computer
Create -> System -> Computer
The Computer shortcut lets you automate the process of logging out, putting your computer to sleep, showing and 
hiding applications, and launching/quitting the Classic environment, among other things.

 

Figure 9-4. Computer Shortcut options

Computer Shortcut Types
• Shut Down – Shuts down your computer immediately with no “Are You Sure?” warning. You will still be 

prompted to save any unsaved documents.
• Restart – Restarts your computer immediately with no “Are You Sure?” warning. You will still be prompted to 

save any unsaved documents.
• Sleep – Puts your computer in sleep mode.
• Log Out – Logs out of the current user account.
• Hide Front Application – Hides the front-most application.
• Hide Other Applications – Hides all but the front-most application.
• Show All Applications – Reveals all open, previously hidden applications.
• Bring All Windows to Front – Brings all of the windows of the front-most application to the front. 
• Start Classic – Starts the Classic Mac OS operating system (if available).
• Stop Classic – Shuts down the Classic Mac OS operating system.
• Start Screen Saver – Starts the userʼs screen saver as specified in System Preferences.
• Empty Trash – Empties the system trash without the need to switch to the Finder or click on the Dock. 

❖ Note: This shortcut bypasses the systemʼs “are you sure you want to empty the trash” warning so use it with 
care.  
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Finder Views
Create -> System -> Finder Views
The Finder Views shortcut enables you to adjust the appearance of Finder windows with a QuicKeys trigger. This 
shortcut duplicates a feature now built into the Finder, but QuicKeys adds the ability to change all open window 
views simultaneously.

Figure 9-5. Finder Views Shortcut options

Finder View Options
When you set up a Finder Views shortcut, you can choose to view windows in the Icons view, List view, or Columns 
view. Select the Change view in all open windows checkbox if you want your Finder View shortcut to change the 
view of all your open Finder windows. If you do not select the checkbox, QuicKeys will only change the display of 
the active Finder window. 



145

Chapter 9 - System Tools

Switch Applications
Create -> System -> Switch Applications
The Switch Applications shortcut enables you to switch between applications with a hot key rather than having 
to use mouse clicks. You can create shortcuts to switch directly to specified applications, or switch between open 
applications. As well as being great stand-alone shortcuts, Switch Applications is a staple of many multi-step 
shortcuts you may want to build.

Figure 9-6. Switch Applications Shortcut options

Switch Applications Options
Action: Switch to Next/Switch to Previous 
Switching to the next or previous application is based on the order in which you last accessed a pair of 
open applications. For example, if you just finished writing an e-mail message and have switched to Safari, 
triggering a Switch to Next or Previous Application shortcut will put you back to working in Mail
Action: Switch to Specified 
Selecting “Switch To Specified” reveals a couple more options. How QuicKeys affects other applications 
After Switch, which application to Switch to, and whether or not to launch said application if it is not already 
running.
After switch:
• Leave other applications visible – This is what the operating system does naturally when you use 

Command+Tab to switch to another application. No application windows are hidden in this case.
• Hide previous application – This option completely hides the previous application from view after the 

switch is made. Hidden applications can be revealed by clicking on their Dock icon.
Switch to: 
When choosing which application to open, the pop-up list that displays is populated with currently running 
applications. If the desired application is not listed, choose “Select other”. A standard navigation window 
appears so you can navigate to the desired application and click Choose.
• Open if not running - Select the Open if not running checkbox if you want to open an application that isnʼt 

currently running.
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Switch Printer
Create -> System -> Switch Printer
The Switch Printer shortcut changes your default printer without you having to manually do so in the print dialog. 
Print jobs can be easily scripted and printing to multiple printers can be done more efficiently with this shortcut.

Figure 9-8. Switch Printer Shortcut

Switch Printer Options
Switch to Printer pop-up list - This pop-up list contains printers that are already set up for use in your system. 
You can define more printers with the Printer Setup Utility found in your /Applications/Utilities folder.
❖ Note: The Switch Printer shortcut should be run while an applicationʼs print dialog is closed. If you invoke 
an applicationʼs print dialog and subsequently trigger a Switch Printer shortcut, the printer selection will not 
change until after you close and re-open the print dialog.

Switch Printer Usage
The Switch Printer shortcut is handy as a stand-alone shortcut, but really shines when combined with a simple  
File -> Print Menu Selection shortcut. For example, to quickly print to your black and white draft printer you could 
make a two-step shortcut that does a Switch Printer (to the b&w draft printer) then select Print from the File menu. 
Give it a hot key of Command+P and youʼll always print to your draft printer when you press Command+P.
For color printing you might instruct the Switch Printer shortcut to select your high quality color printer before 
selecting Print from the File menu. Assign Command+Shift+P to this shortcut and youʼll always print to your color 
printer when you press that key combination.
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Terminal Command
Create -> System -> Terminal Command
The Terminal Command shortcut executes UNIX commands without the need to open the Terminal application. You 
type in the command you want executed, and QuicKeys feeds it to the operating system behind the scenes.

Figure 9-7. Terminal Command Shortcut

Terminal Command Options
To create this shortcut you simply type the desired command into the Run command text box and save the shortcut. 
When you trigger the shortcut the action takes place out of view; no windows or dialog boxes of any type open. This 
is a very powerful feature, but it also means you cannot interact with what your command has set in motion; So keep 
in mind: if, for example, you used this type of shortcut to send a “sudo” command, you would not be given any way 
to enter the required password.
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Chapter 10: Text Shortcuts

QuicKeys Text shortcuts manage text in several useful ways: Text can be stored and retrieved at any time with tap 
of a key, the current date and/or time can be inserted into documents in just about any imaginable format, and a 
password can be injected into multi-step shortcuts with a more secure form of text storage.

Date & Time
Create -> Text -> Date & Time
The Date & Time shortcut is pretty straight forward in its uses. You can insert it into documents you are working on, 
put it in a multi-step shortcut along with formatted text for up-to-the-minute boilerplate letterhead, use it to adjust 
web page “last edited” information, and more.

Date & Time Options
The options available in the Date & Time Shortcut Editor window are dependent upon what is selected in the Type 
pop-up menu. An example of the selected format appears in the preview section in the lower half of the Shortcut 
Editor window.

Standard Options
The following options are available in each of the Date & Time shortcut options:
• Insert Text – Select this option to Insert/Paste the date and time rather than have QuicKeys simulate typing it 

into your document. Inserting is faster but typing works when insert may not.
▫ Make applications accept insert – Some applications are unaware of changes to the contents of the system 

clipboard, which can cause problems with insert operations. Selecting this option will force all applications 
to check with the system clipboard for any changes before inserting.

• Type Text – Select this option to have QuicKeys simulate typing the date and time rather than using the Insert 
method.
▫ Slow/Fast Typing Slider – The Type Text speed slider is used to adjust how fast QuicKeys types. If you 

are using an older machine or constantly working your G5 hard enough for the fans to be running at “leaf 
blower” speed, you may need to retard the speed at which QuicKeys tries to type so the system s̓ typing 
buffer can keep up. This can be done by changing the slider in QuicKeys  ̓general preferences, or by 
changing the slider in any individual shortcut which types text.
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Short Date
By selecting Short Date from the pop-up list, you are presented with various options for customizing the date format. 

Figure 10-1. Date & Time Shortcut, Short Date

Short Date Options
• Format – Choose which parts of the date (Month, Day, and Year) you want typed, and in what order to type 

them.
• Separator – Enter the character you want to use to separate day from month from year.
• Leading zero for day – Selecting this option puts a “0” in front of the Day if the day is a single-digit number. 

For example, “October 1” becomes “October 01”.
• Leading zero for month – Selecting this option puts a “0” in front of the Month if the month is a single-digit 

number. For example, “1/12/2004” becomes “01/12/2004”.
• Show century – Checking this box displays the year in four digits rather than two.
• Adjust by – Numbers entered in these fields are an offset QuicKeys uses when typing the date. Positive 

numbers adjust the date forward, negatives adjust it back. This is useful for automating “will contact you on or 
before <future date>” messages, for example.



151

Chapter 10 - Text Shortcuts

Long Date & Abbreviated Date
The Long Date and Abbreviated Date options are exactly alike. The difference in the two types of shortcut is, as the 
name suggests, Abbreviated Date uses month and day abbreviations rather than the full names. For example, the 
long date “Monday, October 17, 2004” would be “Mon., Oct. 17, 2004” as an abbreviated date. You can view the 
selected format in the preview section in the lower half of the shortcut editing window.

 

Figure 10-2. Date & Time Shortcut, Long Date

Long Date & Abbreviated Date Options
• Prefix – Use this option to specify a prefix. For example, if you enter “on ” here, QuicKeys will type the date 

as “on Monday, October 17, 2004”.
• Day, Weekday, Month, Year – These pop-ups determine the order by which each part of the date is typed. 

Following each pop-up is a field where you can place a separator. The example in Figure 10-2 shows comma 
separators following both the Weekday and Day.
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• Leading zero for day – Selecting this option puts a “0” in front of the Day if the day is a single-digit number. 
For example, “October 1” becomes “October 01”.

• Show century – Checking this box displays the year in four digits rather than two.
• Adjust by – Numbers entered in these fields are an offset QuicKeys uses when typing the date. Positive 

numbers adjust the date forward, negatives adjust it back. This is useful for automating “will contact you on or 
before <future date>” messages, for example. 

Time
The Time shortcut inserts the time into your documents, formatted in a number of ways. Choose from 12 and 24-
hour clock options, custom Separator and AM/PM characters, and more. You can view the selected format in the 
preview section in the lower half of the shortcut editing window.

Figure 10-3. Date & Time Shortcut, Time options
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Time Options

• 24-hour clock – Use this option for military style time formatting. 7:00PM would become 19:00 with this 
option selected.

• 12-hour clock – Use this option for standard 12-hour time formatting. You can specify whether noon and 
midnight are displayed as “0:00” or “12:00”.

• Include seconds – Select this option to type the time in a format that includes seconds.
• Before/After Noon indicators – Use this option to provide a designation for morning or afternoon. Leave blank 

for no AM/PM designation.
• Separator – Enter the character you want to use to separate the hour from the minutes from the seconds.
• Use leading zero for hour – Selecting this option puts a “0” in front of the hour if the hour is a single-digit 

number. For example, “7:45” becomes “07:45”. 
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Text Tools
Create -> Text -> Text Tools
Text Tools shortcuts are a collection of useful text formatting operations. They allow you to quickly clean up 
superfluous white space, turn styled text into plain, change case, and more.

Text Tools Options
The available options for Text Tools shortcuts consist of Text Action and Text to Change options. The Text Action 
pop-up list is where you choose the operation youʼd like to have QuicKeys perform on the desired text. The Text to 
Change pop-up list is where you indicate which text to reformat, and what to do with that reformatted text.

Figure 10-4. Text Tools options

Text Action pop-up list
• Reformat – removes single spaced carriage returns and extra white space
• Remove Styles – removes all formatting information such as font and color
• Remove E-mail Quotes – removes e-mail quotes of the form “>”
• Upper Case – MAKES ALL TEXT UPPER CASE, LIKE THIS TEXT
• Lower Case – makes all text lower case, like this text
• Title Case – Capitalizes The First Character Of Each Word, Like This Text.

Prompt for action checkbox 
Rather than setting up individual shortcuts for each reformatting option, you can check this box so when ever 
you trigger your Text Tools shortcut it will ask you which type of reformatting youʼd like to do.
Text to Change pop-up list
• Selected Text – perform the desired reformatting on the text currently selected.
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• Text on Clipboard – perform the desired reformatting on the text currently held on the system clipboard.
Replace selected text with changed text / Leave changed text on clipboard 
These radio buttons let you tell QuicKeys to replace the selected text with the newly reformatted text, or you 
can choose to leave the original text in place and move the reformatted text to the clipboard.
Make applications accept insert 
Some applications are unaware of changes to the contents of the system clipboard, which can cause problems 
with insert operations. Selecting this option will force all applications to check with the system clipboard for 
any changes before inserting.
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Type Text & Password Vault
Create -> Text -> Type Text or Create -> Text -> Password Vault
The Type Text shortcut is great for quickly inserting often-used blocks of text, such as e-mail signatures or mailing 
addresses. Within multi-step shortcuts, Type Text often takes over your job of typing usernames or repeatedly filling 
out forms.
Password Vault differs from Type Text only in that it stores the text in a more secure way. By encrypting and hiding 
the text you enter, prying eyes can be kept away from any sensitive data you might want to place in a shortcut.

Figure 10-5. The Type Text Shortcut options

Type Text & Password Vault Options
• Text to insert/type – When you create this shortcut you must provide the text you want QuicKeys to insert or 

type for you.
• Check Spelling – Click the Check Spelling button to check the spelling of the text you entered.
• Insert Text – Select this option to Insert/Paste the text rather than have QuicKeys simulate typing it into your 

document. Inserting is faster but typing works where insert may not.
▫ Make applications accept insert – Some applications are unaware of changes to the contents of the system 

clipboard, which can cause problems with insert operations. Selecting this option will force all applications 
to check with the system clipboard for any changes before inserting.

• Type Text – Select this option to have QuicKeys simulate typing your text rather than using the insert method.
▫ Slow/Fast Typing Slider – The Type Text speed slider is used to adjust how fast QuicKeys types. If you 

are using an older machine or constantly working your G5 hard enough for the fans to be running at “leaf 
blower” speed, you may need to retard the speed at which QuicKeys tries to type so the system s̓ typing 
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buffer can keep up. This can be done by changing the slider in QuicKeys  ̓general preferences, or by 
changing the slider in any individual shortcut which types text.

Drag and Drop Functionality
• You can drag-and-drop a text selection from any application onto QuicKeys  ̓main editor window to instantly 

create a Type Text shortcut.
• You can drag-and-drop selected text into the Text to Insert/Type field as well.
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Chapter 11: User Actions

The shortcut types encompassed in this group generally mimic what a user does with their mouse dozens of times 
per day. Selecting menus, clicking buttons, and manipulating pop-up menus can all be handled by QuicKeys User 
Actions shortcuts instead; very useful as stand-alone shortcuts, and indispensable within multi-step shortcuts.

Button
Create -> User Actions -> Button
The Button shortcut clicks buttons, check boxes, and radio buttons that appear in windows and dialogs. Some 
buttons have common keyboard equivalents by default (Command+D for “Donʼt Save” and esc for “Cancel” for 
example), but many do not. For example, you can create a shortcut that clicks the “Add” button in a dialog when 
you press Control+A, or one that clicks the “Replace” button when you press Control+R.

Button Usage
The number of options available for finding the right button and manipulating it are somewhat daunting. Rather than 
starting by digging through a feature by feature listing of those options, it is better to get an overview of the Button 
shortcut; and what better way to do this than through a tutorial on how to create one? If you have not already worked 
through the Button tutorial on page 201 in Appendix G, doing would be a good idea.

Figure 11-1. Button Shortcut options

If you are not interested in going through the tutorial, it is highly recommended you let QuicKeys automatically 
create button clicks via the Set Button option rather than trying to do it by hand yourself. The typical procedure for 
this is as follows:

1. Bring up a dialog containing the button you want QuicKeys to push for you. (“Donʼt Save”, for example)
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2. Open the QuicKeys Editor and create a new Button shortcut.
3. Click on the Set Button... button in your new Button shortcut to bring up the Select Button window.
4. Hover your mouse over the desired target button, it should highlight, then tap your Caps Lock key to tell 

QuicKeys that this is the button you want and click OK.
5. QuicKeys gathers name and location information for the highlighted button; you may need to tweak this if 

your new Button shortcut proves to be either too specific or too generic for your needs.

Button Options
Set Button – automatically sets the coordinates of the target button, click Set Button... located at the bottom 
of the shortcut window. A Select Button window appears and each time your cursor hovers over a button, the 
button and accompanying text are highlighted. When the desired target button is highlighted, press the Caps 
Lock key to set the location and press the OK button in the Select Button dialog to save the button selection. If 
the desired item does not register a name, you may need to use the Location option.

Figure 11-2. Select Button window & Example of highlighted button

Find Button by Name – When you choose to have QuicKeys find the target button by its name, or build a by-
name shortcut by hand, this pop-up item will be selected and the Button Name field will display the targeted 
buttonʼs name. You can refine the button name QuicKeys searches for by selecting Is, Contains, Starts with or 
Ends with from the pop-up list.
As an example, the “Starts with” option is useful if youʼre looking to have QuicKeys press any button starting 
with a specific word but not necessarily containing the whole button name (The “Add <extension>” and “Use 
<extension>” buttons often show up in the Finder when changing extensions in file names and are prime 
examples for using the “Starts with” option).



161

Chapter 11 - User Actions

Find Button by Location – Some buttons, check boxes, and radio buttons simply do not identify themselves 
by name. If QuicKeys cannot pry the required information from the desired button, it will need to locate 
the button by its location on its window rather than by its name. You can enter the coordinates by hand, or 
populate the coordinate fields using the Set Button option to get the general coordinates and then edit the 
numbers as needed.
Ignore case – Click this checkbox if you want QuicKeys to ignore whether or not the button text contains 
upper or lower case letters.
Which button if multiple matches – Indicate which button you want QuicKeys to click if multiple buttons 
meet the button criteria you specified. For most shortcuts, “1” will remain the value of this field, but you may 
need to change the value if multiple buttons have similar names.
Press Button – Choose the conditions under which the Button shortcut operates:
• Always - QuicKeys selects the designated button regardless of whether it is on or off.
• When button is on - QuicKeys selects the designated button only when it is on.
• When button is off - QuicKeys selects the designated button only when it is off.

❖ Note: The standard button doesnʼt have an on/off state; this distinction is meant for checkboxes and radio 
buttons. For example, you could have QuicKeys only click on a check box if it is unchecked or “off”, thus 
preventing QuicKeys from un-checking the check box you wanted it to turn on.

Button Details - Window tab
To further refine your Button shortcut, click the Button Details button at the bottom of the shortcut window and 
choose the specifications for the window that will contain the target button.

Figure 11-3. Button Shortcut - Window Details options
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Window Type - Specify which interface element must be present for a particular shortcut to function properly.
• Any Window - QuicKeys will make designated selections in any window.
• Document Window - QuicKeys will only make designated selections in a document window. Document 

windows are typically application editing windows and Finder windows that display folder contents.
• Palette Window - QuicKeys will only make designated selections in a palette window. A palette is a floating 

window or toolbar that contains tools. For example, the Show View Options in the Finder displays a palette 
window.

• Sheet on Any Window - QuicKeys will only make designated selections in a sheet. Sheets slide down from 
the window title.

• Sheet on Document Window - QuicKeys will only make designated selections on sheets that slide out from 
a document window.

• Sheet on Palette Window - QuicKeys will only make designated selections on sheets that slide out from a 
palette. A palette is a floating window or toolbar.

• Drawer on Any Window - QuicKeys will only make designated selections on drawers. A drawer is a 
window that is attached to, or slides out of, another window.

• Drawer on Document Window - QuicKeys will only make designated selections on drawers that are 
attached to document windows. A drawer is a window that is attached to, or slides out of, another window.

• Drawer on Palette Window - QuicKeys will only make designated selections on palettes. A drawer is a 
window that is attached to, or slides out of, another window and a palette is a floating window or toolbar.

Identify Window by
• Main Window – If you choose Main Window from the pop-up list, QuicKeys will work with whichever 

window the front-most application considers to be its main window. This is almost exclusively the 
applicationʼs document window.

• Focused Window - If you choose Focused Window from the pop-up list, QuicKeys will work with the 
window which currently has focus. The key or focus window of an application is dynamic and can change 
depending on such factors as your mouse location, text insertion point, or tabbing around an application s̓ 
interface.

• Frontmost - If you choose Frontmost from the pop-up list, QuicKeys looks for the front-most window on 
your screen.

• Level - QuicKeys identifies window level from front to back, so Level 1 would be the front-most window. 
Depending upon the application and how it handles windows, you may have to tweak the window level 
when you use this shortcut option. For example, Photoshop identifies palettes as windows so you may need 
to experiment with window level for Photoshop shortcuts. 

• Name - If you choose Name, you must specify the window title that contains the target item. Choose to find 
the targeted window by selecting Is, Contains, Starts with or Ends with and then type the window name, or 
part of the window name, in the text field.

▫ Pop-up list:
- Is - Select Is when you want QuicKeys to find an exact match for the window name you provide in 

the text field.
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- Contains - Select Contains when you want QuicKeys to find a window name that matches part of 
the window name you provide in the text field.

- Starts with - Select Starts with when you want QuicKeys to find a window name that starts with 
the characters you provide in the text field.

- Ends with - Select Ends with when you want QuicKeys to find a window name that ends with 
characters you provide in the text field.

▫ Ignore case - Click the Ignore case checkbox if you want QuicKeys to ignore whether or not the 
window text contains upper or lower case characters.

▫ Which window if multiple matches - Indicate which window you want QuicKeys to use if multiple 
windows meet the criteria you specified. For most shortcuts, “1” will remain the value of this field, 
but you may need to change the value if multiple windows have similar names.

Button Details - Options tab
To further refine your Button shortcut, click the Button Details button at the bottom of the shortcut window, click the 
Options tab, and set the following specifications if so desired.

Figure 11-4. Button Shortcut – Options tab

Press Action:
• Tell Button to click itself - QuicKeys can direct the target button to activate itself instead of simulating a 

click. This method works even if the target button is obscured from view; if the button is partially or fully 
hidden by another window, using Tell Button to click itself will still work because QuicKeys is not trying to 
simulate a mouse click on the button.

• Click button - If the application you are targeting does not support the Tell button to click itself option, use 
the Click button option to simulate a click on the button.

▫ Modifiers - Select a modifier key to press while clicking the target button. Modifiers allow clicks to 
perform different functions.
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Clicks
Create -> User Actions -> Clicks -> Click
The Click and Multiple Clicks shortcuts enable you to mimic mouse click(s) with QuicKeys. These shortcut types 
are especially helpful when buttons, menus, and other interface objects wonʼt listen to QuicKeys and there is no 
keyboard equivalent for the item you want to select.
❖ Note: The shortcut types “Click” and “Multiple Clicks” might sound like they are differentiating between single-
clicking and double-clicking with the mouse, but both types of shortcut are capable of simulating single-clicks and 
double-clicks. The distinction between the two is made by how many locations are clicked in succession.

Using Click
Use click if you want QuicKeys to click on a single target item or location. This shortcut can simulate a single-click 
of the mouse, a double-click, or even three or more clicks. The Click point can be separately designated from the 
Release point, in effect creating a click and drag event. After all, when you click and drag by hand, you are simply 
clicking in one location, holding the mouse button down, dragging to another location, and releasing the mouse 
button. QuicKeys can do this as well.
For most Click shortcuts, you will either be asking QuicKeys to click one or more times on a specific location, or 
click and drag to resize a window or move an object. For an example of how to make a resize window Click, please 
refer to Chapter 3 of this manual. This tutorial is a great way to familiarize yourself with the Click shortcut; it is 
highly recommended that you at least read through it if you are new to the concepts of Click.

Figure 11-5. Click Shortcut window

Click Options
There are two basic ways to create a Click shortcut. One is to manually enter the coordinates for the Click point and 
the Release point. The other way is to let QuicKeys record those points for you.

Click Location and Release Location 
You can specify the horizontal and vertical coordinates where the Click shortcut will click and release relative 
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to the main display or a specific window. You can enter these coordinates manually or you can use the Set 
Location button to specify your coordinates.
Set Location... 
The Set Location button is used to auto-populate the coordinates of a Click shortcut. Click the Set Location 
button to display the QuicKeys Click Location dialog. The target icon appears when the Set QuicKeys 
Location dialog is open. Position the circle where you want QuicKeys to click. When the circle is positioned 
where you want the click to occur, press the Caps Lock key to lock the Click target into place. Then, click the 
OK button in the Set QuicKeys Click Location dialog to save the Click location.

Figure 11-6. The Set QuicKeys Click Location window

Set QuicKeys Click Location Options
• Set Location for - Choose from Click & Release, Click, and Release. If you choose Click & Release, 

QuicKeys will click and release at the same coordinates. If you choose Click you must choose the Release 
coordinates separately.

• Relative to - Choose from Display or Window. If you choose Display, coordinates are measured from a 
corner of the display. If you have multiple displays, the click location is set relative to the display in which 
the mouse is currently located. If you choose Window, coordinates are measured from a corner of the 
window. When a window is selected, the Click shortcut that is created will only be effective in the specified 
window.
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 ❖ Note: Clicks relative to windows do not work in Classic applications. The Classic environment does not 
present window position details and names to the Mac OS X environment, thus QuicKeys is also in the 
dark.

• Corner - Choose one of the four corners on the screen example to click relative to the display/window from 
the specified corner. By default, the coordinates are measured from the upper left corner of the display or 
window. In some cases, it may be preferable to set the coordinates relative to a different corner.

Details – the Click and Release Tabs
Click the Details button in the Click shortcut Editing window to further refine your Click shortcut. In the Click and 
Release tabs, you can fine-tune the Horizontal and Vertical coordinates of your click and choose whether the click 
will use the entire Display or the specified Window as its reference for the defined coordinates.

Figure 11-7. The Click Details window

Click relative to - Choose to have QuicKeys click relative to the entire Display, a specific Window, or the Mouse 
location at the time the shortcut is triggered.

Mouse 
If you choose to click relative to the Mouse, you are telling QuicKeys to click wherever the mouse cursor 
happens to be when you trigger the Click shortcut. A good example of a time when you might want to use 
Click relative to: Mouse is when you have to repeatedly hold a difficult set of modifier keys while clicking on 
an object. Rather than pretzel your fingers, you can simply hover your mouse over the target and hit a hot key 
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trigger. QuicKeys can click the mouse and simulate holding down any combination of modifier keys in the 
process.
Display 
If you choose to click relative to the Display, the Horizontal and Vertical coordinates are referenced from one 
of the corners of your display, as chosen by you. This option is useful if you are needing to click an item which 
is outside of an identifiable window and always in the same place relative to one of the corners of your display, 
such as the Apple menu icon.
Window 
If you choose to click relative to a specific window, QuicKeys provides a plethora of options so you can be as 
precise as possible in choosing the correct window.

Type - Specify which window element must be present for a particular shortcut to function properly.
• Any Window - QuicKeys will make designated selections in any window.
• Document - QuicKeys will only make designated selections in a document window. Document 

windows are typically application editing windows and Finder windows that display folder contents.
• Palette - QuicKeys will only make designated selections in a palette window. A palette is a floating 

window or toolbar that contains tools. For example, the Show View Options in the Finder displays a 
palette window.

• Sheet on Any Window - QuicKeys will only make designated selections in a sheet. Sheets slide down 
from the window title.

• Sheet on Document - QuicKeys will only make designated selections on sheets that slide out from a 
document window.

• Sheet on Palette - QuicKeys will only make designated selections on sheets that slide out from a 
palette. A palette is a floating window or toolbar.

• Drawer on Any - QuicKeys will only make designated selections on drawers. A drawer is a window 
that is attached to, or slides out of, another window.

• Drawer on Document - QuicKeys will only make designated selections on drawers that are attached 
to document windows. A drawer is a window that is attached to, or slides out of, another window.

• Drawer on Palette - QuicKeys will only make designated selections on palettes. A drawer is a window 
that is attached to, or slides out of, another window and a palette is a floating window or toolbar.

Identify by
• Main Window – If you choose Main Window from the pop-up list, QuicKeys will work with 

whichever window the front-most application considers to be its main window. This is almost 
exclusively the applicationʼs document window.

• Focused Window - If you choose Focused Window from the pop-up list, QuicKeys will work with the 
window which currently has focus. The key or focus window of an application is dynamic and can 
change depending on such factors as your mouse location, text insertion point, or tabbing around an 
applicationʼs interface.

• Frontmost - If you choose Frontmost from the pop-up list, QuicKeys works with the front-most 
window on your screen.

• Level - QuicKeys identifies window level from front to back, so Level 1 would be the front-most 
window. Depending upon the application and how it handles windows, you may have to tweak 
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the window level when you use this shortcut option. For example, Photoshop identifies palettes as 
windows so you may need to experiment with window level for Photoshop shortcuts. 

• Name - If you choose Name, you must specify the window title that contains the target item. Choose 
to find the targeted window by selecting Is, Contains, Starts with or Ends with and then type the 
window name, or part of the window name, in the text field.
 ▫ Name Is - Select Is when you want QuicKeys to find an exact match for the window name you 

provide in the text field.
 ▫ Name Contains - Select Contains when you want QuicKeys to find a window name that matches 

part of the window name you provide in the text field.
 ▫ Name Starts with - Select Starts with when you want QuicKeys to find a window name that 

starts with the characters you provide in the text field.
 ▫ Name Ends with - Select Ends with when you want QuicKeys to find a window name that ends 

with characters you provide in the text field.
• Ignore case - Click the Ignore case checkbox if you want QuicKeys to ignore whether or not the 

window text contains upper or lower case characters.
• Which window if multiple matches - Indicate which window you want QuicKeys to use if multiple 

windows meet the criteria you specified. For most shortcuts, “1” will remain the value of this field, 
but you may need to change the value if multiple windows have similar names.

Corner - Click and Release locations are relative to the corner of the window chosen here. For example, if 
you wanted to  resize a window you'd want to click relative to the bottom right corner of the window where 
the resize control is. Alternately, if you wanted your click to move a window by its title bar, you'd need to 
set the Corner to either top left or top right.
Click/Release Delay - If you want QuicKeys to pause during a click, specify how long you want the delay 
to last in the Delay after Click or Delay before Release field of the Click or Release tabs. This option slows 
QuicKeys down to adjust to the response time of your application or system. It is not necessary to add a 
delay in both the Click and Release tabs; this field appears in both locations simply for your convenience.
Synchronize - Clicking the Set Release to Click Settings button in the Click tab will copy the settings you 
specified in this Click tab into the Release tab. Conversely, if you click the Set Click to Release Settings in 
the Release tab it will copy the settings you specified in the Release tab into the Click tab. This is helpful if 
you manually make several changes in one tab or the other and want to quickly copy those changes to the 
other tab.
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Details - Options Tab
You can further customize a Click shortcut by adjusting behavior such as which button to click with, the number of 
clicks, and modifier keys to press during the click operation.

Figure 11-8. The Click Options tab

Click with - Choose the mouse button the Click shortcut will use when it is played. For example, if you have 
a multi-button mouse and you click the center mouse button to be clicked, defining a Center click in QuicKeys 
will mimic this action. Choose from Left, Center or Right mouse buttons.
Do not release - Choose the Left, Center, or Right checkboxes if you do not want QuicKeys to release the 
click. You can use this option if you want QuicKeys to release the click under different coordinates as part of a 
multi-step shortcut.
❖ Note: If you use this option in a multi-step shortcut and you do not set up a second step for release 
coordinates, QuicKeys will reset your mouse so the click is released for the next playback.
Modifiers - Modifiers keys allow clicks to perform additional functions depending on the application you are 
using. Choose from any combination of the Command, Option, Shift and Control keys.
Clicks - The mouse will click a specified number of times in the same place. For example, you can use 
this option to mimic a double-click by setting Clicks to 2, or if you only want to move the mouse without 
performing a click, set this option to 0.
Bring all windows to front for click - Selecting this option makes all open windows active for Click 
shortcuts. This ensures any hidden windows are made available for clicking.
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Restore mouse location after click - The cursor will move to the original location if you choose this option. 
Uncheck this option to leave your mouse at the release point when the Click finishes.
Drag duration - Specify the number of seconds between the click and release. This feature slows QuicKeys 
down to adjust to the response time of your application or system.
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Multiple Clicks
Create -> User Actions -> Clicks -> Multiple Clicks
The Multiple Clicks shortcut automatically creates a multi-step shortcut consisting of a series of Click steps. Each 
Click step corresponds to a click location designated when you create the Multiple Clicks shortcut, and can be edited 
just like any Click shortcut.

Multiple Clicks Usage
When you create a Multiple Clicks shortcut, the Set QuicKeys Clicks Location window immediately appears with 
instructions on how to proceed. Move your cursor to the click locations you want to set, pressing the caps lock key 
to set each click point. A black donut with a number below it appears, tracking the order of your click locations. 
Hit the OK button in the Set QuicKeys Click Locations dialog to stop designating click points; QuicKeys will 
automatically create a shortcut consisting of multiple Click steps for the locations you set with your caps lock key.

Figure 11-9. Multiple Click points

❖ Note: You can delete a target icon by Control+clicking it and selecting Delete Location.
When you set your click points, QuicKeys records them as single click and release actions relative to your display. 
If you need to do anything more elaborate, you will either need to edit the steps QuicKeys created for you, or hand 
build a series of Click shortcuts. 
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Menus
The Menus shortcut category is intended to free you from having to take your hands off of the keyboard and 
repeatedly use your mouse to select menus. Most application menus communicate their contents to the operating 
system, which allows QuicKeys to activate menus by simply calling their name. Some applications, however, do 
not provide sufficient information about their menus to the operating system, so QuicKeys must resort to simulating 
actual clicks on those menus.
To these ends, QuicKeys contains two menu shortcut types: Menu Selection - for those well behaved menus which 
can be called by their names, and Menu Clicks for those not-so-friendly applications needing simulated clicks to 
operate their menus.

Menu Selection
Create -> User Actions -> Menus -> Menu Selection
When you create a Menu Selection shortcut, you have the option of hand typing the menu name and menu item 
directly into the fields provided. This is a quick way to build the shortcut if you know exactly which menu you want. 
You can click on the corresponding Details button to further refine your selection.

Using Menu Selection
As mentioned above, Menu Selection is the most powerful type of shortcut for manipulating menus. Not only can it 
select the desired menu item, it can instead be set up to check the state of that menu. In other words, QuicKeys can 
look at a menu item and evaluate properties such as “is the menu item checked?” or “is the menu item enabled.” The 
results of these tests can be used with Step Results to add logic to your multi-step shortcuts.

The Menu Action pop-up list
The Menu Action pop-up list defaults to “Select Menu”, but can be changed to “Check for Menu” or “Wait for 
Menu.” Each of these methods gives the same options, so the difference in their behavior will be explained first, and 
the options available to them all will follow.

• Select Menu - Choosing this option creates a shortcut that will try to select the menu item you have specified 
in the Menu and Menu Item fields.

• Wait for Menu - Choosing this option creates a shortcut that will pause the playback of a multi-step shortcut 
until certain attributes of the desired menu item meet the conditions you specify. For example, assume you 
have built a multi-step shortcut that needs to wait for a web page to load in Safari before continuing to the next 
step. Rather than put in a hard pause which will be imprecise, use a Wait for Menu shortcut to keep an eye on 
the “View -> Stop [loading]” menu item in Safari. This menu item is always active while the current page is 
loading, so just have QuicKeys wait until that menu item is inactive (grayed out) before continuing.

• Check for Menu - Choosing this option creates a multi-step shortcut step that will evaluate the state of a 
menu item. The results of this test can be used within Step Results to add logic to the shortcut. This is covered 
in more detail on page 101 in the Decision shortcut section.

 ❖ Note: Step Results can be found at the bottom of any shortcut or step editing window. You can control 
QuicKeys  ̓reaction to the reported success or failure of any shortcut step with this feature. For more 
information on how to use Step Results, see the writeup on page 34 and the tutorial on page 37.
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Figure 11-10. Select Menu options

Select Menu Options
Displaying Additional Submenus
You can click the (+) button in the Menu Selection editing window if you want to specify additional submenus 
for your shortcut. Click the (-) button to delete the submenu. This allows you to create Menu Selections as 
deeply into submenu hierarchies as desired.
The Choose Menu... Button
Clicking the Choose Menu... button starts QuicKeys searching through your running applications for all menus 
and all items in those menus. (This small bit of programmer voodoo is necessary because the operating system 
has no idea whether or not any particular menu item exists unless you actually, or virtually, click on that menu, 
after which it promptly forgets again.)
Once this list of available menu items is collected and presented by QuicKeys, select the desired application 
from the pop-up list. Then select the desired menu item from the target applicationʼs menu bar at the top of 
your screen as you normally would. QuicKeys records this selection into the Menu and Menu Item fields of 
the shortcut.
❖ Note: Some applications may provide QuicKeys one set of menus when a shortcut is created, but display 
another set upon playback. If the menu item you need is not presented by QuicKeys, you will need to type the 
menu itemʼs name manually.
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Figure 11-11. Select Menu window

Checked: pop-up  
Often you will see menu items that have a check mark beside them when their associated function is active. 
For example, the View menu in Safari shows a check mark beside all of the view options that are currently 
active. You can test for this with the Checked pop-up list, telling QuicKeys that a check mark is or is not 
required, or that you do not care either way.
Exists: pop-up list 
QuicKeys can test for the existence of the specified menu or menu item within a multi-step shortcut. The 
results of this test will determine whether or not QuicKeys reports this step as passing or failing. Step Results 
can be configured with this pass/fail result in mind. For example, if the desired menu item does not exist, the 
“If step fails” Step Result can be configured to jump back to an earlier step in your multi-step shortcut.
Enabled: pop-up list 
This option works exactly like the Exists option above, except it tests to see if a specific menu or menu item 
not only exists but is enabled or disabled. Disabled menu items are listed in gray, rather than black. For 
example, if the desired menu item is not enabled, the “If step fails” Step Result can be configured to jump 
back to an earlier step in your multi-step shortcut.
Show menus while performing menu action 
This option usually does not need to be turned on for a Select Menu shortcut. However, some applications do 
not build their menus until you click on them with your mouse, and they cease to exist once they close. This 
means QuicKeys will have to actually open the desired menu to get it to draw its contents and make them 
accessible. Also, it is usually impossible to test a menu item to see if it exists, is checked, or is enabled unless 
its menu is open. For this reason, this option will have to be checked for almost every Wait for Menu and 
Check for Menu shortcut you build.
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Perform as alternate menu action (option key) 
Some menu items change their names if you open the menu and hold down your option key (open Safari s̓ 
File menu and depress the option key, you should see Close Window change to Close all Windows). With this 
option checked, QuicKeys simulates pressing the option key while sending the menu selection command.
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Menu/Menu Item Details
You can further refine how this menu selection behaves by clicking the Details... button next to any Menu, Submenu, 
or Menu Item field. Some menus have odd characters in them that make automatic identification of the target menu 
difficult; the options in Details allow you to modify or remove some of the parameters to make playback of the 
shortcut more reliable.

Figure 11-12. Menu Details

Identify by:
• Name Is - QuicKeys must find a menu, submenu or menu item that matches exactly with the text youʼve 

entered.
• Name Contains - The text you entered must match some, but not all, of a menu, submenu or menu item s̓ 

name.
• Name Starts with - The text you enter must match the first few characters of the menu, submenu or menu 

item in question.
• Name Ends with - The text you enter must match the last few characters of the menu, submenu or menu 

item in question.
• Position - If you select Position, you must indicate the number that represents the position of the target 

menu, submenu. The Apple menu is menu #1, the application menu  is #2, and so on. For example, use 
menu position of 1 and menu item position of 2 when you want QuicKeys to choose Software Update from 
the Apple menu. Keep in mind that menu separators are counted as menu items in the position count. For 
example, in the QuicKeys File menu, Save shortcut looks to be the second menu item, but the separator 
above actually makes it number 3.

Ignore case 
QuicKeys will ignore case when comparing your text to that of a Menu, Submenu, or Menu Item.
Which menu if multiple matches 
Some Menus or Menu Items may appear twice. Use this field to designate which one QuicKeys should 
activate.
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Menu Clicks
Create -> User Actions -> Menus -> Menu Clicks
Menu Clicks shortcuts select menus by making a series of clicks. In some applications, it is simply impossible to 
access a menu by its name and so QuicKeys must resort to clicking just like a user would, only faster and with no 
risk of getting a Repetitive Stress Injury.

Creating a Menu Clicks Shortcut
1. Select Create -> User Actions -> Menus -> Menu Clicks. The Set QuicKeys Menu Click Locations window 

appears.
2. Switch to the application that contains the menu item you want to select.
3. Click the menu title so that the desired menu opens.
4. Press the Caps Lock key to set the first click location. A target icon appears at the mouse location. This tells 

QuicKeys to click at that spot to open the menu.
5. With the desired menu still open, move the mouse to the desired menu item or submenu and press the Caps 

Lock key again. Another target icon appears at the second mouse location.

Figure 11-13. Menu Click

6. Repeat this process until you select the desired menu item.
 ❖ Note: You can move a target icon by clicking and dragging it. You can also delete a target icon by 

Control+clicking it and selecting Delete Location.
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Figure 11-14. Menu Click Locations

Press the OK button when you are finished, QuicKeys will create a new shortcut consisting of Click type 
shortcut steps. For each menu click location you set, a Click step is created. These Click steps are the same 
steps youʼd create manually if so desired, and can be edited and tweaked as needed.
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Mouse Recording
Create -> User Actions -> Mouse Recording
QuicKeys makes two methods of recording your actions available to you. One is interpretive, following your actions 
and building a sequence of shortcut steps as it interprets what you are doing. This interpretive method is discussed 
on page 45 of Chapter 2. The other Recording method is the Mouse Recording shortcut that records exactly what 
your mouse, and only your mouse, is doing. This is useful if you are working with an application where specific 
interface elements only respond to mouse clicks.
❖ Note: While actively recording, a blinking red record button appears over the QuicKeys Dock icon.

Mouse Recording Options
This section describes the shortcut-specific options available with the Mouse Recording shortcut. The usage of this 
shortcut is very simple, thus are the options. You can Record your mouse actions, delete or clear those recorded 
actions, or record additional mouse actions.

Figure 11-15. Mouse Recording Options

Record 
Click the Record button to display the Ready for Mouse Recording dialog. Press the Caps Lock key to begin 
mouse recording. When you are finished recording, press the Caps Lock key again. The Mouse Recording 
shortcut Editing window appears.
You canʼt see information about your recording session, but you will see two buttons (Record More and Clear 
Recording) that only appear when a recording already exists.
Record More 
Click the Record More button to add to your recording. This allows you to build a complex mouse recording 
in bursts rather than all at once.
Clear Recording 
Click Clear Recording to delete the contents of the recording shortcut.
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Pop-Up Menu
Create -> User Actions -> Pop-Up Menu
The Pop-up Menu shortcut is used to select pop-up menu items from various windows and dialogs. It is flexible in 
that it can locate pop-up menus by their name or by their location on a window.

Pop-Up Menu options
Building a Pop-Up Menu shortcut requires that QuicKeys be able to identify the desired pop-up menu either by 
its name or by its location on a window. Finding the correct pop-up by name is dependent on whether or not the 
target application is telling the operating system the location. If the application doesnʼt report this information to the 
operating system, QuicKeys has no access to it either. In these cases you will need to locate the desired pop-up menu 
by its location.

Figure 11-16. Pop-up Menu options

Find Pop-up Menu by Name or Location 
Finding the desired pop-up menu in this type of shortcut is done in the exact same way one would tell 
QuicKeys to find a button in a Button shortcut. Rather than waste a tree by explaining it again here, please see 
page 160 for an explanation of how to tell QuicKeys to find an object by name or by itʼs location.
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Select Menu Item by 
Much like the Menu Selection shortcut, the Pop-up Menu shortcut can select Menu Items by their name or 
position. This follows exactly the same set of rules as found on page 173 in respect to selecting menus, please 
look there for details.
Ignore case 
QuicKeys will ignore case when comparing the item name in your shortcut to that of the menu item.
Which menu if multiple matches: 
Some Menu Items may appear twice. Use this field to designate what one QuicKeys should activate.
Set Pop-up Menu button 
To auto-populate the Pop-up Menu "Name" field, click the Set Pop-up Menu button located at the bottom of 
the shortcut window. The Select Pop-Up Menu window appears and each time your cursor nears a pop-up 
menu, that menu will be highlighted. When the desired menu is highlighted, press the Caps Lock key to set 
the location and click the OK button to save the Pop-up Menu selection. For additional information on the Set 
Pop-up Menu options, see “Set Button” on page 160.

Figure 11-17. Select Pop-up Menu options

Pop-up Menu Details - Window tab 
To further refine your Pop-up Menu shortcut, click the Pop-up Menu Details button. Choose the specifications 
for the window that will contain the target menu. You can choose document windows, palettes, sheets and 
drawers from the Window Type pop-up list. See “Window Type” on page 161 for more information on the 
Window Type options. For information on the options in the Identify Window by pop-up list, see “Identify 
Window by” on page 162.
Pop-up Menu Details - Options tab 
Use the Options tab to choose modifier(s) to press while selecting the target pop-up menu. Modifier keys allow 
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interface elements to perform additional functions depending on the application you are using. Choose from 
any combination of the Command, Option, Shift and Control keys.
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Scroll Wheel
Create -> User Actions -> Scroll Wheel
The Scroll Wheel shortcut enables you to create shortcuts that simulate the scroll wheel on a mouse, even if you 
donʼt have a scroll wheel. If an application supports scroll wheel input in some way, a Scroll Wheel shortcut can 
fill that role. This goes beyond simply scrolling a web page up and down. Some applications make use of the scroll 
wheel for zooming or for volume control for example. These are fair game for QuicKeys and the Scroll Wheel 
shortcut.

Scroll Wheel options
Where you can designate attributes such as which Scroll Wheel to use, Scroll Direction, Scroll Speed, and keyboard 
Modifiers to apply.

Figure 11-18. Scroll Wheel options

Scroll Wheel Pop-up List 
Most users will use Wheel 1 to simulate the scroll wheel commands. However, there are applications, such as 
CAD programs, that support multiple scroll wheels. Users who have up to three scroll wheels at their disposal 
can specify which they intend to use in each Scroll Wheel shortcut.
Scroll Direction 
Indicate whether you want the Scroll Wheel shortcut to scroll Up/Left or Down/Right. Up/Left and Down/
Right are paired up on radio buttons; to differentiate between the two you would select the “Shift/Horizontal 
Scroll” Modifier. For example, scrolling to the left with a scroll wheel is accomplished by holding the shift key 
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and moving the scroll wheel upward. To emulate this with QuicKeys, the Scroll Direction option would be set 
to “Up/Left” and the Modifier option would be set to “Shift”.
Scroll Speed 
Use the slider to set how fast QuicKeys translates the speed of the scroll wheel actions for the application.
Modifiers 
Modifiers allow scroll wheels to perform different functions. Choose from any combination of the Command, 
Option, Shift and Control keys. Select Shift/Horizontal Scroll when you want to scroll horizontally (from left 
to right). 
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Type Keystroke
Create -> User Actions -> Type Keystroke
Type Keystroke is one of the simplest yet one of the most versatile shortcuts QuicKeys provides. You can remap 
almost any key combination, including modifier keys, but its uses go way beyond changing your keystrokes. Think 
about what you do with your keyboard each day... you hit the Enter key to acknowledge OK buttons, you use the 
escape key to cancel dialogs, you hit key combinations to activate menu items (like ⌘S to Save), you use arrow 
keys to navigate lists; the keyboard is most peoples  ̓primary input device. Being able to remap keys and emulate 
keyboard actions within multi-step shortcuts is thus a very important part of what QuicKeys can do to help automate 
your daily tasks.

Type Keystroke Options
Keystroke field 
When you create a Type Keystroke shortcut, the Keystroke field must be active to enter a key or key 
combination. Click in that field to make it active. When the Keystroke field is active, all QuicKeys hot key 
triggers are turned off. This ensures that you donʼt unintentionally play a shortcut while you are trying to 
assign a keystroke.

Figure 11-19. Type Keystroke Shortcut window
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Keys pop-up list 
There are some situations where it is impossible to enter the desired keystroke into the Keystroke field. For 
example, a key on your keyboard may not be readable by QuicKeys, or you may be using a smaller keyboard 
that is actually missing some keys that your larger keyboard has. For these types of issues, you can select the 
keystroke you want QuicKeys to send via the Keys pop-up menu. The upper half of this menu contains the 
keys you can have QuicKeys press, while the bottom half is a list of modifier keys which can be toggled on 
and off by selecting them.

Figure 11-20. Type Keystroke - Keys pop-up options
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Windows
Create -> User Actions -> Windows
The Windows shortcut Type is useful for controlling the appearance and behavior of the windows that appear on 
your screen.

Windows options

Figure 11-21. Windows Shortcut options

• Close - The Close option will close the specified window.
• Minimize - The Minimize option will collapse the specified window to the Dock. You can reopen the window 

by selecting it from the Dock or by using an Unmiminize Windows shortcut.
• Unminimize - The Unminimize option will display a window that has been minimized.
• Zoom—The Zoom option changes the size of the specified window.
• Toggle Toolbar—Use the Toggle Toolbar option to show/hide the toolbar of a window.

Window Details
To further refine your Windows shortcut, click the Window Details... button. You can choose options from the 
Window Type and Identify by pop-up menus, or the Window Action and Modifiers options.
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Figure 11-22. Window Details

Window Type
• Any Window - QuicKeys will make designated selections in any type of window.
• Document - QuicKeys will only make designated selections in a specific document window. Document 

windows are typically application editing windows and Finder windows that display folder content.
• Palette - QuicKeys will only make designated selections in a specific palette. A palette is a floating window 

or toolbar. For example, the Show View Options in the Finder displays a palette window.
• Identify by - See “Identify Window by” on page 162 for information on the options in the Identify by pop-

up list.
Window Action 
Select Tell Window to do action itself when you want QuicKeys to direct the window to perform the specified 
action. Using this method to complete window actions is more reliable. For example, if the window is partially 
hidden by another window, using Tell Window to do action itself will still work because it doesnʼt matter that 
the window is partially obscured. In contrast, if you try to simulate a click in a window action, it might fail 
since the button is partially obscured. If you are trying to use the Windows shortcut type and it doesnʼt work, 
use “Click to perform action” to simulate the window commands.
Modifiers
Modifiers are the keys the Windows shortcut can use in combination with window actions. For example, 
holding your Option key while you click the minimize button on a Finder window will hide all Finder 
windows in the Dock. QuicKeys can simulate holding these modifier keys while doing window actions.
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Appendix A

AppleScript & QuicKeys
QuicKeys can be directed to play a shortcut by its name using AppleScript. QuicKeys can also be directed to set or 
get variables with AppleScript. The AppleScript code must be written in the following ways to make these things 
happen.

• Play shortcut by name 
The following three lines of script tell QuicKeys to play the shortcut named “Open TextEdit”. Any shortcut 
name can be substituted.

tell application “QuicKeys”
 play shortcut named “Open TextEdit”
end tell

• Set variable 
The following three lines of sample script set the value of a QuicKeys variable named “QKVariable” to the 
value of “something”. You can use any variable name you like. Data passed into QuicKeys may or may not be 
usable directly by Decision, Wait, or other logic tests, it depends on the data type passed in.

tell application “QuicKeys”
 set value of variable named “QKVariable “ to “something”
end tell

• Get variable 
The following three lines of sample script set the value of an AppleScript variable named “ASVariable” to the 
contents of a QuicKeys variable named “QKVariable”. You can use any variable names you like. Data passed 
into QuicKeys or set within QuicKeys can be retrieved by AppleScript in this way.

tell application “QuicKeys”
 set ASVariable to the value of variable named “QKVariable”
end tell

Appendices 191
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Appendix B

Remotely Trigger QuicKeys Shortcuts with Apple Events
Remote Apple Events and AppleScript can be used to trigger a QuicKeys shortcut residing on a remote machine. For 
example, while working on machine A, you can trigger a QuicKeys shortcut on machine B.

Preparation
You must prepare the remote/target machine in advance to accept these types of events by doing the following:

• Open System Preferences
• Select the Sharing pane, Services tab.
• Check the box named “Remote Apple Events” to turn on this feature

Play remote shortcut by name
tell application “QuicKeys” of machine “eppc://xxx.xxx.xxxx.xxx”

playshortcut named “Shutdown”
end tell

... where xxx.xxx.xxx.xxx is the IP Address of the target machine. Running/compiling this script should bring up a 
window asking for username and password for the remote machine with the option to “add to keychain”. Once the 
login and password information is accepted the shortcut on the remote machine should activate.

Usage
You can put AppleScript code like this into a QuicKeys X3 AppleScript type of shortcut, or save it as an AppleScript 
applet.
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Appendix C

Backing Up Your QuicKeys Data
QuicKeys maintains your shortcuts, toolbars, and clips in one location and your preferences settings in another. You 
can drag these items to a second hard drive, a network storage location, or burn them to a CD to back them up. They 
can easily be restored by copying them back to their original locations.

Backing up your QuicKeys data
1. Quit the QuicKeys X3 application.
2. Navigate to <user>/Library.
3. Locate the QuicKeys folder inside and copy it to your backup location.

Backing up your QuicKeys preferences
1. Quit the QuicKeys X3 application.
2. Navigate to <user>/Library/Preferences.
3. Locate “com.quickeys.quickeys.plist” and copy it to your backup location.
4. Locate “com.quickeys.quickeysbackgroundengine.plist” and copy it to your backup location.

Restoring your QuicKeys data
1. Quit the QuicKeys X3 application.
2. Copy your archived QuicKeys folder into <user>/Library.

❖ Note: Overwriting one QuicKeys data folder with another will destroy all of the shortcut data in the folder being 
overwritten. If you need to merge archived shortcut data with current shortcut data, use the methods discussed in 
Appendix D, Sharing Shortcuts.

Restoring your QuicKeys preferences
1. Quit the QuicKeys X3 application.
2. Copy your archived QuicKeys preferences files into <user>/Library/Preferences.

❖ Note: Restoring your QuicKeys X3 preferences file will not restore your activation code. If youʼve done a fresh 
reinstall of your operating system or if you are moving your data to a new machine you will need to reenter your 
activation key.
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Sharing Shortcuts
QuicKeys stores your shortcuts in the folder <user>/Library/QuicKeys/Shortcuts. Each new shortcut is saved in this 
location as a separate file whose name matches the name you gave the shortcut. If you remove a shortcut file from 
this folder, the next time you run QuicKeys that shortcut will not load.
Conversely, if you drag additional shortcut files (or folders containing shortcut files) into that folder, those shortcuts 
will be available next launch. You can also share shortcuts by exporting and importing them, or subscribe to folders 
full of shortcuts placed on public file servers and shared drives.

Using other people’s shortcuts
There are three methods to get other users  ̓shortcuts to load into QuicKeys:
Install shortcut files 
This is a simple, manual method for installing shortcut files. QuicKeys must be quit and launched again for the new 
shortcuts to become available for use.

1. Quit the QuicKeys X3 application.
2. Copy or move the new shortcut files or folders containing shortcut files into <user>/Library/QuicKeys/

Shortcuts
3. Launch QuicKeys to see your new shortcuts, complete with their original triggers.

Import shortcuts 
Shortcuts that have been exported from QuicKeys can be imported by another user. Importing makes the new 
shortcuts immediately available, no re-launch required.

1. From within QuicKeys X3, select the menu item, File -> Import Shortcuts.
2. Navigate to a QuicKeys export file and click Open.
 ❖ Note: You cannot import raw shortcut files, you can only import shortcuts that were exported into a 

QuicKeys export file. If you are working with raw shortcut files, use the Install shortcut files method above.
3. Your new shortcuts are ready to use, no re-launch of QuicKeys required.

Subscribe to public shortcuts 
If you have access to a file server or shared workstation whose owner has made QuicKeys shortcuts available to the 
public or selected users, you can easily subscribe to those shortcuts.

1. Log into the server or workstation that is home to the repository of shortcuts to which you want to subscribe. 
You need to be able to navigate to the target folder to be able to subscribe to it.

2. From within QuicKeys select Subscribe to Shortcuts from the File menu. In the resulting window, click on the 
[+] button to add a new location from which to load shortcuts.

3. Navigate to the folder containing the shared shortcuts and click Open. Any shortcuts in that folder, or inside 
other folders located inside the target folder, will be loaded into QuicKeys for your use.

❖ Note: Subscriptions to shortcuts are not live. QuicKeys X3 loads the shortcuts from the designated location at 
only two times: 1) when you subscribe, and 2) when you quit and re-launch QuicKeys. If the owner changes the 
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shortcuts in a folder to which you have subscribed, your copy of QuicKeys will not update with the new shortcuts 
until you either quit and re-launch QuicKeys, or unsubscribe and subscribe to that shared folder again.

Making your shortcuts available to others
There are three ways to share your shortcuts with other users:
Distribute your shortcut files

1. Locate your shortcuts in the <user>/Library/QuicKeys/Shortcuts folder and copy any that you want to share 
out to another location.

2. Pass these copies on to whoever you wish.; they will need to follow the Installing shortcut files instructions 
found earlier in this appendix.

Export your shortcuts
1. Within the QuicKeys Editor, highlight the shortcuts you want to export in the shortcuts list and select File -> 

Export Shortcuts.
2. Navigate to the desired destination and click the Save button.
3. Pass this exported file on to anyone you wish; they will need to follow the Importing shortcuts instructions 

found earlier in this appendix.
Make your shortcuts public

There is no mechanism within QuicKeys to enable file sharing or act as a shortcut server per se. What 
QuicKeys can do however, is subscribe to shortcuts that are outside of its default <user>/Library/QuicKeys/
Shortcuts folder.
To make your shortcuts available to the public you need only move copies of your shortcut files to an 
accessible location. Be it a file server or a shared location on your workstationʼs hard drive, if users are 
allowed to log in and access that location, their copy of QuicKeys can load shortcuts from it.
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Appendix E

Read/Write Permissions & QuicKeys Shortcuts
QuicKeys X3 has the ability to load shortcuts from numerous sources outside of its default data location. QuicKeys 
must, like any other application, obey the Read/Write permissions of the user that logged in. For example, if you 
have subscribed QuicKeys to a public folder where your user name and password only grant you Read permissions, 
you will be able to edit, but will not be able to save those shortcuts.
❖ Note: QuicKeys will always try to write an edited shortcut back along the path from which it was loaded. New 
shortcuts are always saved to <user>/Library/QuicKeys/Shortcuts. These behaviors cannot be altered.

Shortcut file permissions effects:

Permissions Load & Run Shortcuts? Edit Shortcuts? Save Shortcuts?

Read Only Yes Yes ❖ No
Read & Write Yes Yes Yes

❖ Note: Editing shortcuts loaded with Read-only permissions caches the changes within QuicKeys, but those 
changes will be lost when QuicKeys is quit.

Read-only permissions for all shortcuts
Some administrators may find it desirable to prevent users from editing or creating new shortcuts at all times. This 
can be accomplished by setting the QuicKeys shortcut data folder to Read-only.

Symbolic linking
The QuicKeys shortcut data folder can be replaced with a symbolic link using the Terminal application if so desired.
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Descriptions of the Preloaded Shortcuts
When you first install and run QuicKeys X3 it will automatically preload a default set of shortcuts if you are a new 
user of the product and have no shortcuts already in place. Feel free to edit and explore these shortcuts, change their 
hot keys and triggers as you like.

Figure F-1. List of Preloaded shortcuts, Part 1
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Figure F-2. List of Preloaded shortcuts, Part 2

❖ Note: These default shortcuts are also available on the QuicKeys X3 CD and Disk Image as an exported 
Shortcuts file. This file can be found at /Extras/Default Shortcuts and will need to be imported.
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Alphabetical Listing - Part 1

Shortcut Name Type Trigger Explanation

Clips 
Gather\Manage Clips ⌃C

Pressing Control+C will copy selected text or 
graphics into your Clips collection. You can 
also delete & rename Clips here.

Clips 
Insert\Type Clips ⌃V

Pressing Control+V will open your Clips 
collection letting you choose which clip to 
insert or type into your document.

Hide Front 
Application Computer F1

Pressing F1 hides the front-most application.

Hide Other 
Applications Computer F2

Pressing F2 hides all but the front-most application.

iTunes 
Next Track AppleScript ⌃⇢

Pressing Control+Right Arrow tells iTunes to skip to 
the next track.

iTunes 
Previous Track AppleScript ⌃⇠

Pressing Control+Left Arrow tells iTunes to skip to the 
previous track.

iTunes 
Stop\Play AppleScript ⌃Spacebar

Pressing Control+Spacebar tells iTunes to toggle 
playing of current song on/off.

iTunes 
Volume Up AppleScript ⌃⇡

Pressing Control+Up Arrow tells iTunes to turn its 
volume up independently of your overall system 
volume setting.

iTunes 
Volume Down AppleScript ⌃⇣

Pressing Control+Down Arrow tells iTunes to turn its 
volume down.

Open 
Address Book Open Items ⌃O, A, B

Pressing Control+O then pressing A and B in sequence 
will open the Address Book application.

Open 
Calculator Open Items ⌃O, C, A

Pressing Control+O then pressing C and A in sequence 
will open the Calculator application.

Open iCal Open Items ⌃O, I, C
Pressing Control+O then pressing I and C in sequence 
will open the iCal application.
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Alphabetical Listing - Part 2

Shortcut Name Type Trigger Explanation

Open iTunes Open Items ⌃O, I, T
Pressing Control+O then pressing I and T in sequence 
will open the iTunes application.

Open Mail Open Items ⌃O, M, A
Pressing Control+O then pressing M and A in sequence 
will open the Mail application.

Open QuicKeys 
Editor

QuicKeys 
Action

⌃O, Q, K 
or 

say "open 
quickeys"

Pressing Control+O then pressing Q and K in sequence 
will open the QuicKeys Editor. Alternately you can speak 
“Open QuicKeys” if you have a microphone attached.

Open Safari Open Items ⌃O, S, A
Pressing Control+O then pressing S and A in sequence 
will open the Safari application.

Open System 
Preferences

Menu 
Selection ⌘⇧,

Pressing Command+Shift+Comma will open System 
Preferences.

Reformat Text Text Tool ⌘⌥⌃R
Pressing Command+Option+Control+R will bring up a 
Reformat dialog allowing you to clean up text you have 
selected in a document.

Show All 
Applications Computer F4 Pressing F4 shows all hidden applications.

Sleep Computer ⌥⌃esc
Pressing Option+Control+esc will put your computer in 
deep sleep.

Toggle 
Recording

QuicKeys 
Action ⌘F1

Pressing Command+F1 will put QuicKeys into recording 
mode, or shut off recording mode if recording is already 
in progress.

Type 
Date & Time

Multi-step 
Shortcut ⌥⌃D

Pressing Option+Control+D will insert the current date 
and time into your current document.

❖ Note: All of the sample Open Items shortcuts installed with the product assume that you keep your applications in 
the systemʼs Applications folder.
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Appendix G

A Few Simple Examples
This group of example shortcuts should help new users get a better feel for QuicKeys X3. The examples are not 
fully detailed tutorials, but they do demonstrate additional features and techniques.

Example G1: Don’t Save Button
This Button shortcut is a good example of how to use keyboard hot keys to press buttons on your screen. When you 
quit an application that has an open, unsaved document the system will put up a dialog window asking you if you 
want to Save, Donʼt Save, or Cancel. In cases where you donʼt want to save the document this shortcut will allow 
you to press a hot key to simulate clicking on the Donʼt Save button.

Figure G-1. The “Button – Donʼt Save” example shortcut
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1. From the Create menu or the New Shortcut button in the QuicKeys Editor, select User Actions -> Button to 
create a new Button type shortcut.

2. Change the Button name pop-up to “Contains” and type “Don” in the field.
❖ Note: Why Don? The word "Don't" contains an apostrophe which on some systems will be "curly" and on 

others "straight". Hand typing "Don't" can thus be hit and miss. If you simply use "Don", you've indicated a 
word fragment that unique in Save dialog, so it will work fine.

3. Check the Ignore Case checkbox.
4. Click the Button Details button. In the resulting Window details sheet, set the Window Type pop-up to “Sheet 

on Document Window” and set the Identify Window by pop-up list to “Frontmost”. Click Okay to close the 
Window details sheet.

5. Make sure the Scope pop-up is set to All Applications.
6. Set your hot key to Control+D.
7. Rename the shortcut to “Button – Donʼt Save” or something similar.
8. Close and save the shortcut.

❖ Note: In this example we identified the button by manually entering information in steps 2-4. For other buttons, 
these steps might best be replaced with the more automated button setup method described in the Button shortcut 
write up in Chapter 11 of this manual.

Try it out
Open TextEdit, create a new document and type some text in it. Without saving your document, close the document 
window and when the Save/Donʼt Save dialog appears, press Control+D.

Similar shortcuts
This type of shortcut also works great for Replace buttons (which appear in a dialog when overwriting other files 
while saving) and Add buttons (which appear in an “are you sure” dialog when changing the suffix of a file name, 
like .pdf or .txt).
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Example G2: Remap a Hot Key
Most applications use their own hot keys to accomplish tasks, such as Command+P to Print, Command+Z to Undo, 
and in the case of Appleʼs Mail application Command+Shift+N to check for new mail. If you find some of these key 
combinations difficult to press or hard to remember you can easily remap them with QuicKeys. This example will 
show how to remap Mailʼs check for new mail hot key from Command+Shift+N to one of your F-keys.

Figure G-2. Remap the check for new mail hot key in Apple Mail.

1. Bring up QuicKeys Editor and choose Create -> User Actions -> Type Keystroke to make a new shortcut.
2. Click in the Keystroke field then press ⌘⇧N. This tells the shortcut to send Command+Shift+N when 

triggered.
3. Change the Scope pop-up list to Mail. If Mail is not running it wonʼt show in the list so you will need to 

choose Select Application and navigate to Mail in your Applications folder then click the Choose button. We 
do this because we only want QuicKeys remapping our keystroke when weʼre using Mail!

4. Make F5 (or another key combo of your liking) the hot key for this shortcut.
5. Rename the shortcut to “Check Mail” or something similar.
6. Close and save the shortcut.

Try it out
Switch to Appleʼs Mail application and press F5. If you have any new mail it should now be in your In-box.

Similar shortcuts
Remapping keystrokes with Type Keystroke shortcuts tied to hot key triggers is probably the most-used shortcut for 
QuicKeys users. Knowing how to remap shortcuts, as you work will undoubtedly identify numerous cumbersome or 
non-standard key combinations that could benefit from it.
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 Example G3: Open a Folder
Everyone has a few folders they need to access regularly. Why not open them with a QuicKeys shortcut instead of 
manually navigating through your hard drive every time? For this example weʼll create a shortcut that will open your 
Documents folder when you press a couple of keystrokes in order.

Figure G-3. Creating an Open Items shortcut from the Finder.

1. Go to the Finder and press Command+Shift+H to open a new window showing your Home directory. Locate 
your Documents folder in this window and single click on it to select it.

2. From the Finder menu select Services -> Create QuicKeys Shortcut. This will instantly create a new Open 
Items shortcut already configured to open your Documents folder.
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Figure G-4. Setting a hot key trigger and adding a second trigger.

3. Make sure the Scope pop-up is set to All Applications.
4. Set your hot key to Control+F (for Folder).
5. Weʼre going to add another hot key and group the two together so you can trigger this shortcut with hot key 

“chaining.” Click on the green button with the plus sign in it and a new trigger of type hot key will appear.
6. Set this second hot key to just the letter “D” (for Documents).
7. We canʼt leave the triggers like this or every time you type a “D” the shortcut will activate and open your 

Documents folder! To turn two separate hot key triggers into a hot key chain you simply click the square blue 
button with the plus sign in it. Do so now and you will see a grey shaded area surround the two hot keys to let 
you know that they are grouped.

Figure G-5. Grouping hot key triggers to create a hot key chain.

8. Rename the shortcut to “Open Documents Folder” or something similar.
9. Close and save the shortcut.
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Try it out
You should be able to trigger this shortcut from any application you are working in. When triggered, the Finder will 
be switched to the front and the Documents folder will open in a new window. Go ahead and trigger the shortcut by 
pressing Control+F and then the letter “D” within a couple of seconds.
When you pressed Control+F you should have seen a white ghost of your key press appear on the screen. This is to 
let you know QuicKeys is waiting for a follow-up keystroke to trigger a shortcut. You can group more than just two 
keystrokes for hot key chaining if desired.
❖ Note: In our Example we used Control+F followed by the letter “D” as our grouped hot key triggers. These were 
not randomly chosen, but intended to show how a pattern can be used to make your hot keys make more sense to 
you. The suggested pattern here is to use Control+F as the initial hot key for ALL of your shortcuts that open folders, 
then just make sure the grouped follow-up hot key or hot keys are unique.

Similar shortcuts
For more versatility, Use Control+F and D and O as your chain of hot keys to trigger opening the Documents folder. 
Along these lines, consider Control+F and A and P for your Applications folder, and maybe Control+F and U and T 
for your Utilities folder.
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Example G4: Change Destination Folder When Saving
When you save a document for the first time you have to tell the application you are where you want to put the file 
by navigating through your folder hierarchy. This can become quite tedious and is a prime candidate for automating 
with QuicKeys X3.

1. From the Create menu or the New Shortcut button in the QuicKeys Editor, select Files -> Change Folder to 
create a new Change Folder type shortcut.

2. Click the Select button, navigate to your Documents folder and click Choose.

Figure G-6. The Change Folder to Documents example shortcut.

3. Make sure the Scope pop-up is set to All Applications.
4. Set your hot key to Control+Shift+F (for change Folder).
5. As in our previous example we are going to set up a chain of hot key triggers by grouping them. This time 
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weʼre using a chain of three hot keys (⇧⌃F, D, O), so press the green button with the plus sign twice and 
assign D and O as the second and third hot keys.

6. Now click the two square blue buttons with plus signs in them to group the hot keys together. Make sure all 
three hot keys are grouped inside the same gray shaded grouping box.

7. Rename the shortcut to “Change Folder to Documents” or something similar.
8. Close and save the shortcut.

Try it out
Open TextEdit and start a new document. Select Save from the File menu and when the save dialog opens, press 
your chain of hot keys to switch the destination folder to your Documents folder.
When you press Control+F and then D and O in sequence QuicKeys will fire the new Change Folder shortcut. This 
shortcut will open a small “Go to Folder”, insert the path to the desired folder into the field, then close that window 
and change your save dialog to point at you Documents folder.

Similar shortcuts
The Documents folder is actually pretty easy to get to, but it was also easy to use for this example. You will find this 
shortcut more useful for accessing more deeply buried folders. This shortcut will also save you time when opening 
documents from within an application. Pretty much any Open/Save/Import/Export dialog will benefit if you have 
Change Folder shortcuts set up for your most-used document folders.
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Contextual Menu — A menu whose contents depend upon where or under what context it was invoked. Contextual 
menus are often accessed through right-clicking or Control-clicking on objects.
Control-Click — Pressing the Control key on your keyboard while simultaneously clicking with your mouse. Often 
used to activate contextual menus.
Dialog — Typically small windows that contain command buttons and various kinds of options through which you 
can carry out a particular command or task. Often used for alerts and error messages.
Dock — The Dock is a multi-function toolbar attached to the bottom or one side of your screen. The Dock is part of 
the Mac OS X user interface.
Drawer — A window that is attached to, or slides out of, another window.
Group — A trigger group is two or more triggers in one shortcut scope which are dependent upon one another to 
be active. Typical examples are groups of hot key triggers that fire by sequentially pressing them, and date range 
qualifiers grouped with any other trigger.
Hot Key — The keystroke(s) used to play a QuicKeys shortcut. When you assign several keys to a Hot Key (such as 
Shift+F1), those keys must be pressed simultaneously.
Inspector  — A multi-view palette providing access to various details of a shortcut, such as the icon, step 
descriptions, on/off status, and Step Results.
Multi-step shortcuts — A shortcut containing a collection of QuicKeys steps you can assemble to automate more 
complex tasks.
Palette — A floating window or toolbar.
QuicKeys Editor — The main component of the QuicKeys interface where you create and edit shortcuts and 
toolbars. 
QuicKeys Menu — The QuicKeys Menu is available whenever the QuicKeys application is running, if your 
preferences are set to display it. You can display the QuicKeys Menu by clicking the black QuicKeys icon in the 
upper right corner of your screen. The Menu provides quick access to basic QuicKeys components.
QuicKeys Toolbars — The user-defined toolbars used to play shortcuts.
Reveal triangle — Small triangles facing either to the right (closed) or down (open) that reveal or hide information 
in a window. Click to change their state, option-click to change the state of all reveals in that view.
Right-click — An action performed by a two-button mouse; can emulated with one-button mice by Control-
clicking. Often used to activate contextual menus.
Scope — The range of operation for a shortcut. For example, you can create shortcuts that only work when 
Microsoft Word is front-most, or shortcuts that work in all active applications on your computer.
Sheet — Sheets (such as the Toolbar Editing sheet) slide out from the window title bar and are typically used to 
quickly configure a property of an element within that window.
Shortcut — The time-saving tools you create with QuicKeys to automate single-step or multi-step tasks.
Shortcut Editing Window — The window that appears when you create or edit QuicKeys shortcuts.
Single-step shortcuts — A shortcut that consists of one step.
Step Results — The Step Results portion of the Inspector displays when you click a Step Results button at the 
bottom of any shortcut step. Use Step Results to choose how you want each step of your shortcut to react to success 
or failure.
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Sticky — An option you can select when setting up a hot key that enables you to combine two or more different hot 
key triggers. This is a legacy item in some respects, being supplanted by simply Grouping hot key triggers.
Subscope — Following the same pattern as scope, subscopes are subsets of scopes. Triggers can be assigned to All 
Parts of an application, or subscopes can be created for additional hot key sets within a single scope.
Toolbar — Small windows or palettes you can use to trigger shortcuts.
Trigger — Any action that signals QuicKeys to start a shortcut. There are several types of QuicKeys triggers 
available, including Application Event, Day & Time, Device, Hot Key, Menu, Repeat, Speech, and Time Range.
Trigger Groups — See Groups.
URL — Uniform Resource Locator. A reference to a resource on the Internet. For example, use http://www.
quickeys.com/ for CE Softwareʼs URL.



Index
A
AppleScript  137, 191

Assign Script Result to Variable  138
Apple Events  192
Application Event Trigger  71
Assign triggers  27, 41, 68
Assign Variable Shortcut  119

B
Backing Up  193
Bring All Windows to Front  143
Button  159

Button Details  163

C
Chaining hot keys  79
Change Destination Folder  207
Change Folder  93
Clear Recording  180
Click

Click Location  164
Release Location  164

Clips  139
Clips Usage & Behavior  141
Clip Groups  140
Gather clips  141
Make new Clip  140
Retrieve clips  142

Compare Variable Shortcut  121
Computer  143

Log Out  143
Restart  143
Screen Saver  143
Shut Down  143
Sleep  143
Start/Stop Classic  143
Start Classic  143

Contextual Menu  3, 16
Create menu  57
Creating & Assigning Scopes  81
Creating Shortcuts  19

Services Menu  19

D
Date & Time  149

Abbreviated Date  151
Long Date  151
Short Date  150
Time  152

Day & Time Trigger  71
Decision  101
Decision Types

Check for Application  103
Check for Button  104
Check for Date & Time  105
Check for Menu  106
Check for Window  108

Deleting Scopes  83
Deleting Subscopes  86
Device Trigger  72, 89

Advanced Device Trigger  89
Display warning when quitting  52
Distribute your shortcut files  195
Dock  8
Do Not Show Again  52
Drag and Drop  38, 157
Duplicating Scopes  83

E
E-mail  97
Empty Trash  143
Enable Triggers  52
Equation Tester  124
Example  46, 201

Donʼt Save Button  201
Open a Folder  204
Remap a Hot Key  203

Exclude Applications  14, 82
Export your shortcuts  195

F
Finder Views  144

G
General Settings  51
Get variable  191
Group Triggers  79



214

H
Help menu  59
Hide Front Application  143
Hide Other Applications  143
Hot Help  63
Hot Keys  53

Group  42
How To  9, 25, 37, 65, 87

I
Import shortcuts  194
Insert Shortcut  111
Inspector Window  33
Installation  6
Install shortcut files  194
Interface  51

J
Jump to  35

K
Keys pop-up list  187

L
List of Preloaded shortcuts  197
Lower Case  154

M
Manage Files  94
Menu  13

Menu Clicks  178
Menu Selection  173

Menu Trigger  75
Message  112
Minimize  188
Mouse Recording  180
Multi-step Shortcuts  13, 25
Multiple Clicks  171
Multiple hot keys  42

O
Opening QuicKeys  7
Open Items  96
Open QuicKeys at log in  52
Open QuicKeys Editor  114

P
Password Vault  156
Permissions  196

Read & Write  196
Read Only  196

Playback Palette  23
Pause/Continue  114

Playing Shortcuts  22
Pop-Up Menu  181
Preferences  51

Default Trigger Type  52
Preloaded Shortcuts  197

Alphabetical Listing  199
Public Shortcuts  195

Q
QuicKeys Actions  114
QuicKeys Dock Menu  32
QuicKeys Editor  15

Default Buttons  17
Editor Toolbar  17

QuicKeys Icon  8
QuicKeys Menu Bar  55

Edit menu  56
File menu  56
QuicKeys X3 menu  55
View menu  57
Window menu  58

QuicKeys Recording window  47
QuicKeys Toolbars  60
QuicKeys Updates  8

R
Reassigning Scopes  82
Recording  45

Debugging  49
Initiating  45



215

Record Button  180
Record More  180
Show recording hints  54
Start/Stop/Toggle/Cancel  114
Stop Recording  45
Things to remember  125
Timing  50
Tutorial Window  46

Reformat Text  154
Remap Keys  65, 87
Remotely Trigger QuicKeys Shortcuts  192
Remote Administration  54
Remove E-mail Quotes  154
Remove Styles  154
Renaming a shortcut  12
Repeat Loop  116
Repeat Trigger  75
Restoring from Backup  193
Reveal Triangle  26

S
Scope  14

All Applications  14
Details  81
Precedence  81
Scopes & Triggers  21

Scopes List  16
Scope interaction  14
Scripting Tools  137
Scroll Wheel  184
Select Menu  173
Servers  99

AppleShare (AppleTalk)  99
AppleShare (IP)  99

Services Menu  19
Set Button  160
Sharing Shortcuts  194

Making shortcuts available  195
Symbolic Linking  196

Shortcuts  13
Single-step  13

Shortcuts menu  57
Shortcut Data  193
Shortcut Editing Window  20

Add Step  26
Default Buttons  21
Toolbar  20

Shortcut List  15
Show All Applications  143
Simple Examples  201
Slow/Fast Typing Slider  156
Speech Trigger  53, 75
Startly Technologies  4

Customer Service  4
Feedback  5
Sales  4

Steps Area  22
Step Results  14, 34, 37, 67

Continue to next step  35
Jump to Step  40
Setting  40
Step Failure  41
Stop Shortcut  35, 41
Stop shortcut & notify  35

Sticky Keys  42
Subscopes  84

Creating Subscopes  84
Switch Subscope  115
Usage  85

Subscope Interaction  85
Subscribe to public shortcuts  194
Switch Applications  145

Next/Previous  145
Switch to Specified  145

Switch Printer  146
System Requirements  6

T
Technical Support  5
Terminal  147

sudo  147
Text Shortcuts  149
Text Tools  154
Time Range Trigger  76

Qualifier  79
Title Case  154
Toggle Toolbars  114



216

Toolbars
Adding Shortcuts to Toolbars  63
Creating Toolbars  60
Deleting  64
Displaying  63
Editing  63
Tabs Tab  62
Toolbar Tab  60
View Tab  61

Toolbars menu  58
Triggers  13, 52

App Event  13
Day & Time  13
Device  13
Grouping  78
Hot Key  13, 74
QuicKeys Menu  75
Repeat  13
Requirements  78
Speech  53

Trigger types  13, 71
Troubleshooting Recordings  48
Turn All Triggers On/Off  52
Tutorial  9, 25, 37, 65
Type Keystroke  186
Type Text  10, 156
Typing speed  52

U
Universal Access  6

Accessibility  6
Unminimize Window  188
Upper Case  154
Use Variable Shortcut  123
Using other peoples shortcuts  194

V
Variables  117

Add Equation Item  119
QuicKeys Variable Window  117
Set variable  191
Using Variables  124

W
Wait  126
Wait for Application  38, 127
Wait for Button  128
Wait for Menu  131
Wait for User Action  133
Wait for Window  134
Wait until Date & Time  130
Web Address  98
Windows Controls  188

Z
Zoom Window  188


